S SLEE] AT |

o0 Org
Qy‘ot \“de u.P. Govt, Act No /y(//’/
Q o° f 79 Gp

\g ) 9 Xy

L ¢ Y D
D | A
G
©

Indira Gandhi National Open Llniversity UP Rajarshi Tandon Open University

BLIS-10 E1
MICROSOFT OFFICE

FIRST BLOCK : Microsoft Windows

SECOND BLOCK : Microsoft Word

THIRD BLOCK : Microsoft Excel

FOURTH BLOCK : Microsoft Powerpoint |

FIFTH BLOCK : Internet Awareness

Shantipuram (Sector-F), Phaphamau, Allahabad - 211013




 BLIS- 10 F1

UTTAR PRADESIH : MICROSOFT OFFICE
vy RAJARSIHI TANDON OPEN UNIVERSITY -

Block
Microsoft Windows
UNIT 1
Windows Fundamentals 5 .
UNIT 2
Managing 17
UNIT3 |
Printing in Windows, 28
UNIT 4
Windows Accessories 32




So far you have been learning applications which are DOS based. Now with the change in technoloyy
the WINDOWS hased applications bave now wkee a lead in the computer fields, Number of such
applications are in use. To imroduce to this world of VWINDOWS, Microsolt hus some out with (he
package MS-OFFICLE which is un incarated package comprising of four most cammonly required
packages in the olfice working ie. MS-WORD which is like @ WORDSTAR or any ather word
processar, MI-EXCEL which is like a LOTUS 1-2-3 ar ay other spreadsheet pa.kase. MS-
POWERPOINT which is used 1o muke slides and presentations. and MS-ACCESS which is like any
Database package. For this course only the first three packages have been explained in this comnse.

The first block of this course tatks about the WINDOWS environment as such angd how this has nyace

things simple 10 understand and wark. The environment is very tser fricndly. The {undamentals of

windows have been covered in deiail and (e covrse pectic’ pants shall find it very simpic aad
interesting to work in this environment.

The second block is on MS-WORD which is window based word processor. This block explains the
various typing and ediling features in MS-Woard, including AutoCorrect and AuloText which s; zed up
the text vatry. The block describies the various Page Design and Layout features, Table Creation and
handling has been discussed in delail,

The third block is on MS-EXCEL which is a window hased spread sheel. EXCEL is used to automate
financinl stalements, business forecasting, ransaction regisiels, ventory control, accounts receivable
and accounts payable, It alse provides muttiple fucilitics tike makine grephs, analysing, situations and
also helps peaple at the managerial level in laking, decisions.

Tae last block of (his course is on MS-POWERPOINT which ¢ u very powerlul presentation packace.
This block covers (he features available in Powerpaint, how (o create presentation slides using tools
like Wizards which will help in creating presesitutions quickly and easily. Afier goirg throug.y this
Mock vou will be able 1o make effective presentations using sfide shows,
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In e 1 decade or so, the Information Technology has seen many changes in the way we view
campull.g. The hardware has &lso advanced remarkably. From few Kbs of RAM, now the PCs have
couple of Mbs of RAM. The hard disks and drives have also improved. Even the displays on the screen
have become rather impressive. Now we find graphical user interface (GUI) rather than the carly years
ol tex tode interface. Most of the vendors have come out with their products suppomng the GUT. -

GUT eaviranment gained popularity because, of the case to lcarn and use the applications compared to
the convetional DAS Lascd applications, Now (he windows based products:have -become so popular

that the s mgdors have kloppLd lhll‘lklng, about com;n[, out any ncw version of their product ‘based on
[hlabS

Windmvs is a GUT for the Disk Opu.llmg System (DOS) based 1BM Pcrsonal Compulers and .ils
cemnpatiies, To most, GUI means, using a mouse, noint to icons that répresent programs and files, pull
qu. n {or pop up; menus of commands. and o this wirlin scparate windows qn the display screen.

Windows has more to it than these clements. 11 makes DOS yased: uni-tasking(single appiication) PC

easnble of running mulliple applications simultancously, which is e~ned -as multitasking. Under the
aurngrer-based environment of DOS, the users had 10 learn a different ~athod to mte‘act with every

wopram il wis conrw.:ng aned _complicated. Windows being a graphlcc r:nwro-.ment, in dircct

ceatrast {o 3OS, provides 1 more intuitive interface because of its consistency aciess alt applications
rubning under it. I_"-gnmg to usc one Windows-based apphcahon means L'nowmg lhc csscntmls for
Bt any olher apphcallon with Windows. : _ s

Wingoys has alse made possible the exchange of data belween applications, DOS-based applications
wan also Ae ren beside Wiidows appiications and information can be shared between then. Windows
Provides abl the necessary tools for (ile and divk- -manapement that are pregent in DOS so that the uscr
des nof have lo switeh o DOS 1o perforny those functions. Windows not only resembles an operating

=temy Dubis also an intepraled packape that n.ch:dcs programs that can be used to pcrfon’n cveryday

thoeontare ahsolutely new to this world of compulers, my suggestion is, you should gct some
nadderslanding and knowledye about PCs Disk operating System (DOS): Although svindows shall make
:Umeh simpler for you but it watl be still betler to have some cxposure about DOS,

I'six bloek is just covering the basic unp]cmcnmuon of Windows but not the advanced level workln
o alzo includes :hJ administration of the Wu‘dows as an operating system,
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1.0 INTRODUCTION | ~

i

There are two types of prograths every PC requires. These are operaling system pi‘dgmm_s and
applicalion programs. An operating system is a set of programs thal lets the user use the applicition

programs on the PC. The most widely used operating system on PCs is DOS or Disk Operating

System to be specific. DOS has been enhanced by a group of programs called Windows, which also

provides some of the functions of the operatin

g system. Some of the Windows functions duplicale

or replace DOS functions, and others improve 'upon DOS functions. Although ong may say thal

Windows is an operating system’ but windows can not work witliout the disk operating syslen.
There arc other windows programmes which Microsoft has developed like Windows 95 which is 4

completc operating system.
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Windows not only performs operating system functions but alse provides 'appli_c::lion programs of .

its own. Many of the vendors have now“sl:u'lcd-dcvc!uping their praducts. which are sepporicct by

windows pecause of the popularity gained by the windows package. Several application packages

are now available thir have been spectlically writlen to run under Windows.. These application

progrims can be tsed Tor basic and cveryilay tasks. These pregrams include 2 simple text editor,
Natepad; a word provessing progrim, Write: o graphies program. Paintbrusht a simple dala basc
program, Caidlile; o Caleulator; and several others.

1.1 OBJECTIVES

b
After going through this unit. you will be able 1o
o pel familiar with basic concepts & clements of windows
¢ Kknowdiflerent parts of Window

» 1ypes oi Teons

v exiting the window environment

1.2 STARTING MICROSOFT WINDOWS

Switeh on your computer and atlow it to boot in the ustal way. You will sce a C prompt on your
screen onee (he booting is complete. Ensure that the WINDOWS soltware is loaded on your hard
disk. 1T this is net teaded. ask your vendor to install the sume for you.
To start Windows, fvpe WIN i e C prompt and press ENTER. The WIN s the exccutable file
(WINEXE or WIN:CONM) on the hard disk, This is created under the WINDOWS dircetory on your
hard disik.
Windows vzsually takes 10-15 sceonds 10 starloThe s thing shown on starling is ‘the Microsolt
Logo. Then the Program Muanager is automatically vun and conlinues o run as long as Windows is
running, . ' ' '
[n some cases, the win command is included into the AUTOCXEC.BAT file which dacs not allow
the computer to give C prompt on the sereen alier baating, bul louds the windows software as well,
CIFthat s so. ‘thefirst thing shown is the Microsofl -Logo. Then the Program Manager is

auwtomatically vuit and continves 1o run us long as Windows is running.
< .

G e _ , _ Microsoft -I.i’_fndpn.'f




1.3 BASIC ELEMENTS

Before you start working on Windows, there wre a few basic terms you need to know.

Windows The rectangular arcas of the sereen, where one can work. As you can sce the cursor
has come on the teft corner of this reclangle and blinking. indicating that this is the
start point of your work arca.

Desktop This is the background on which the windows appear, i : W
leons The small graphical symbols thit represent applications such as word processing or

graphics programs in Windows, The few of the i lcqns which you g,cm.rallv see on
your sereen Lo you swilch o window are as follows: :

e
5B
\.\;L F‘rinlr:!fs

“Windows: |
"Eikplorer.

[l Contiol Panst]

The Program Manager'is the central point for almos( afl the work dane in Windows. The. Progam
Manager window displays icons for other groups. of applications, Any of the applications can be
started by double glicking on the respective icon.” As you click it once you will sce that the text
below the icon dirkens und on sceond click the application programnie gets loaded, '

. s

The related applications are arranged tagether under o group, The names and icons for the
“applications in the group are displayed in the group window,

The following Geure shows the graphical environment o Windows, ' -

£ o oy
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1.4 PARTS OF A WINDOW - i e

FFor the sake of simplicity certain parts; such as title bar and menu bar, are common for most of the
windows. Since the window parts of many of ihe windaw based application software arc cormmon,
this makes i person 10 usiderstand and memorize faster.- You will see that the butlon to maximize or

-t minimize always appear on the right top corner i all the windows. Similarly the menu bar, (he
tittde bar, the contral ment: bar also appear at the same plice lor all the windows. This w':'zly if you
et familiar 1o one window, you will et familiar with the other windows too as the'meaning for
ciach of the similar hultons remain the same. Depending upon the type of application all windows,
however, may pot have every clement.

Insertion Piint “Mouse Pointer - 7 Minimise Button

+ .
Control-menu - Meeu Bar — Titke
R A

Box / _ /Bar

Maximise Butlon

P T e
mritaaiet e v e Ntepad 2 {Untiled)iae s
File- Edit/ Search  Help N _

et rar e
e AT LS
e il

L XY

B g TR T s 3
L A R A R S e s
Window » Horizohtal © | "Vertical
Border - . Scroll Bar - Scroll Bar
“ Control-menu box ' [i is in the upper-left corner of each window. Clicking on the Control-
menu box opens the Control rher.s. The Control menu can be used to
move, size, and close a-window while working with the keyboard.-
Title Bar [t shows the name of the application, document, group, or a directory.
Menu Bar U lists .the- available menus. A menu contains a list of actions or
commands. =~
Seroll Wars They are used to move'through a document or a list when the enlire
document or list does not fit in the window.
Msigiise Botlon Clicking this bulton using the mouse enlarges (h€ active window so
‘ that it (dlls the entire deskiop. - :
LI - o - ' ~ Microsafi Windows
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Minimise Bulton Clicking this bulton reduces the window to an icon gnd arranges it on

the desktop. Minimising the -application window does not quit the
application. . ,

Restore Bulton 'l‘h::. Maximise. butlon is replaced by the Restore button after the
window is enlarged. Clicking this butlon relurng the window to its
rgﬂ previous size.

Window Border 7T Yis the owtside cdgz of the window. The window can be-resized by-
© lenglhicning or shorening the border. '

Insertion Point Itis a Dashing vertical bar that marks the place where text or praphics
- are to appear on fyping or drawing, '

Mouse Pointer. An arrow used lor pointing items, It appears if the mousc is instatied
oh the sysien, :

1.5 TYPES OF WINDOWS

While working with applications, two types of windows appear on the desktop: Application
windows and windows inside (lic application window, . _ o

An application window containg the rumning applicalion. The application window has a title bar
and manu bar., . . -

Another window called document window, may apnear inside an application window. This type of
window may contain documents, groups (in Progran; Manager), or directories (in File Manager). In
cerlain applicalions, more than one of these windows can be open at a time, For example, with-File
Manager {one of the main applications included -4l Windows), écve;al dircctories can be viewed

_ simultaneously. Each direclory appears inside a £27arate window. The document windows share the
menu bar of the application window, but not the ‘itle bar. :

S CAWIND OWSV=.* - [MS-D|o- | _
- (3 msoffice ‘ 4]
H — (D e _ =
X - 7
| P
- I - P = p,d|
e B oSBT o el |

h 4 4

Document Windows

Microsoft Windoey ' o _ _ . " 9
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1.6

TYPES OF ICONS

The small praphical pletures hat represeal varous ypes of applications and files ave called Icons.

There are three types oi icons

e

Type

Deseription

Vrogeam - il

icon

Anpplication icon

Group icon

Represents the applicatior that can be started from Windows, These
Lons cin be fownd under the groups in (he Program Manager. The
Program-ilen jcons can be moved [tom one group window 1o
anadher,

Represents an application that is ranning but whose window is reduced
TORITHEE

Represents o praup ol related applications or o document window that
was reduced (o an icon. This icon is generally arranged al the lower

cdpe ol the application window.

Monium-item ieons
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1.7 BASIC TECHNIGQUES FOR WORKING IN WINDOWS:

Windows offers an on-line Tutorial in which one can practice working with a mouse and
performing basic Windews esks. To run the Tutorial, choos. the Windows T utorial command

frem the Melp mena in Vroginm Manager 1

Using & mouse is useally easier and faster than v ing the kewboard but one eeds 100 know bolh
mouse ind keyboard Yethniques o work in Windey s, Almaosi ol the functions in Windows can be
pecfornied using either the keyizonrd or ¢ mouse. . ;

1741 Basic Mouse Techniques

Generaliy the mouse has two buttons where one s (2 primary mouse button and the other is
secondary. In Windows, the lell mouse bulien is set as e primary button by default. The primary
button is used o perform the majority of the tasks whercas (he sccondary button is manipulaled by
fow of the windows-bascd applications only.

Term Meaning
Click To quickly press and release the primary mouse button to seleet a

single jtrem,

Double-click To click the primary mouse button twice in rapid suceession to
carry out an action after the item is sclecled.

Point To niove the mousc unltil the mouse pointer on the screen points t¢
the itern of choice. ‘

rag ' To press and hold down (he primary mouse bution while moving
the mouse, '

Drag-and-Drop Pointing w the item of choice, press and hold down the primar

mouse bullon while moving the mouse. Release the mouse button
on reaching the desired location Lo place the item.

1712 Basic Xeyboard Techniques

Close an active Application window or AET+RY
quit an applicalion

Clesc an active Document window CTRL+14
Move between items in 2 group window An arrow key

-

Micener G Windowg : il
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Seleet an item-or applicalion TAB

Start the sclecled npplirﬁalion or restore ENTER
the sclected group icon

Switeh belween Lhc_.running'r, applications Press and hold down ALT and repeatedly
‘ prezz TAB
Start Help ' Fi

Open the control menu far -

¢ anapplicalion window . , ALT+SPACEBAR
° a document window or a group ALT+HYPHEN
window '

To . ' . Press '

Activate the menu bar ALT ar I10

Sclect a menu o ALT + the underlined. character in the
ment name

Choose a menu command An arrow key, ENTER Or the underlined
characier in.a command name

1.8 USING MENUS : ‘ '

Each application window, and other windows as well have meny rames localed on the ey bar.

Commands, the aclions thal can be carried oit in Windows, are ljsted on  menus. Along with the

menmis on the meau bar, cach window alse has a control menu.
1.8.1  Menus an the Menu Bar

The menu on the menu bar can be seiacled and opened by pointing it and then clicking the primary
mouse button. Alter _cipcning the menu, a command o a meny item can be selecled by dragping the
selection cursar down or up the menu unti!l the menu item is highlighted and release the mousce
button to exceule the: command.

The menu can be closed by clicking the ment name or anywhere outside the menu.. The same can
be performed by pressing the ESCrkey on the keyboard, but the contral remains on the menu bar.

There we a simber of menu conventions used in Windows, which are as follows :

——

- ‘ Microsoft Windmv. '
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Menu.Convention

Meining

Dimmed (or rot visiblc)
cormmand ’
|

An cllipsis (i..) lollowing o
commiand

A cheek mark (V) 1o the left

ol a command

A kcy combinalion to the
right ol & command

A trinngle (&) to the right

of a command

1.8.2 Coantral Menu

The commind eannot be used wnh the application at the
current lll]'lb

A dialogue box appears on choosing theé commia nd. The
dinlogue bex. containg opl|0'~s need to be selected before
carrying oul the comm'lnd

The command is in effect. By choosing the command
again the check mark-is vemoved and the command ‘is no
longer in clleel. |

The key combination is' a shortcut for choosing the -

commimnd. Pressing the keys carry out the command
witheut opening the menu.

On choosing this command, a cascading menu appcar,,
listing additonal commands.

[l ey e i

Application wmduws document windowz and their icons; and-some e di alogue boxes have a Conlrol
menu. The commands on the Centrol menu allow one to work with a virdow. A window can be
moved to a different location, or enlarged and even reduced to an icon us: ng these commands. The
commands on 1he Control menu and (hz way this menu .is opened vary. The Control menu for
windows and dialogue boxes can be opeied by selecting the Control-menu box in the upper-jeft
comer of the window or dinlogue box. Tir¢ Control menu [or an icon is opered on bcu.cnn;__ the
icon. Seme commonly found Control mer i commands are s follows

LN
e,

Usce To ‘
Restore Reslore the window Lo its former size afler it is reduced to an icon or enlarged,
Move Move the window to another position by using the keyboard.

Size Change the size of the windcw by using the keyboard.

Minimise Reduce the window o and icen

Maximise Enlarge e window 1o ity maximum size.
Llose - Close the window oy the dinlogue box and even quit (he application.

' ’
Switeh Ta Open Task Int which enables (0 switeh between wnmng apphcaunns and o

rearrange the windows and icons on the deskiop.

Micrasofl Windoiws : ;
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1.9 WORKING WITH A DIALOGUE BOX

A divlogue box supplies adaitional informalion to a command, required for the completicn of a
lask. An cilipsis(...) alier & menu command indicates that a dialogue box will appear wit choosing
this command,

Most dialogue boxen contain oplions they can be sclected, After specifying the options, one can ;-
choose a command buiton to carry out (b2 command. Some other dialogue boxes may display :
inlormation. warnings, or error messages, Meving a dialogue box is just like movirg a window - by

dragping the title bar or using the Move comr.-and on the Control menu.

19,1 Types of Options

One may need Lo seleet one or more optiens within a dialogue box and for this one nced to move
[rom onz option o another. To move within a dizlogue box :

One can cither click that aplion or press TAB to move to the next option and SHIFT+TAB to the
previous option. TS

The currently seleciea aption is marked by the selection cursor, which appears as a dotled rectangle,
a i zhiigit or both,

The types af dinlogue box options are as follows ; C -

S -

e

[\

1 TAREMN AL G AT
SETNEA R

MR

e {card
f Fax [FaxView.cxe) _
FFax Key Viewer [keyview.exe)

Fax Signature Yiewer {sigyiew. exe]

"List Box-

Command Bulton

A Cammand Batton initintes an immediate action, such as carrying oul ¢~ narceling a command.
e GRL Cancel aud Help buttons are conumon command buttons. They arc often located along the
bultom or on the right side of the dinlspue box. Some command buttons arc marked with greater-
than signs (=) which expands (he active dialogue box, A conunand bulton containing an ellipsis
(...} opens another didtogue box. '

—
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ext Box

—

|_

A text box is used to type information. On moving 1o an empty text box, an insertion point appcars
10 il fardelt side. Lo I e
Visi Doy

A dint bax displays a list of choicus. 1F (here are more choices than can fit in the box, scrol! bars e

provided 10 mave quickly through the hist.

Usually only one tlem can be selected in a list box: and in some cases, more than one ilem can also

e wetaeled,
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hrop-Dewn List Box

A drop-down list box appears initinfly as a rectangular box containing . the current sclection. On
selecting the down arrow in the square dox al the right, a hist of available choices appears. Tt there
are wore choices than can (it in the box, scroll bars are provided.

Ontion Biattons

Oplion buttons represeint a group of mutually exclusive options. Only one aption can be selected at
a time, The selected oprian bullen vontains a black dol. 1f one option is already sciected, then the

current aplion replaces it

Cheeli Brx

A check box presents non-exciusive options, that is, more than one option can be selecled al o fiinwe,

Selested check boxes contain an X.

Microsoft Windows
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1.9.2  Closing a Dinlogue box

When a commind bulion is chosen. the dialogue box is elosed und the command is executed. The
dinfopue box can plso be closed to cancel.a command. )

Choosing the QK command button closes ihe dialogue box by carving cat the command or the
ENTER key can also be pressed. To close the dialoguce box wuhout carrying oul a command, click
tha Cancel cmnnmnd butlon or press ESC.

1,10 GETTING HELD

Windows plO\'Idc‘- on-line ]Ielp (o asa:st lhc user. in workmg with Wmdows I‘ollewmg arc some
ways lo obtain help @ - ae

»  Press 'L key to view a list ol Help lopics for the application the user is working with.

* Click the Help command button 1o display information aboul working with the dialogue box.

w»

» Choose IMelp menu in any application to display a list of Help commands.

1.11 QUITTING MICROSOFT WINDOWS

Before turning oft the computer one is required lo quit Windows. To quit ;
« Double-click the Conlrol-menu box in the Program manager
Or

» Sclect the Exit Windaws command (rom the File menu of the Program Manager .

Cheek Your Progress

State True ar lulse

1) The Minimize butten is replaced by the Restore button. - Truc [:I False I:l
b} The Document windaw has its own menu bar. True D "~ Talse [j
¢) More than one document window can be opened True [:I _ False D

in an application window,

.12 SUMMARY

This unil has introduced you with the basic concepts and clements of Windows, ond some essential
teehniques needed 10 wark with Windows. Alter acqiiring lhese skills, it becames casy to work'
wilh almos! anwhmu i Windows and one is ready (o master by 1éarning more technigues.

AU - Microsofi Windows
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Nironeture

2.0 Introductian _ ]
it
21 Objectives .
2.2 Qpenmg Another Direelory Window
2.3 Switching hetween Direetory Windows )
24 Cham:;;in_g View ol the Dircetory Window
24,1 Using View Menu
242 Using Free Meny
2.5 Changing Drives and Dircclorics
2.6 Working with Files and Dircetories
2.6.1  Sclecling Files and Direclaries .
2.6.2 Moving and Copying Files and Di'rcclorie_s__ ‘ ;
2.63 Renaming Files and Directorics
2,6.4  Scarching lor Files and Dircclories '
2.6.5  Creating Directorics i a
2.6.6  Associating Files with Applications
2.6.7  Changing Fiies Attribules IR
27 Managing Floppy Disks
2.7.1 Tormatling a Floppy Disk -
2.72  To Capy a Floppy Disk
2.3 Summary )
2.0 INTROD UCT‘I ON

Microsoll classifics Windows
system Lei
application called Fite M

the: drives, directories and files.

SIS U Opu.mn;, system, House keeping and maintaining the file
15 one ol the functions porformed by any operating_ system; Microsoft included an
amaper. It can be used (o perform some common tasks, including managing -

by
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File Manager is present as a Program-iteny under the Main group in the Program Manager window
The lollowing screen appears on double-clicking the File Manager icon. -
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In File Manager. the liles and direetories are displayed in the document window -referred as
direciory window. The dircctory window is divided by the split bar. The left side ol the window
displays the structwre of the current drive, or the directory tree, The.right side ol the window
displays a list of lles and sub-dircclories in the selected directory. I the dircetory window, each
name fisted in the right half has an icon next to i1, indicating the type of file.

The following table describes the various icons used in the directory window :

leon .~ Description
LT Displays the contents of the dircetory one level up in the Idircctpr)' lrec.
i Represents o direclory.
1Usy Represents an open gdhrectory
vl Represents an application ile. These lles sim'{ :1]:13iiculi6:15 or run
Progrims.
B ‘ chr.csgu[*.l:a' a document file associated with an application. On opening this
f'llg. the application associated with it starts, -
B ' Represents o sysicn ar hi:!tl.-:n lle,
) o Represents other decuient files. '
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The other things to be found in the dircclory window are @

o The a’; ive jeons gn the drive har Yor I...|1L|1 drive that can be currt..nlly achsscd Thesc lmn‘- L
be used lo change (o a diflevent drive. :

. Thc statuy har displays information about the current drive-and directory and other information

about the lask being perlormed with the File Manager.,

sa - R N L L

o The menu bar coptains menus listing FFile Manager commandé.’"f TR

The drive bar or the stinus bar can be hidden or dlb]ﬂ.l)’bd by choosm[, lhc Br wcbar or St.llusbas
cammund from the Gplions menu. :

2.1 OBJECTIVES T
Alter geing through this wnit, a student shoukl be :il)‘IE (o

«  swilch belween directories

o working with mienus

o working with {ifes and dircclories

formatting a Noppy disk S o - S .

2.2 OPENING ANOTHER D.I.RECToiiY- W-INDOW -

Within File Manager, onc ¢an open multiple-windows to: dlbp]ﬂ}’ more tha.rl one drwc or dl:u.[m}
atime, . ' :

1o r}puu a new directory wintdomu @

Fl

v TFrom the Window menu of ﬂu. FFile Mdl'l:lj:,l.r wmdow clmosc Ncw Wlndow cmnm.md H;L-
new window inttially has the same chsplay a% tim c,um.mly achc wmdow but ll.. c(mu,nt:. can
be changed. . . :

+ Double-click the different drive icon, 1o open a new window. displaying the cuntents of .«
different drive, ] : : . o

23 SWITCHING BETWEEN DIRECTORY W'I_Nj)_pws_-’ '

z\llhoubh many divectory windows can be open, only ong con h'.: active.at,a. Hmc. A, Ao
becomes aetive when sclected.

To switclr between the open direchry windows !
R /i ) >

v Clhick anywhere in the desired directory window,

1<
A
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» Cycle through the open directory windows by pressing CTRL+F6 or CTRL+TAB until the
_ desired directory window is not selected.

» Choosc a window name lrom the Window menu of the File Manager window.

2.4 CHANGING VIEW OF THE DIRECTORY WINDOW

The way the files and dircetorics ure. displayed in the directory window can be changed, The overall
display of the dircclory window can be changed using the View menu. The way dircclory tree is
displayed in the lefl half of the direclory window can'be changed using the Tree menu.

24.1 Using View Mt,nu

One can cheose to display anly the directory tree or only !h. |cclory contents. The details. of the

files displayed can also be ehivr. b e 1oniswing wv ine o' ons used o change the display :
‘ Uscfl.‘h‘ilsl‘-.co mmund To

Tree and Dircclor}: ' Displuy both dihrcctory trec and the directory

; conlents. '

Tree Only Display only the directory tree.

Direclory Only ‘ ' 'D‘isr)l'z_ny_'or'ily the dicectory contents.

Name : Display only the names of files,
“All File Details Display the namc, - size, date and time of

_crealion, and attributes of files.
Sort By Type Display f{iles in alphabetic order. based 6n the
' C hicnamc cxtension.
Sort By Size Dlspl.\y ‘files in order of size, from Jarpest ‘to
bl‘l'l'l”(.bl
Sort By Date - D:sph) files in. ordcr of date, with the most

recently modified file listed first, .

By File Type o Display the specified types of files

2.4.2  Using Tree Menu

The Dirgctory Tree can be expanded or collapsed 1o view or nol lo-view the subdirectorics in a
dircctory. An cnlire branch. a single leve] of (he branch, or. all branches on the drive can be
expanded and a dircctory can be collupsed so that subdirectories are nol shown in the directory lrec.

Meanaging the File 8 ysiem
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To expand or collapse a directary :

In the directory tree, double-click the icon of the direclory to be expanded one level or collapsed, or
selecl it using the arrow keys, and then press ENTER.

The following ¢commands on 1he Tree menu cun also be used (o expand or collapse directorics :

Use . To R
Expand Qne Level Display the immediate subdircctories of the selected dircclory;
Expand Branch . Display alf the subdirectary levels below the selected directory.
Expand All I.)is;;lay all the direetories and subdirectorics on the drive,
Collapsc Branch Cotlapsc n directory so that all the subdircetory levels below the
selected dircetory are nol shown, :

2.5 CHANGING DRIVES AND DIRECTORIES

The files one wanls to work on may he on a different drive or in a differen directory. File Manager
enables onc to casily view and work wilh them, : '

To change to the current drive :

* Inthe drive bar. click the desired drive icon, or double-click it to ereate a new dircetory window
displaying information lor the new deive.

1
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¢ Press nnd hold down CRTL key while typing the lelter of the drive to be selected. This works
cven 1f the drive bar is not displayed. .

To change lo another directory :-

¢ Select the dircctory in the direclory tree or select the directory in the list of files, by using the

mousc or the arrowskcys.

2.6 WORKING WITH FILES AND DIRECTORIES '

File Manager provides graphical way to organize your files and direclories. It also provides all
basic file and disk maintenance commands used to move and copy. files, rename files. create
directories, and format disks, eic, :

2.6.1 Seleeting Files and Divectories

To perform tasks with File Manager, the files ar dircctories necd to be selected. Mouse can be used
10 sefect one or more direclories or files.

To select a file or directory

-I Click the-filename or directory n:uﬁc {o be sclected,

¢ Press TAB (o move 1o the list of files, and then use the arrow keys.
To scleet two or more items in sequence

1, Click the first file or directory to be selected.

2. Press and hold down SHIFT while clicking the last file or directory in the group.

Ta select two or more jiems out of sequence

e Press and held down CTRL and click each file or dircctory.

»  DPress SHIFT+FB, use the arrow Lcy to movc to cach item, press SPACEBAR to sclect it or to
cancel the selection. Then, press SHIFT+F8 again.

To canced a .\'cf::criou

Press and hold down CTRL while clicking the selecled file or directory.
2.6.2 I\-Ioving zngd Copying Files and Diruciorics
Onec or more f'lc.b ot dircclories can be moved or copicd to another directory or drive, either using @

mouse by quickly selecting ilems ahd then dragging them to their new destination or by using the
Capy or Move command. The destinalion can be a directory Wmdow directory icon, or drive icen.

o Managing the Fil: Svstem
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To tmove or copy o file or divectory

)

*

To move a (il or direclory Lo a dilferent drive, piess and hold down SHIFT, and then drag the
file ar dircetory icen(s) 1o a direclory icen, drive icon, or minimized directory window, Il a file
ar dircetory 18 drapeed 1o adrive feon. the file is moved 1o the current directory on that drive.

o Tn move o lile ov-divectory o a destinalion on the same drive, drag the file or directory icon
wilhewit pressing SHIFTY

v ‘l'o copy & lile or dircctory lo a dillerent diive. drag the Jile or directory icon without pressing
CTRL. :

« Ta copy a file or directory te ihe same drive. press and hold down CTRL and drag the {ile or
directory jcon(s) o a directery icon, deive icon, or minimized direclory window, If you drag a
file or directory o a drive ivon, the [1le is copied (o the current direelory of that drive,

To move or copy u file or directory by nsing the Move or Copy command

1. In the list of Oles and dircetorics, seleet the iiems you wanl {0 move or copy.

2. TFrom the File menu, choose Maove or Copy command.

In the Move arCopy dinlog box, speeily ithe destnation directory.

e

4, Choose the OK balion, .

14.3  Renntning Files and Directories
A Dile or direclory ¢an be renamed in File Manager,

To rename a Jile or directoe:
¥ :

Seleat the fiic or directory o be renamed.

=a

From the File meny, cheose Rename.

3 I the Rename dimlog box, spectby the new name.

i, Choose the QK button.

While renaminyg the liles, ane must wke care ol (he sysiem and hidden files. A systeny file contains
infarmation required for muming the nperating system. Changing the nama of a system file might”
cileel he system and it may nol sun correetly, A hididen file is a file not inlended 10 viewed in the
dircelary listing,

Lodb Searching tor Files und Divectories:

o Gnd a file or group of files, the Scarch command cun be used. If files that match the search
reiteria are found, they are Hated in the Scarch Resulls window, The ilems in this window can be

1!:‘1”(.{{:”1".: tha File .(-\-\';'E.:u . 2:‘_._.-
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selecied and perform such tasks as copying, deleling, moving, and printing fiics. ‘The contents of
the Search Resulls window changze when a new scarch is perflormed. :

To search for files or divectories \

b, Scleet the direetory from which the search 1s 1o be starled.

1

Frem the File menu, choose Search comman.

3. I the Search dinlog box, specily o [ilename or . usg wi]dcards * or 7 [lor
a group af fites in the Search For text box and Mark the option for suuchmb all subdirectorics.

4, Cheoose the OK button.

To cancel the seiuch! press BSC.

. 2.6.5 Creating Directories

1. Select the divectory in which the new directory is to be created. S
2. From the File menu. choose Create Directory comimand,
3. Inthe Name hox, type the name ol the new directory,

4, Choosc the OK bulton,

2.6.6  Associating Files with Applications
When a file is assnciated with s spypdivation, one can open (he file and start the application at the

same time, If a file is associared with an application, there'is a document- flc icon next 1o the
filename in the directory window:,

When File Manager is starled, some files are already associaled with applications.

fo assaciate a file not associated with an application

1. Seleet the name of the file (o be associated with an application,

G ASRocial

: E Filos with Extenzion: bmp{
Associal With:

F’alnlbrux‘h Fricture
MS PowcerPoint 3.0 Prezentalion [C:AMS Ol
HS PowerPoint 3.0 Slide [C:\MSOFFICENGSE
M5 PowerPoint 4.0 Presentation {C:\MSO ¥
MS PawerPoint 4. O Slide (C:AMSOFFICEAREE

i : ' hiexe) S oG g
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2. From the File-menu, thoose Associate command. - e

3. Inthe Associate dialog box; sclect (he application with which the [ile is 1o be associated,

4. Choose the QK bulton. I

.07 Changing File Attribuley

By using File Muager, the propertics of ¢ (ke ar directory can be changed. Thesé properlics
nclude file attributes, such ag reid-only, archive, bidden, and system, '

Ta change file or directory propertioy

L. In the dircclory window, scleel the ilem(s) for which the properlies are (o be changed,

2. From the File menu, choosc Propertics command.

3. Inthe Properties For dialog box, seleet the tile propertics. For a file or directory more than one
property can be sclected, ) .

4. Choosc the OK bufton.,

2.7 MANAGING FLOPPY DISKS

Some of the DOS equivalent disk-level commands are available on the Disk menu, These
commands help in managing the disks by puerforming the following tasks: '

o Copying a Disk

¢ Formaiting a Disk

e Labeling a Disk

. Making a System Disgk

7.1 Formatting i Floppy Disk

Belore using a disk, it must be formutied, FForivanting prepares (he disk for use with the computer
and deletes any previous information stored onil, - L

Tu format o divk
I Insert a fisppy disk in a drive.
2. Trom the Disk menu, choose Farmat Disk command.

37 In the Format Disk dialog box, specify ihe drive letter, disk capacity, volume-label, and other
options, '

Managing the File Sywten _ : . . . 25
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[ Make System Disk
3 Quick Format

»
o The Label box assigns a valume label to a Noppy disk al the time of formatting. The same can
be done later by using the Label Disk command in the Disk menu.

» The Make System Disk copies MS-DOS operating-system files (o a Noppy disk al the time of
formatting, whercas, the Make System Disk command copies the files w a formatied floppy
~ disk. The system disk to start a computer that uses the MS-DOS opcrating system,

«  The Quick Formal option quzcklv formats a previously formatted floppy disk w1lhout scanning
for the bad SCClLI“i

Fay

. Choose the OK butlon-.
2.7.2 To Copy a Floppy Disk

‘The contents of one floppy dlsk can be copied to anothcr. but bolh the disks must have the same’
slovage capacity. To perform this task, Copy Disk command ‘on the Disk menu can be used. This
command is same as the MS-DOS DISKCOPY command. This command makes. a true replicaof a
disk by performing (rack-for-track and sector-1o-seetor copy. -

To copy a disk

1. Tnsert the source disk in the drive from which the dala is (o be copied. if there are two floppy
disk drives, insert l|‘.c destination disk in the drive to which the data is to be copied.

2. In the drive dar, select the drive icon [or the source disk,

3, From the Disk meny, (,hoosc Copy Disk command. _ L : .

4. [f the computer hag two ﬂoppy disk drives, the Copy Disk dmlog box appea.rs Sclcct the lctlcr
of the destination drm,, and then cheose the OK button. If the computer.has only one, ﬂpppy
disk drive, the Copy Disk dialog box appears when (he disks need to be changed.

1
Chieck Your Progress

1. What is a File Muanager?

26 Managing the File Systent -




ta

Give the purpose for what the Tollowing eimmands are used.

=]

File menu — Copy command S Co
b View ment — Split command

¢ View menu =+ Seleet Drive commangd

-

Give the menu conunands to
< Open anew dircetory window,
»  Display both Tree und Direetory 1 the directory window.

o Sortthe files i the vight hall by type.

2.8 SUMMARY

This-hands-on session has been a guide throughout: [earning the use of File -Ma.nagér. Instead of”
using DOS for disk-management and file system managément tasks,you'can now perform -these
tasks with the help of the File Manager. This feature of File Manager categorizes it among the
important utilities packaged along with Windows. '

Managing the Fife Svstem . 27
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Structure

3.0 Introduction

N Objectives
3.2 Aclivating Print Munager
3.3 Printing using Print Manager

3.4 Pausing and,Resuming Printing

+ 3.5 Summary

- T

3.0 INTRODUCTION

Print Manager is a Windows application that pravides a way to view and control the printing of
yaur documents,

When printing from a Windows-based dpplication, you do not need to use the Print Manager
window. The application creates a print file and sends it to Print Manager, The Print Manager
usually works in the background, sending vour documents ‘o the printer while you perform other
laeks. You can check the status of the document al any time and change its status unti] it starts
printing. Generally, Print Manuger is used la install printers, configure printers, or print documents.

3.1 OBJECTIVES

After poing thréugh (his vnit, a student should be able 1o
i’

v aetvale print manager

1
!

s tosclup printer

« o get print aut of the docoment

¢ tosclectively take a print oud | .
° 1o pause & resume printing o decument

* toend more than one document to the priner simultancously

—_—



32 ACTIVATING PRINT MANAGER

Tiwe Print Manager can be activaled by double-clicking its icon in the Main group wmdow Print
I\"'ln :gu.' can uscd 10

Chech 1w print status of o docuiment.
L]

e Pause and restart a printer or the printing & o document,

Cancel the printing o' e document.

s Sctupaprinter.,

b

S .*-' A
o

Printer _D_ncumcnt

d imh,msou word . ‘\.‘HILH DOC rPnnmg 801K 10:29 PM T2}22195
O MieresotlwWerd - WINCH4.00C, 208K 10:29 PM 12/22/56

D Hliezofl A 'Work Fax on FAY idle

—imria

1The pnnlpr 15 Pllher outof paper or: nol conn

AT

aggdmﬂ’«

The Print Manager window displays inlormation about the printers ‘which are phys:cally cormcctcd
o your compuler. The deft lult printeris designated by its name appcarmg in bold and underlined:

Bl.lnw the name of eich printer in the Print Manager wmdow is a list of documents printing or

witliing Lo print, aiso known as a guene. The document that is currently printing is at the lop of the
hisl.

tinch document displays the application name, the document, the.status and size of the documcnt
and the time thal the dacument was sent o the printer. These columns can be turned off by using
the View menu or resized by using the mouse or (he Options menu. Each document and prmtcr has
i icon next to it indicating its st Illlb. as I'ollows

! fcon Deseription
!
@ A pfinlcr physically canneeied (o your computer
2 A printer or document that is currently printing.
. L
i - A printer or document that has been temporarily stopped.
P A printer or document that has had an error and cannot print,

Printing in Windos . ) 29




3.3 PRINTING USING PRINT MANAGER

Most Windows:based applicalion include a Print comumaid on the File mchu that is used to print
the documents. When o document 1s printed from a Windows-based application, Print Manager

starls and appears on the desktop as an icon, if it is not already nmmng A document can also be -

_ printed using the Print Manager.
To print a document

+ Drag the documenlt's file icon from File Manager 1nt0 the Print Manager wmdow or onto the
Print Manaper applu.'umn icon,

DOS-based applications that run in Windows do not route. prml files lh:ough Print Manager They
print the same way they ‘would from DOS.

3.4 . PAUSING AND RESUMING PRINTING

You can pause the printing of a document ‘or even a printer, Pausing a printer stops the printing of
all the dec ~ontsan the print queve. Pausing a sinple document stops only that document from

printing wii: s other documents in the queue will continue 1o print, The printing of a document
can be pausc.. i it has actually started Lo print,

You can later resume the printing of a document or restart a printer that has been paused.
To pause a document

1. In the Print Manager window, selcet the document.

~ 2.. On the toolbar, click the Pause Printing Document button.
Or

Choose Pause Printing Document command from the Document menu.

" The statws of the selected document changes Lo indicate that printing has pausecd.
Te pause a printer

1. Inlhe Print Manager window, select the printer.

-

2. On the woolbar, click the Pavse Printer button.
Or

Choose Pause Printer command [rom the Printer menu.

The status ol the selected printer changes to indicale (hat printing has pauscd,
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To resunie printing o dociment

. Sceleet the document that is paused.

20 Qo the tooibar, elick the Resume Printing Document bullon,

Or

hoose Resume Prinasy Document cemmand from (he Document menu.

To restari a privier

L. Seleet the printer that is pauscd. .

2. On the toolbar, elick the Resume Printer button.
Or

Choose Resume Printer command from the Printer menu.
Cheele Your Progress

1. Whatis I'rint Manager used For?

2, State True or False :

a)  Adocument can be sent to Print Manager : True D False - E]

fram the Filz Manager

b) The printing of document can be paused True D . False D

cvein when the document is gelling prinied. -

3.5 SUMMARY

This unit describes how Print Manager helps in printing of files. The Print Manager enablés one to

.

send mere Lthan ane document {o the printer bIITILI“ﬂI"lLOLISl)’ It manages the multiple documents

with the help ol print queuces.

e

The Print Manager is alse used 1o install and configure printers. This can be donc by usmg the

Printer Set-up commaid on the- Opuons menu of the Print Manager window.

Printing in Windows
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Intraduction

Objectives

Wrile

4.2.1 . Opening Files
4.2.2  Saving Files

4.2.3 Typing Text

4.2.4  Moving within Text
4.2.5 Seciting Text

42,6 Editing Text

4.2.7 Formlnllil}g Text
Paintbrush

4,3.1 Basic Concepls

4.3.2 Working with the Tools

Other Accessories

~Summary

4.0 INTRODUCTION

Windows not only inc;'ludcs the manapement ulilities like File Manager and Print Manager, but also
includes a set of office tools as those found en-the.office desk, including calculator, calendar,
notepad, and clock. These tools are included among other useful programs in the Accessories group

and help in performing Lhe everyday (asks.

The proprams in (he, Accessories: group are also called “Applets” because these programs do not

offer full range of lin
usclul.

To stari an accessory, choose an icon in the Accessories group.

]J-;

1ctions Lhat separate applicalion programs do. Even so these applets are quite




s
Sound
Recorder -

G qrdhlu Calculétor

Characler  Media ‘. Ubiéti o
Map  Player - Package

Ll L . Ll . — - e Nl 2% L ¥-al '@tmf il LA Lo S Rk

4.1 OBJECTIVES

After'going through this unit, a st:dent should be able to

R R R

opena file

» cditafile

s gave Ly done

o use key board oplions for mousa
* usc _drawing tool i.c. ijainl brusi

» [familiarize with olher accessories-

4.2 WRITE

Word processors are the most commonly used programs, Wnte is the word processor provided with
Windows ver 3.x. Write is simple and casy to master. Though not a very powerful program, it has
ctiough features lo creale - profcssional-looking reports’and documents. When you create Write
documents, you can type, edit, and format text in the Write window; 1nscngmphlcs save the text
and graphics as a file; and print your documcnls

Wrile also supports object linking and énibcdding (disc_usscd in the next init),

+
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. o S ' Thé'e'ndrﬁarkindicétesme.

o /— end of document
A TR

._lle E’lt i nd Charactcr Praraph Document Help

Text appears | _{x” - ‘ . |7

at the insextion| ! . e

noint on | _ - &5

typing I . - 2
. The mouse :
[ pointer - o ' _ . %
~ Lt S o [

The Page - % i1l 3 =i It aé—: X 4 h ‘ T I v_'ﬁ': ‘ -thﬂ : &: gﬁ

Status Area - :

4,.2.1 Opening Files -
To work on a‘document, - you must first open and display it on your screen. You can then edit,

format, and print it. When you starl Write, a new, blank untitled document opens To bcgm
working on it, just start typing and it. can be. savcd under a new name.

To apen an exisiing Wrile dactiment

1. From the Filc menu, choose Open command. The Open dialog box appears.

L T A T ————
S A ke \'-‘“"-r‘ a1 ‘% X :v ﬁ&i‘iﬁf‘i‘;&h‘- i
! '3 i "'EZ ritl i | l. fﬁ?i’":?illfs..ﬂe.n-

File Name: . Direclosies:
Irczfdmc.wri J ‘c:\wihdows
fmarlwn HEEEEE B e v
networks.wri £ windows
unlers wii o .
ll Pafl Bé‘ﬁlliu_ﬂ'.. g ) II'IS('.IDDS ’
sysini.wrl | & system
lest, wi ‘ 1
tost2.wii : .
winini.wii % ‘ ' 7 B
List Files of Typax Diivas: L . i ‘
Wite Files ("WRI} [ |[&c i
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2. Type or select the filéname. [f the file is on a different drive or dircétor)}, select the drive from

the drives list and directory in the directory box.
3. Choosce the QK bution.

To open o new, untitted document

»  From the File meny, choose New command. 1f a document is al-eady.open, windows pt;ompl's'Lo _

save any changes made, belord opening a new Write document.

4.2.2 Saving Files

When you open a dacument, it is copicd .from the disk and displayed. in Write window. As you -

work, you chinge the copy of the document in the window, The Save command can be used to
preserve your changes. When vou save o document, it remains on your screen so that you.can
conlinue working. It is a good iden to save the document frequently. '

Tosuve changes to ¢ document
* Jramthe File menu, choose Save command.

To save a new (untitled) docriment or the current document under a new name

1. Fram the File menu, choose Save As command.

2. Type a filename. If the file is 1o be saved on a different drive or directory, select the drive from

the drives list and directdry in the direclary box.

Choose the O}_(_huuon. . .

L}

4.2.3 Typing Text

When you start typing text, an inserlion point marks the place where the text appears.

To fype text in o new document : ' ) .

* -Begin typing the text. Press ENTER to move the insertion point to the ==xt Jine: Pres~ the
SPACEBAR to mave the insertion point one space to the right. U

To type text i an existing dociment
. . ¢ . 1 .
* - Move the mouse pointer to the place where the text is to appear, click once, and then start
lyping. Or use'the arrow keys to move the inscrtion point to that location.»

4.2.4 MO‘-‘iIIIg within Text

_The insertion point can be oasily moved within text and placed at the desired location.

i

Windowy Accessories o S ' 35



To move the insertion peint using mouse
« Place the mouse pointer at the desired location and click once.

To move the insertion point using keyboard, the following arc the ways

R I e TR

To mm*_c' fo'the b I‘css

Next Line DOWN ARROW
PreviousLine  UP ARROW : . |
Endoftheline | END |

Beginning of the line HOME

Next screen . . PP'xGE bOWN

Previous scron ' PAGE up .

Next word " CTRL+RIGHT ARROW

Previous word . CRTL%_-‘LEFT ARROW -

End of the document . C:I‘RL+END | ’ | |

Beginning of the docmﬁcnt . CTRL+HOME

4.2.5 Sclecting Text ' ' ‘ ;

To make chanpes to blocks of text, the text’ nccds 10 be selected. To select text the selection arca
can be used. The selection area is invisible and extends vertically along the left margin, The mousc
pointer slants ro the right when inside iie sclcctlon area.

To'Sel

. > am— .
TFrom the selection area, point to a line and click the mouse bution, .

A single finc

f

Several lines " From thé sclection area, point to a I ne and drag the: pomter up of '
down within the sciection area, ;

~ A paragraph From the sclection area, pdint lo a paragraph and double-click.

Secveral paragraphs  TFrom the selection aréa, point to a paragraph and double-click and
B hold down™ the mouse button. Drag the - pomtcr up or down lhe
sclccl:on area.. :

i
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To seleet Do this

-

. while pointing 1o the last line or paragraph from the sclection arca,
Then citek. Write sclects everything the two points, '

A range of lext scleet the starting ling or paragraph. Press and hold down SHIFT

L4 : i
The entire Press and hold dewn CTRL, and, with the pointer in the seiection .
document © e, cliek, '
A rang of Poinl to the hiest cheracter. Press and hold down the mouse button,
charagters and then drag (he ins~rtion point to the last character to be selecied.

To cuuce!lrhu selection

.- Click anywhere in the documetit.

$.2.6 0 Editing Text

Editing text includes addition. deletion, copying i]ll’ld moving functions.

To add text ; .

~

»  Place the insertion point zt the desired location cither using mouse or the keyboard and then add
lext. . o .

CoremTrrt— o — o -

To rentove foxt

= Press DEL key to delele the Ichm'aclcr lo the right of (he insertion point.
«  Press BACKSPACE (o delete the character to the left of lhcl ins_crtion point.
»  Sclect l_'.hc.block of text to be deleled, and press DEL kcy.‘

The Copy, Cut, and Paste commands transler and duplicate information.

To copy text by using, the mouse
I, Select the text you waal Lo copy.
2. Move the mouse pointer to the place youwant to insert the copy.

3. -Press and hold doven ALT, and click.
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T copy text by using the keyhoard .
I Scdeet the textyou want o copy. : ,
2. From ihe Lidit mena, choose Copy command:
» - -
+ Move the insertion paint to the place you want the copied text to appear.
Or

Seleet the text you want 1o replace with the copicd text.

4 o the Edit nenu, glioose Pasle command,

’

To move text by using the mouse
1. Select the ext you want to move,

2. Move the mouse poinler o the place you want to insert the texl.

3. Press and hald c!own SHIFT+ALT. and click,
|

To maove foxt by. uxing the keybonrd ' -

1. Selcet the text yau want to move.

2. Fror the Edit menu. choose Cut command, -

s o e - -

3. Mave theinsertion point 1o the place you want the cut text to appear,
S Or

Seleet the text youwant (o replace with the copied text.

I From the £3dit menu. choose Paste command,

4.2,7 TFormatting Text C e

The documentcan be made attraclive and professional-looking by formatting the text, Thcrc ore
different typus of formatting (hat can be applied to a dacument such as, character styles, fonts,
dilferent font sizes. paragraph alignments, etc. ‘ : .

]

Changing Charncter Styles .

Moare than one ¢harcter style can be applicd to the same characters,

To apply a character siyle

I Move the insertion pointio the place you want to stact “/oing text, or seleét the text whose style
you want Lo change, : .
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2. Trom the Character menu: choose the style you want. If text was selected, it now appears i the
style you chose, ['no text was selecled, the text you type will appear in Lhe style you chose.

RN et
.

To cancel o characier siyle i o ) 2

I, Select the text whase style you wanl o eancel,
‘2. Trom the Character menu, choose the style.

‘I'his does.not apply to Regular style.
“Tacancel all character styles

1. Select the lext whose slyles you want o cancel.

2. From the Character menu, choose Regular.
Changing Fouts and Font Sizes

Ta change lonts or font sizes by using the anls command :

[. Move the insertion puml to the place you want to ch.u‘\L_,c the font, or select thc text ynu wani (o
change,

2. Trom the Charaeter menu, choose Fonls command,
3. Inthe Fonl box, type or seleel a fonl name.

4. In the Font Style box, type or sclect @ stvle lor the text.

In the Size box, type ar select a lonl size. ) -

A

6. Choose the OK button,
Change Paragraph Formuat

By default, paragraphs are single-spaced and leR-justified. This means that the pardgl.tphs are
aligned along the feft margin with a jaggered edge on the right. The paragraph can be formqltcd
according to one's choice and rcqmrt.mcnt ‘using the commands from the. l’aragraph mcnu. ,

To change the -paragmph Jormat

1. Plaéc the insertion point anywhere in the paragraph you want to change, 1
Or

. o

. If you want fo ch.mg. more than one pangraph select text from the paragraphs.

2. Trom the angmph menu, choose another JIIU'LI'HCI]! or line spacing commands

I vou choose Normal, Write ullgns the parﬂgmph.ntzthc left.margin and rn‘ﬁkcs it single-spaced,
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I youmake ¢ mistake while formaiting, yau cen choose Undo conumand from the Edit menu.

43 PAINTBRUSH

Paintbrush is the tool that can be used to create sim.ole or claborate drawings. It is almost entirely

mouse-driven. Unlike other accessories, Paintbrush makes use of beth meuse bultons. The night '

mouse button is uscd for certain specified tasks only, but almest &1 the functions are performed
using the lefl mouse bulton,

4.3.1 Basic Coneepts

‘The major pertion of the Paintbrush window is taken by Ihc dr awmg urea where you create or
change a drawuu, :

The Toolbox containing the 1ools used to create and change a drawing is arranged to the left of the
window, Any tool can be selected by clicking on the desired tool fram the toolbox,

The Linexize hox containing the available drawing widths is in the tower left corner, with an arrow

pointing lo (the current line width. Tae line width can be changed by clicking the desired ling width
or dragging the arrow 1o il

The color ‘Pa}’e!{e is it the bottom of the window.-The box to the left of the palette displays the
sclected forcground and background colors. The foreground color is in the center and the
background color in the border, When you starl Paintbrush,.the background color is white and the .

forepround color is black.

To select differcnt buckground colour

¢ Pointto the color in'the Palette, and then click it using the right mouse button.
To select different foreground colour

¢ Point 1o the colour in (he Puictle, and then click it using the It,ﬂ mouse bution. -

The palette not only conlains celors but alsa (he palterns.

Drawing
Araa
T~ \{luv; Tcxt l‘hl- Onplono Help
—
4 AT """""--....__
'y o '\-\‘_-
Toolbox-
N
Linosizo
- Box- -
T
FPalshke .
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4.3.2 Worlking with tie Tbuls' '

Thc (oolbox contains the tools for tlrawing in-which .cach ool has a different funcfion. The

following list bricfly d(.b{.lth‘.(. acl tool's function -

\

Color Eraser-

Rounded Box —

Circle/El PSE ——

Scissors —0% " Pick

- Alrbrush —-——- i abol——Text

y ——— Eraser

Paint Roller — Brush

Curse "'_"(j? / +—Line

Box—1L 1 BH— Filled Box

L

— Filled Rounded Box

OO
& €8

7

—Filled Polygon

PO['}"QOH ——%

| Filled CirclefElipss.

Thigtool

" Doeg this

Scissors
P.ick- tool
Airbrusl:
Text tool -

Color Eraser

Eraser’

Paint Roller

Defines an area to cut. copy, or changc

Dcf‘ncs 4 rcclungul e to cut copy, or changc
Creates a cireular spray of dots

Adds textto the dr;nvi:}g

Changes portions of the foreground color to the background

color, or changes cvery oceurrence of one color 1o another

color
Changes foreground colors 1o the sclected bac2round color

Fills any closcd shape or arca with color

Windows Accessories'
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Thiy tool Docs this

-

T—tr
it

Brl:l'sh ) M9 Draws freehand shapes and lines ,

Curve " Draws curved lines
Ling Draws straight lincs 1_
Box Draws hollow squares and rectangles . P
Filled Box Druaws squares and rectangles itled with color

Rounded Box Draws hollow round_-corncrcd squares and rectangles

Filled Rounded Box  Draws round-comered squares & rectangles filled with color
Circle/Ellipsc Draws hollow circles and cllipses |

Filled Circle/Ellipse Draws circles and cllipses filled with color

Polygon Driws polygons from ¢connected straight lines

Filled Poiygen Draws polygons filled with-color

4.4 OTHERACCESSORIES
There are more accessories other-lhan Write and Paintbrush that can also be used. The following list
describes how usce the aceessories, :

S

Use To ;

Culeulator Do simple, advanced scientific and statistical caleulations. y g

Calendar . Record daity appointments and sce monthly schedule at a glance,

Cardfile Organise and manage information such as names, addresses and phone
mimbers, ‘ -

Characler Insert extendled characlers not found on most keyboards into documents.

Mayp ) - : -

Clock : Keep (rack of lime.

Media Play multimedia files, such as sound or animation, and control hardware

Player devices, such as« videodisk player,

Notepad Creale noles, wrile short memos, and cdit and create batch files.
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Wera .

Use To

T g R

Reconder Record aseguence ol keyetrohe: and mouse sesinas w play iack later,
. PR P t
Sound Play, recorch amd edit dizitized sound {iles.
" Recorder . '
Terminal Conneel your compuicer e other compulers and exchange infermalion.

or the funclioning of the Terminal, Mecha Player and e Sound Recorder relevant hardware is
rcclmrcd o be installed on the computer. The rest of the sccessorics do not require any specific
harewire.

Cheek Your Pragress

Fitdin the blanks :

» Al programs in the Aceessories group da not uller (ul) range of functions, they are-

called

° Tumove to the next line.in the document. press +

¢ I'he . comniand is used lo open an existing file,

2. Apart from the deswing aren and the parts ol the windows, what else is seen in the Pamlhm"'
window. Explain them brielly,

L L L

4.5 SUMMARY | -

“This wnit gave an overview of all the programs in ihe Accessories nroun, excepd tue (wo Write and

Painthbrush thal are covered i delail. Write is a Tuil- fledged word processing 1 bregram. Although it

it nol as poserful as some ather windows-based word processing prograris, bt it docs have the
apability 1o format fext, .I{IJI.M spacing, and align paragraphs. '

faintbrush is a powerful driwing program for c.n..:luu, Iree-hand drawings. Even il onc is not
skilled artistically, still can easily crealte graaphics thai {.omlwm text and basic geometrie-shapes,

-

ST g nt L L e, LS e b p—-
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Microsofl Word i ts a [ull-fealured Word Processor that can be used to create lcttcrs, memos, reports,
newsletlers and just about any other kind of document.

It is essential for thr user {0 know MS-Windows before starting MS-Word because it, works under
Windows environment. 1. will be casier for a person to learn MS-Word if he is already acquainted
with WordStar, as MS-Word is an enhanced form of Word-Processor WordStar,

Unit 1: covers the fundamental features of Word.

|"'

e

Unit 2: explains the various typing and Ldllmg features in MS-Word, including AutoCorrect and
AutoText which speed up the lext entry. -

Lhyit 3: covers the various characler formatting and p.udgraph I'ormatlmg features. Autolormat
feature allows specdy automatic lormatting,

Unit 4: describes the various Page Design and Layout features, Table Creation and handling has
been discussed in detail. It shows how the frame features facilitate in wrappmg the text
around the m:.ul:.d ]JIClllILb or graphics cte.

ut 5 introduces you to Mail Merge and Macros. The various advanced techniques of Mail Murpe
have also been discussed. .

Lnit 6 : is the Tast unit of this block. This unit explains the document management concepts,

ATier learning MS-Word. il woild be easier for the user 1o Tearn Excel and Powerpoint,
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. Structure

1.0 Infraduction

.1 Objectives !

1.2 Starting WORD

1.3 The WORD Sereen

1.5 Additional Fealures
I.5.1  Using the SHOW command
[.5.2  Changing the CASE of text ,
£.5.3  Moving & Copying text with drag & drop
[.%.4 Tustifying text : ‘
i.5.5  Crcating Bulleted & Numbered lists
(.56 Arranging & Moving Bctwecn documents

.6 Summary

1.0° INTRODUCTION

Consider the following typed letter:

Jlllr ' L3
i .

Dear Anu,

C-1/45

. Janak Puri
. Delhi-110 058

We both have holiday next Monday. What do you say to a trip to-muree and a ramble in the
‘gullies? We could start.early, say 6 a.m., in my car, and take some group with us, and make a day
of it up in the cool, It would be a change from this heat down here! It you agree, I will arrange the

you.

picnic, and be rourd af your house at a quater to six on Monday morning, Bring Your camera with

Yours

Rohit

Just notice, in this letter, there are some spelling crrors, typing mistakes, missing . waords, missing

lines, a paragraph to be moved down and so on.

-




tn. order 1o make the changes, the entire document has to be retyped and if there are many
dacuments ol this sorl, the time and eifort required to retype each'would be phenomenal.

Sueh work, delined above, is called Word Processing,

A ward processor is i soliware package which helps enter und cdit a document much fuster than the
usual manual ways., Mosl of the word processars today atlow much more than allowing one (o
enter and cdit a documenl,

The folfowing is a dist of some ol the functions that are possible by using a MS-Word:

e Typing out the document

o Saving the document

e Cpening an existing document

o Moving ar copying purageaphs (rom one place in the document Lo anolher
o F.nding the words and replacing them with another word

° Sl::l;'ching Ior spelling errors

s Printing the document ele,

In (his unit, you will Tearn o use the word processor Microsoft Word (MS Word), MS Word is a
windows bascd application and is a normally available as an icon in the Application group or the

MS Chfice group.

1.1 OBJECTIVES

After poing through this unit, fou will be able o
s slirl the WORD software package.

¢ crenle a document,

v move and copy the textwithin the document.
o printa document, |

v create bullets and numbers.

close and suve e documenl,

<

1.2 STARTING WORD

As i the case wilh other windows applications, to invoke MS Word, you click on the icon
Microsolt Ward. In application or MS Office group the following icon will be displayed. To
voke MS Word. doubile click on this jcon

o . ‘ o - T MS—IVcn-a'_Ba.'.'f'c:t:
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Starfing Word and Opening o doctmens

Ta st word and simullancously open a word document, double-click the filename of the

document in the File Manager,

1.3 THE WORD SCREEN

This section provides an overview of the major clements on the Word screen, such as menus,

toolbars and status bar.

Wihen the word is started. o new, blank document appears on the word screen.
illustration wentifies cach part of the word sereen.

Standard toolbar FFormatting toolbar  “litle bar M}u bar

R L?

The following

i e L;fﬁ?"-
" ,—-_‘—{gn;-je ine 5

'n.]

NEIE]
B

o

Ruler Scroll bar

Ust these buttons (o switch to Jillere mi views of the-documicnt

MS-Ward Basics.



The (Menu bar) provides access lo the word t.omm:mds These commands.are grouped IOI.‘C”".I n
menis, with only the group (anu) namc dlsplaycd on the inenu bar.

The “toslhars” contain butians that Jrovidc auick access 1o commony used commands.
! 1

Clicking a butlon has the same cffecl as selecting the command from the menus, but can bc donc in
a single aclion,

The Ruler

The Ruler allows you lo aceurately scl the layout of lhc document. It allows you to set tabs,.

indents, and chdn;,c [MIEC NUITGINS.

1.4 GETsTING TO WORD DOCUMENT

This scclion explains the basic procedures for creating new documents, saving your work, opening
existing docurents, and printing. ' '

Creating a Docurient

!

To creale o new document :at any time, click the New button on the Standard loolbar. While
creating o document such as memo, letier, report, or resume, one can often save time by using one
of the wizards or templates that come with Word

A new document is opcncd and gwen a lemporary name “Documcnl 1" 1f we opencd-another new
documment now it would be named “Documcnl 2" with the next “Decument 3™ and SO on.

When you opcn a documcnt it is placcd on the top of any cxlsung once and bccomcs the uclive
document,

The next step is 10 enter the text for the document.
Opening a Docuiment

To quickly open one of the tast documents you worked on, choose it from the boltom of the file
menu. To open a dogument, click the Open button on the Standard toolbar. When the.dialog box
appears, scleet the document in the File Name box (Windows) and then choose the OK button. -

Saving @ Document

To save a document on disk. click the Save bution on the Slandard todlbar. When you save a
document for the first time, Word displays the Save As dialog box so that you can typc a name for
(he document.

Printine o Duc’mmrn!

Belore printing a <I:Ju.mcnl Page breaks and the overall dppcarancc of the document is checked by
choosing print previes from the File menu. To view the document one page at-a time, and also edit

L
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the text more easily. choose Page Layout, fmm the View Menu. When ready to print, click the Print
hulton on the Standard toolbar. ’ y

Cloxing a Dacument and Quitting Word

When finished wuosi-ing in Wore close the active document-and then quit Word by- choosing Exii
(Windows) fro:w ihe file menu. To work on another document in Word, close the active document
by choosing Closc from Uie file menu and then open the other document.

Also, several documents can be opcn at the same time. To work in a particular docum:.,nt click
anywhcrc in llb window, or sclect the clocumcnt name from the window menu.

-fﬁ.‘"

15 ADDITIONAL FEATUR‘ES'

In llus section the other special featurcs which were not present in the carller word processors are .

explained. L

1.5.1 Usiig the Show command

[

You can display the non-printing characters (spaces, hard retums, tabs, etc.} in 2 document by

clicking the “Show" button. This allows you to check that the document is laid out correctly as
shown in fig below. - '

; ,

‘The spaces bchccn characters, hard lclulm and tabs are now displayed, Viewing a document this
way makes it casicr to sce layout prob!ems (extra spaces between words, too many lines between

paragraphs, etc.). The show button is light gray lndlcatm‘g it is activated. Thesc characters are not
printed, whether or not they are displayed. ' :

Y o

To specify which non-printing cimnclc:s word dnsplays, choosc options from the Tools meny, and-

then select the Vlcw tab.
.52 Changing the Case of text N .

The “Change Cise” command in (he “Formal” menu allows you to change the case of the
_ characters in iext withoul having (o retype them., -

In bricf, (o change the capilalization of text
I. Sclect (he text you want to change.
- 2. From the Format mem, choosc (,Imnge Case. e

L

3. Seleel the optmn vou want, and then choose lhc OK bulton,

a\'ﬁs"Wm'rHJn.'rft S - - _ B -, R .9
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t

For o quicker mc:} od of achieving (he same results, select the text vou want o rt.pl:u.r:, and then
press SHETSS un'll the text has the effect you want,

The Change Cose command, unlike the all caps and small caps formats, does not apply formats.
Ingtead, it replaces lowerease letters with upperease letters, and vice versa, - Nolce that Chanpe
Case does not remove (he small eaps formal, you must remove the format [0 make (he lelters
lowcercise.

1.5.3  Moving & Copying text with drag and drop

You cun mo®e fext within a document by dragging it to a new localion. This method of moving
text s known ux drag wnd drop™, ‘

When yau miove 1ext its attributes (size. lonts, cle,) ac.complmy it wnhoul changing the text in the
new location. L

Using drag and drop is convenicenl when you have a small amount of text you want to move a short
Way.,

To drag and-drop. you liest seleet the text you want le move, then drag it to the desired location,
When the cursor is positioned over scleeted text it changes o a while left pointing arrow.

Drag-and-drop ediling is the casicst way to move or copy-a selection a short dislance, and you can
also drag and drop tiems between documents.  However, (o move or copy a scleclion a longer
distance, (e Cut, Copy and Paste connnands are olicn more convenient.

To wove fext and graphics nusive drag-amid-idrop editing.
& il -

Scleet the ext and graphics you want (© move.

Point 1o the sclected text and graphics, and Lhen hold down the, mouse button. When the drag-
and-drop pointer appears, drag the dotted insertion point to the new location,

-2

3. Release the mouse button 1o drop the text into place.

To copr text aud graphics using drig-end drop editing,

1. Select the text and graphics vou wimt o copy.

2. 1n Windows, hald dawn the CTRI, key. point 1o the seleeted text and graphics, and then hold
down the mouse button while you drag the dotted insertion point to the new location.

.54 Justilving text
Lustification determines the way text iy aligned with respeet Lo the margins.

The defralt Tor Word is felt justilicarion which aligns text to the Ieft margin.

1 ’ MS-tWord Basics
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You can change the lustification of text by using the Justification buttons on the toolbar from leit t
irht they are: _
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1. Lelt - Justiftes text on the lelt margin,

2. Cenler Cenlers all lines of tex(; . . .

3. Right Iustifies text on the right margin:
4. lustify - Justifies text ém both left and right margins.

When you justify text the current paragraph ov sclected text is affected. The scleclcd Justlﬁcntmn
remaing in alfeet for the document antil you chanye it.

Let's see the cffeets of the different justification options by applying them to the text.

s right justily the paragraph using the “Right Justify™ button,
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The text is now allgm.d to the right margin, The “Right Justlfy" button is light gray to reflect this.
Let's center justify this text to sce what it looks like, Now click the “Center Justify” butlon.
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1.5.5 Crc:ttin_;; Bulleted é. Numbered lists

You can casily ereate o bolleted or  umbered [ist by selecting a llst ang then chckmg the Bullets
butlon or the Numbering button on the fornnltmg toolbar. Allernatively, you can click either of
these bultons belore you type a list. When you've finished typing the llst Just press ENTER and
click the same Lutton again. The new text you type is not formalted with bullets or numbms

12 - ‘I . ‘ T _ ) MS-P_Vorcj Basics

TUITTITTTT T

S g o ool



4w edsanglg sna vioving between open documents

~ All the open documents can be viewed at the same time via the “Arrange All” command in the

“Window" menu. The title bar of the active document becomes coloured.

To move to another document, you elick inside its window. or via the window list in the “Window”
menu. ' '

Check Your Progress

Ty

|

pe in the document given below and perform the following operations:

Go to the third linc of the 4th paragraph and copy it at the bottom of the current page and at the
beginning of the next page. - : ' )

. .L'-'
Cut the first word of the paragraph and paste it at the end of the first sentence, ©

Make the paragraph right justificd,

Split the screen to two portions. Set one pottion of the document to page layout view and the
other to Norma| view, .

Type in the last paragraph of one portion to the other portion and watch the changcs.

List the steps to remove this split, bring the document to full screen view, then close the

-document and quit Word,

Click the appropriate answer

I. The toolbar in Word
) provides a shortcut way of accessing commands
b) allow the current time lo bc.displaycd
¢) help in displaying the position of inscriion point

d) allow you to move around in a document

2. Print Preview is u:';cd o -
a). Save the document
b}  Print the document
c) View how the decument will appear when printed

d) Copy the document

3. The field for current time is displayed on

a) the toolbar

b) the horizontal ruler

MS-Word Basics : o 13
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c)  he stas bar

4} the verdeai ruler

4. Bring the differences belween viewing a document in Norma! view and Pape Layoul view.

1.6 SUMMARY

Afler poing throngh this untt you must have become (amiliar wilh the features of Word which mai-
v disiinguished froin the other Word processors. By now, you must be knowing how Wao .,
document appaars in different views. The various commands can be invoked either through th

(aolbar. menu or kevboard shorteut keep. In shorl, Word Processing job has been made easicr an:!
faster. The AuloSave function in Word documents helps lo save the dacument automaticatly after =

cpetain specilicsd interval of Hine.
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2.0 INTRQDUCTION

This unit dcscrlbgs the various features related to typing and rcwsmg text, selecting fext as a proup,
instead of a letter or word al a time.

Maost Word Processing cflorts, whether a note to yourself or an annual report, are created twough

an iteralive process of typing & editing. In this unit, we briefly cover some simple ways of revising,

documents.

With Ward, you can search a document for specific characters, formals, or styles using the Iind &
Replace command. :

Various ediling & proefing tools including spcll cheek have been cxplamcd Word's spelling
feature is uscd to cheek an entire document or ‘a*block: of selected text against Word’s buili-in
dictionary or against specialized dictionarics that you create. -
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2.1 OBJECTIVES - :
ARer going through this unit, you will be able to

s type and edit lcx‘t
‘s copy and move text

v finding and replacing text

® comect your [yped document using speli checker

%2 TYPING AND REVISING TEXT

When you open a new document in Word, the insertion point is at the top of the document, ready
for you to begin typing. Word inserts a non-printing character called a paragraph mark at the end of
a paragraph. Thia section gives the details about typing fext and the varjous ways of revising text,

Z2.1 Typiug Text”

Typing text in MS-Word is very casy and straight forward task, because of the useful word
processing featurcs supported by it. When you create a new document in Word you can just start

typing.

MS-Ward automatically moves the text to the next line when it reaches the right edge of the screen.
This fealure is known as word-wrap. When you end a paragraph, word inserts a non-printing
character called a paragraph mark (7). To display all non printing characters, click the show/hide
button on the standard toolbar,

222  Editing text

fam g . . ‘ : . R . ' . . .
-Editing Text includes sclecting, deselecting, deleting, inserting, replacing text which are described
in this subscctions, '

‘the curser changes shape to an [-beam when it is over thc text work area (document page).

However, when you move the cursor into the left margin it changes 1o a white arrow. The area of
U page is known as the “selection bar” and allows you to select blocks of text easily.

i Selucthag text

As well a dragging over the text to seleet i, you can sclect text by clicking actions. The actions
yeu perlovm depend on what you want to do, The options are: '

Ay Selesting a word:
by Selecting.compicte lines;

¢} Gelecting entire ser tence;

16
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d) Selecling paragraphs:
¢} Sclecting blocks of text
) Selecting the whole documnent:

1} The casiest way to select o word 15 1o double-click anywhere on the word. The s¢lected text
then appears reversed (or highlighted). ' : -

11) One way 1o seleer a complete line of text is to drag the cursor over it.

A simple way to achicve this is to click in the left margin beside the line (the cursor appears
as a white arrow), . y .

To select several lines drag e mouse in the left margin beside the text you require,

i) o seleet an ertire yerence-hokd down the-xey and click anywhere in the sentence. Note
that the punctuation mark (if any), and the space following the sentence is also selected.

1) You can select a pui-agrcrph by clicking three fimes anywhere within the paragraph.
Alternatively, this can be done by double clicking in the left margin beside the paragraph,

v) To select the block of text click at the beginning of the first line, then press “Shift” as you
click at-the end of the last line you wish to select, )

vi) To seiect the shole document click three times in the left margin, Allerriﬁtive!y, you can do
this by pressing the “CTRL" key and clicking in the left margin, i

i

2 Deleting Text

Text can be deleled by using cither the “Delete”™ or “Backspace” keys. Delete removes single
characters to the right of the cursor, while backspace removes single characters to the left,

Block deletions make it easy to delete senterices, paragraphs and sections of dopumcnts. Once you
have selected the text you wish to remove, pressing the “Delete” or “Backspace” key removes it
from the document. .

J. Inserting Text

MS-Ward offers several ways of inserting text into an éxisting document.” The simplest among ali,
is lo-move the cursor Lo the required position and start typing. The existing text will be pushed and
adjusted accordingly. ' ' .

Place the mouse poinler (the I-beam) where you want to being inserting text,

Next, press and release the mouse bytton to move the insertion point to the desired locations.
A Replacing Text

Word can combine.the steps of deleting unwanted text, positioning the insertion point, and inserting
replacemient text. "To replace text:

e
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o Seleet the (ext 1o be removed

s Start lyping (he new text

¢ The 5clcr;lcci text will he removed and the new text accomlmodated.
2.2.3 Copying and Moving

Word for windows supports all of the usual windows techniques for copying and moving
information (text, graphics or an ilen inserted from other application)

e “Moving” means lo remove (cul) the sclected text or graphic from one location and insert it in
another tocation,

¢ “Copying”™ means to make a copy of the selected text or graphic and inscrt it in another location,
jcaving the original unchanged.

Cuity, Copy & Paste ' . .

The procedurer used 1o cut, capy and paste are similar to window’s cditing procedures. If a portion
of the text is to ve moved o a different place, select the text to be moved and then use the cul
option in the edit menu. The selected text will be copied to the clipboard in Windows. Now the
Paste option is enabled in the Edit menu. To paste the text that is in the clipboard at some position
in the document, place the cursor at the stamng pomt of mserhon and choosc Edit -» Paste. The
text will be pasted there.

[F the text to be pasted dacwhcrt, is only o be copied but not removed from its orlgmal ‘position
then

o Sclect the text to be copied

»  Choosc lhe Edit — Copy option.
»  Place the cursor at the insertion point,
o Choose the Edit — Paste option Lo paste a copy of the sclected text.

The paste oplian can be repetitively used onee the copy operation is made. To try these operiations
type the foliowjng lines of text:

lxample:

If you choose to do a complete installation, can tell the installer which items you want to
install, g ' B

Nows, seleet the word yeu from the example above. Choose Edit — Copy. The text will be copied
o the Cliphoaw!  Now place the cursor after the comma and choose the [Edit — Paste option,
Agan pluee e cosan Cobeen the words items and ‘want’ and repeat the paste operation. The

b H
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If you choosc not to do a comiplete installation, you can tell the installer which items you war|
to install,

Copying From One Word Docinent to Another
MS-Word DTOVIdLb lacility to copy {portions or whole) one documcnt o another To do this, two
documents_should be opencd first. To edit two documents at the same t1me do\thc followmg

s Open any lwo documents one afler the other using the Filc menu.

! .'I ‘ - . . - o *
o Choose the Window — Arrange All option. "The two documents are displayed'in a separate
windows on twsereen, Phe active window is indicated by the highlighted title bar.

e To activile a docoment window ot your choeice just click on that document with the mousc
pointer. The sndividual dogzenis L be re-sized aceoriling lo convenience using the size-
hoxces in the lower-right corners ol the window.

" 1 N . B

o Now copy the portion of the document desired to be copied to the other document ori to the

clipboard using Ldit — Copy option. '

¢ Change the focus of input to the other document and place the cursor at the point of inseriion:

% Use Cdit — Paste oplion {o copy the documnent.
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MS-Word supporls a set of :,pccnl characters and symbols which. cannot be enlered through the

keyboard.

To inscrt these special characters choose Insert — Symbol.

The dialog box of all

available symbols is displayed for respective fonts. Clicking on the symbol displays an enlarged
version ol the symbol. Double clicking inserts the characters at the current cursor position in the

fdocument.

il you don’t see the symbol you're looking for, you may need to select a different font in thc font
box, which shows all of the fonts installed on your system. All fonts based on lhe ANSI or ASCII

L.ImIdCICI‘ sel are listed as Normal Text.
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The Special Characters tab includes additional characters such as em and e spaces, em and en
dashes, nonbrcaking hyphens, nonbreaking spaces, €, and ®.

To display and print & particular symbol, Word needs both the sereen font and the printer font that
contain that symbol. I you have installed only the printer font, the symbols may be printed
properly but+may not he displayed correcily,

2.3 FINDING AND REPLACING

MS-Word provides some excellent features as Find and Replace. which may be used for a number
of tasks, with high flexibility.  Using these -features it is possible to find a specific text in a
document, seurch for a particular nattern of text cte,

2.3.1 Finding and Replacing Text and Formatting

To find a particular 1ext in a decument. choose the Edit->Find option. A dialog box like the one in
example below appears.  This dialog box tan be used to specily the text 10 be faund. The text
found by this oprion cin be changed. by clicking the mouse at .the . position required, in the
document. The djaiug box van be reused to fetch the next instance of the text,

Example: : | ’
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The ¥Find disdog box can he nxed 0 specily thetlireetion in which the Find operation is 1o be done.
To do this nse the Search option in the dinlog box, Choose '

-¢ Down - To scarch the specified text from the current position 1o the end of document,
* Up =+ To scarch from the current pasition to the beginning of document,
e All - To search for the text in the entire document.

-
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“Special seareh requests like Mateh Case or Use Paltern Seurching can be used. . If the Match Case’
option is nol checked out then MS-WORD finds all the instances of the text specified. irrespective .

_ of upper or lawer ease characters. For example, if' the text to be found is given as "New York" then
"NEW YORK™, "new york™, are also found as matehing text, ' ' '

The Find Whole Waords Only option ¢an be used to make searches on complete words only. If not
cheeked out, all matching palterns of texts arc shown. For example. if the word “man. is to be
searched and repluced by the word “woman™, then il the above option is not checked, this would
lead 10 a search for all words containing the word “man" (e.8.. words like “human”, “manner”,
“Manmehian™ are also found by MS-WORD).

*
l!

e use Paitern Matching option helps o find text of a particular patiern only. If a particular
patera ol 1ext ts required to be found, then the Wild card characters or Operators can be used. The .
aperilars are: ' ‘ : )

N

-

o

» - To lind a-pattern like Pick or Pack, use Pack
e “-To linda pattern like Manager. Programmer or Writer use rer
_ ' v ‘ -
® <lext- To find @ word wilh the specified text at the beginning. For example, <con finds convey, -
conduet, conlract, cle. . . ) '

o rext - To Nind o text with the specificd text al the cnd, .For example,. >ion matches positicn,
o transition, portion cte, ' e

’
H

Finsding Special Characters

F

o specily special characters fike line break, tab character, white space, etc.. in the Find Dialog box,
choose the Speetal drop down list.  Most of the special ‘¢haraclers here are self explanatoiy.
Suppose it is required 1o {ind the ‘words *Indian Team” with a white space in between (the white
space might be a.tab. a single space. 2 spaces ete.). Then the correct ‘way to specify this is-by
typing the word “Indian™ in the Find What box. Now choose Special-> White Space which inserts”.
a (") in the Text box next (o “Indian™. Now type in “Team"”, So the correct search pattern would -

b “Indian™wTeam™. - R ) : ) -
'y ' - ’ " - >

-t the sinne nenner the Any f.eter and Any Digit aptions can be used.
: \ ‘ o

The Sounds Fike option can be nsed to search for-words that- sound alike. but are spelt differently,
Wards like byte, bite, ete., are sound alike patierns. The user has to be a litile alert while using this
option {available in the Fintl dialog bax), bectuse MS-Word searches aceording to what pattcrns:

4

= souned <imilar, . L -

r

Use (he Find->Replace option lo replice the text {ound, matching the specifications in the Find
Dindog hox.  This is a very uselul feature using which dne can ninke inst editing-in the existing
document at specific locations, For exampie. a business letler can be adulressed to a newy person by
replaciag the old persan’s name with the new pefson’s name but retaining the rest of the fanmat and
atvle, ' S '
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Example:

VRS
,1";‘,1‘ 5y

I~ Find \-.fﬁl:olo Words Unly .
oI Usn Pallcrn ﬁ_alchmg
- ity

fn the Replace dialog box (example above) one can make a ;,Inbal replacement ol text of the next
pattern to verify il replacement is necessary dnd comimit 10p]accmcnl

2.3,2  Using The Go To command

I the document being ediled ix huge and the user knows the page numbers, MS-Word provides a
feature Go To that »ill make navigation casier. Choose Edit->G0O TO.... A dialog box appears
like the one show: below. Use this to specify the page. section, linc, bookmark, footnole or
annotations 1o whic . vou desire 1o go. Use he text box 1o entet the number and press the OK

button. The (ollow j; gives a list ol samples lh.u san be typed in the téxt box.
0 Move o the bcgmmng of the document.
Blank wviove (o the nexl page.

P20,  Movedlo page 20.

12482 Muove Lo section 2 in paged.

N " Move Back by “N" puges.

+N -+ Move i'r-n'w;u‘d by "N" papes.

55 Mave Lo scetion 3 of cuvrent page.

I-nter Pagc Numbe__.ﬁ Azl s
B !1

‘-'5 R
Z|Section -
Linc :I
Bookmaik
Annolation
Foolnote

E tdnole : _I

D T -m...‘l‘ . ."
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P
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The ediling and prooling (oois in Word help to improve your writing -and the readability of your
{ext. These lools.can: ' _

L} L
: . |
»  Tind and correet spelling crrors. _ _ o A
- o _ |

»  Aulomatically comeet lypiag and S|)ul]ing cryors that you've Spcciﬁcd.

» Locale possible grar mwlu af or stylistic errors, supgest improvemenis and hclp you evaluate lhe
readability ofyom lext.

o . Look up synonyms, antonyms, and related words.

< Auomalically hyphenate text, Lo N

v Cheeli text in-other language.

@ Display document slatistics such as word count or paragraph counl.
2.4.1 Using the Spelling Checker B
Spell check is one of the powuﬁ.ll features of MS-Word. 1t also provme to check the spel]mgs of
the entire document mc]udm[, the header, foolcr and the hidden text. Addmg words 1o the
dictionary is possiblc. . N

The Spelling Checker provides a convenient way of corrcctmg spellmg nuslakcs in your
mcumcn‘ﬁ It compales the words in your document ngamst its own dlctlonary '

You should always check your documenls with the Spell:..g¢ Checker before you pnht :thcm.

You start the Speiling Chcl:'r\CI via the “Spelling” commmd in the “Tools“ menu or by cllckmg the
“3pelling™ butlon, ,

The Spelling Checier automatically checks the active document..
L)
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‘When the Spcllmg Checker locates a word it cannot Imd in lhc dlcuonary it s10ps, lu;,hhrfhtt, the
offending word, and display it on the “Not in Dxctlonary line.

You have the dpuon to:
1. ITgnore its selection;
2. Manually type in a correction'to {he word;

3. Replace the word with a suggcslcd word;

" 4. Add the word 1o the dictionary.

The “Sug;,cslmns box lists posalble allcrnalwcs 10 the word If it cannot find a close match this
box wilLbe cmpty, : :

To retain the word, choose Ignore and to ignore the changc at all its occurrences in the document
Choosc Iguore AII

To changc the word, choose Cﬁnhfzc and to éhangc the Wword at all its occurrences.in the document
choose Chan e All,

To add the current selccled word into the dlcuona:y choosc the Add button.

You havc the .choice (o add thé ward to the default’ Word custom dictionary, or a new custom
dlcnonary that you create. You create new ' customs dictionaries via the Opllons button.

Before you add a word 10 a dlctmnary. check lhat 11. is spelled correctly,. OthLI'WISC it will be
assumed that the misspelled word is correct

[f you have any doubts, check the word with a paper dictionary before you add it.

The Spelier Checker is not foolproof and will not catch a mistake if you accidentally type in another
word, The Sprllmg Checker does not understand the context in which lhc word is used in the
sentence: :

Exclude Dictionaries

An exclude digtionary contains words that the main. d:cuon:uy recognizes as being spelied
correctly, but which you want questnoncd during a‘spelling check. For cxample, if you prefer
“theatrc™ rather, than “theater”, add “lhcater“ to the cxcludc dictionary so llmt word will- qucstlon it
and you can change it.

Once you creaté an cxcludc dictionary, Word uses it aulomahcally with the main dictionary. If you
want 10 cheek apcllmg wnhout using the exclude dtcuonury. rename lht. exclude dictionary before
chccklng spelling.

To check a word for a pr-ct'crrcd spelling.,

I, Inanew, em ply document, type the words that you want to put in the exclude dictionary. After
typing cach word, press ENTER to muake each word a separate paragraph.
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2. From the file menu. choose Save As. Make sure that you save the exclude dictionary in the
same directory that contains the main dictionasy, '

T

In the Save File Ax Type Box, select 1ex1 oniy.

4, In the fhic name box, type a namce for the exclude dictionary. In Windows, the cxclude
dictionary must have the same name as the main language -dictionary with whlch it is
associaled, excepl that i musl have the (ilename exiension .EXC.

5. Cheasc (he K bution.
formatling that will net be saved in wext format, choose the Yes button, and lht.n choose the

JText only bultan! . :

6. When you (i
toolbar.

“ wrcatmg the 2xclude dictionary, click the spelling button on the Standard

2.4.2  Checking Grammar

During a grammar cheek, Word identifics sc.nu.nc..es that coritain possible gra.mmallcal or stylistic
errors 4nd sugpests improvements. For example, if you wrote “The project were'completed by your
team,” Word couid question the grammar, first for subject-verb agreement and then for pdsswr.
voice. Ward also qut.suon style crrors, such as wordiness.and the vse of clichés.

You can determine how strictly Word obsérves grammar and style rulcs by using rule groups.
Word provides three role groups-formal, business, and casual-which you can customize to obscrve
or ignore specific ;,:.unm.lr or style rult,s. You can also crealt. up lo lhrcc of your own custom rulc
!.IOU]').‘: , ,

Cz':cckr'ng and Correcting Granunar

Word checks your entire document, startingre at, the insertion’ pomt You can check part of a

document by sclecting that part before choosmg the Grammar command. The Grammar dialog box
can be invoked by choosmg Tools = Grammar. :
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During a prammar ciicck, Word checks spelling; however, you can (urn this feature of i

want 1o cheek spelling at this point,

2.4.32  Looking Up Words in the Thesaurus

The “Theghurus™ can be used to improve the precision and variely ol your writing. [t looks at the
waords you seleel and presents alternatives with similar meanings.  You then have the oplion {o

seleet a word that betwer fits your needs.

The ‘Thesaurus cannot understand the context in which the original word is used, so the alternatives
it olfers are nol always valid.

It is for you ta decide whether another ward improves the meaning of ihe sentence.
IFar some words, you may alse find antonyms (words with eppositec meanings) and relafed words.

To invoke the Thesaurus c!inlog box ciick Tools — Thesaurus.
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2.4.4  Using Hyphenation

Hyphenation reduces the ragged appearance of unjustificd text and allows you 1o fit more text on a
page. In justified text, hyphenation reduces the amount of space inserted between words to fill out
a line. Hyphenation is especially useful for documents that have nargw text columns. You can
hyphenate texl in the fellawing ways:

v+ Automatically-hyphenale texl by selecting the Automatically Hyphenate Documient clicck box
in the Hyphenation dialog box.

v Manually hyphcn-\tc text by choosing the Manual button in the Hyphenation dialog box.  This
command is uselful (or hyphenating part of a document or for specifying where lo inscrl
hypheins in specific wards, .

v Insert uplicin:‘:i nyplicns wihen you want to break specitic lines.
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o

- Insert ':oublcakn.g, hv phens'in hyphenated cornpounds or phrases that' you' don’t want brc-kx,n at;

a Tryplien, such zs Saatford-upon-Avon. Word will: move the enlu-c compound or pmu:w RN

. new e rather than teeak it,

The Hrar three methods fasert optional hiyphens, which Word uses only when a word oy il HC .

a0 ihe wid of 2 line. To view oplional hyphens, choose Options-from the I"oola VTHTTENEN
potnst e View b, Under Nonprinting Characters, select the Optional Hyphens, check: o o
choose thie QR Lutlen. Click l‘w. Show/Hide 4 button on lhc Standard toolbar Oplinast s
appear as the *=" symbal.

Chaese Tools —» Hyphenation to select the typs of hyphen in your document.

Cleeic Your Prageess

L -Lx-u g spoll cheek, Word uses the English (US) dictionary as lts Main dictionﬁ:_l‘_ry. sm“_':':-'.‘.-::?"‘-'--‘ o
} U:ﬁ.DIL_ st e ‘.'..‘::....-.;-._',':'..."E e -'."4'—"-5‘--',-;‘:.:..-..-,-.-__-—,;,-- .. .'_ L PP
Z.  SCIENCE.DIC
3. -CUSTOM.DIC

g, FRENCH.DIC |
7. Bhift+Z, ' : Y
3. Tab+z N -

4. Cul+Z

T LT CUAC LSS R T

2.5 SUMMARY

After going through this unit, ‘you must have ledtnt Variots* ways of edmng text. You st i e
Clearnt how the use of find conuuand facilitates thc repeated ocourrence of a woxd or vext
document. - o . :

(‘onstrucuon of standmd documcnls such as menus, proposals and contracts whick ..u*owuu.
i‘rcqucntly used addresses can be mmade casier with AutoText and’ AutoCorrcct entries. All the
cditing tools described in this unit help you develop and refine thc conlent of your documents.
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3.1 - Objectivey . T
12 Formalting Text Charuc_{crs
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2.0 INTRGBUCTION

o

Zhe formadting feanue i Word sely v document dparl from others. A well designed document

uges formatting o provide visual cues ghoud ils struclure. TFor cxample: you can work through a,

documgnt appiyingermats o hescdings and summary paragraphs one by.one but Word provides an
easicr way 1o store Siglom combinations ol formalting by defining the combination as a style, You
can then apply that cambinagion to 4 paragraph simiply by selecting the style from the style list.”

Ta ity wgi, we explare a few more formudling teclinigues and then -show you how (o tum
combnations: o forgags inta styles that you con apply with « couple of clicks of the mouse button, -

(o this ung, yoo'li fearn how o produce aitractive documents even when you're in a hurry using the
AutoFormat cemmand on the fermat menu,  This unit introduces you to Templates and Wizards
which serve ng mpdals for new docun,onis: '




3.1 OBJECTIVES

Aller going through this unit, you will be able to

lormal paragraphs, boarders and shading

o align paragraphs in a.document

s use templales

3 create document using the existing templates

77 TORMATTING TEXT CHARACTER:S

(haraciers mcludt, Icllcra, numerals, symbols (such as. @, *, and &), punctuation malks, and
Spuces, :

This seclion provides general information about character formatting. To change the appearance of
lext, sclect the text and then apply the formals you want. If you choose a command without first
setecting text, Word applies the formats at- the insertion point. Text that you type from that point
iorwitrd has (he new formatting until you change the format again. Text that you typc takes on the
formalling of the zmmcmalc[y preceding text.

You can also sec which formals are applied to text by selecting the text and looking at the setung,q
i 1he formatiing wolbar ar in the Fonl dialog box. -

Tz ters formalting tools include:
A ;

a ek [onis

© :Pi;:l-: '_J'onlé sizes

v Pick u'ndcr]im;, slylcsl

+ Add et_;f'ccls like superscript, Sl'JbSC:.I'ipt cle. .

»  Change defaull characters

o 'Cl]ang.c characlers spacing

e Tnserl special characters and symbols'-- E

* Change case

o Create drop caps

Fo:;.-r CrJ:;*.-m‘(.;nd

Seleel Formut — Font. This opens a two table font dialog box,

Formatting Text . , , ' - J}‘_}
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Lxample:
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The default button in the Font tab of Lhe dialog box can be used to make the default settings.
Characters Formatting with Formatting Toolbar

This is used for modifying character appearances.

Example:
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s Pick n Font rom the formatling teolbar and set point size or loggle between bold, ialic,

underling as’required.
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Characier Formatting Using Font D::rz!og Box .

2 (Choose Format = [onl command.

v Choose FFony, -the-stylc and size, underline ‘and color settings.

bottont with the chosen settings applicd.

13

A sample is displayed _at‘th'c

o Lffects hoxes allow Lo specify Strike Thrbugh, Supersc-ript, Hidden, All Caps etc:

ﬁl“' i S
__‘(t,‘ L‘_'ﬁ el

Gmall Fonle
T Symbnl
P Hyslom

B T rutningl

- wal 3
1 ndnilingss %&‘X%i:-f{ b

,-'-.\

H
. 'H!
: ;‘::. Lif'm-;- j
.;-’,m}gafgolum ey

[{mmu] {@ Aulo ;
K PO L o S s s P ,gr;:, e T35 TV T TR YR
e Elh::l..la._ R TR TP ::';,-’-f‘lﬁ"_‘;"-';" 7 Pioviow ot

‘!‘ .aluku!hrqughfl‘rzzl d

l_r"

mf-a ‘%‘.'Eusri‘.m«a R
ansT‘%?,e. nL*AU“?ai"ﬁpw

Chrracter Spacing

Spacing allows overriding lhe standard spacing between characters in terms of I point,

¢  Choosc the text o[' mierest,

v Scleel the characler Spacing tab in the Font d:alog box. Select Expandcd/ Condensed from the

Spacing list.

°  Choosc a ncw sciing by typmg, in the By option box or.cllckmg on the tnanglcs and watch the

preview change. Click OK to save changcs
Colowr Chaice

. Choom, lext of;nlcmsz

* Choosc desired color from Color option box in the Font tab of the. Font dla.log box and click

OK.

While printing the document on the printer, enable color setting of the printer.

'C.‘hfmg.f'.!:g Case

o Select lext and choose Format-> Change Case.

»  Point to the destred option and ¢lick QK.

Formatting Texi
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3.3° FORMATTING PARAGRAPH

In Word, a paragraph is any amount ol text, praphics, object or other items that arc followed by a
_ paragraph mark. A paragraph mark is inserted cach time while pressing the ENTER key. In order
to change the formatling ol a paragraph, sclect the paragraph and then'apply the tormats you apply.

Paragraph formats affeel the enlire paragraph and new paragraphs keep the formatting of the

preceding paragraph. Paragraph marks store the format of cach paragraph. if the paragraph mark is
deleted, the text in that paragraph becomes part of the next paragraph, -
' o Lo I

“To insert a new line mark, press Shilt -+ which pushes the text down to the next line, but doces not
ercate a new paragraph, To modily the appearance of paragraphs; use the ruler, the formalting
toolbar and the Paragraph Diulog Box or one of Word's paragraph formatting shortcut key
combinations. The various ways in"which the Paragraph formatting can be done is described in the
following subscclions: ‘ ' ‘

33.1 Centering, Right Alignnient and Left Alignment

‘By default, lhe text in Word ig left aligned. .But these aligmﬁcnls can be chanpged as described
earlicr in unit 1. y R
3.3.2 Indenting text o

Indenting a paragraph cnables it to set off from other text.
» To indent parygraphs auematicatly, drag e o}y hall of the trinngular indent markér to the right
. . Ve . ' i T - . P
to the desired position. Aflernatively, you can'seleet Format — Parapraph and enter a setting tn
the first line Tndent box in the'aragraph dialog box. :

e To incrensc or decrease indents by one Tab stop, use the Increase Indent and Decreasc Indent -

- butten on the formutling toolbar.

the triangular indent marker lo (he felt to the desitred position. You can also sclect Format —
Paragraph awl enter a sctling for the ‘first finc indent box i the paragraph dialog box that is
farther lelt than the indent of the paragraph as a whale,

Notice the different between left and right margin and the paragraph indentations.

The margins establish the overall widih of the main lext arca and (he space between the main lext
area and the edges of the page. :

Left and right indenis are measured (rom the l2[l and right marains, respectively. The-(irst line
inderit is measurcyd relative 107the lefl indent. The nepative lefl-indent measurement for the texl
appears when the text rins into the left margin. ' -

3.3.3 Tab Stops

By default, the Tab Stops aré sctat 0.5-inch intervals from the left margin. The insertion point can
be moved to the next (ab stop in the current paragraph by prussing the TAT Key.

» To create a hanging indent (an indent that sticks out beyond the paragraph), drag the top half of-
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Use the ruler Lo set 2 tab stop at a particular position or to change the way text lines up at a tab stop.
Taset tab staps

L. Sclect the paragraph in whisk vou want to set or change tab stops.

2. To scl or change the fab alignment, click the Tab Alignment button at the ‘far left of the
horizontal ruler until the tab alignment is the way you. want it to be.

To sclcc.:t | Click .

Lefl t-aligned tab stops - _l . . L

Centered tab stops : , L ,
Right-aligned lab';stop.s | Ny

Decimal tab stops | S l L

.

3. On the rujer, click where you want to sct a tab stop.

Also you an set precise imeasurements for tab stops by using the Tabs command on the format
men, :

Eor,

e

ST z* ».'
R

- To move a tab stop, point to the tib wiaker and drag it to a new position. “To clear a tab stop, drag
the tab marker off the ruler. : ' ' S

Fmrmafﬁyg Tyxi . R ; L - 33



The spacing between the default Tab Stops can also be changed but this will alfeet only the active
dacument. '

To do this, type or select the distance you wanl between the tab stops in the Default Tab Stops box
and then click the OK button. '

3.3.4 Line Spacing

Linc Spacing datermines the height of cach line of text in the paragraph. The defult (single line
spacing) depends on the size af the font characters. Individual line spacing is casy to change.

The indents and spacing tab of the Paragraph dialog box provides a drop-down for simple but
elfective controi ol (he space between lines under most circumstances.  The preview area
demonstirates the relative elfect ol single, one-and-a half’ and double line spacing, Single spacing
cavses 12-poinl line spacing, 1% line spacing is |8 points and double spaced lines will be 24 points
apard,

- All these line spaci settings can be made by choosing (he appropriale options from the Line
spacing menu in the Paragraph dinlog box.
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When you use these choices, Word will compensale lor graphics, superscript and large or small
lype sives,

3.3.58° Parvagraph Spacing
Word enpbles cach paraeraph o give unique before and afler spacing if you wish. The spacing

sellings cin be in points (pr. inches (In), centimeters. (em) or lines (1i).

iy et i L
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ne .1dv iage to adding spage this way is that (he spacing belore and after parapr aphs does not
change the pdint size of vour text. Another advantage is that you can use dilterent spacing
combinationy for dilferent purposes,

Headings often have different spacing requirements for body text.” For instdnce, you may require
difierent before and alter spacing designs for figures and figure captions as well. Also you can
have umique spacing specilications as part of a style, making it casy to Keep the look of your
documents consisient. .

The Paragraph command on the format menu can be used to add space before and/or the paragraph.
The otiwr advantages of using the Paragraph command are:

L. You can make precise adjusiments 1o the spacing between the various text elements. TFor
CRIUMpIC, you can use paragraph spacing to c..I.mfy the relationship between headings and body
e

=l the paragraph 15 moved or deleled. its spacing goes with it.  The paragraph doesn't leave
behind extra blank lines.

3. youinclude spacing in the paragraph styles you use to format text, Word adds the space along
with the other lormatting. You need not add blank lines manually.

136 Dorders and Shading

You can add bor ders, {o any side of a paragraph, and you can add background shading. You can
aise add borders and shading to ordinary text and to the paragraphs in table cells and frames

-

Job 0 DOCUMENT TEMPLATES

ocament Tenmlates serve as a boiler plate for a new document. It is basically a detailed
dsunient with presel text and formalting on which a new docurrent can be based by amendiug
thee siccording o our requirement.

J.4T 0 Template Wizards

To avoid the routine repetitive work of crealing new documents, it is best lo base them on templates
desigtied for the types of documents you create most often.

A femiplale is a blueprint for the texl, [_,lElpthS, and formattmg of a document, A lemplate also
stores styles, macros, AulaText entrics, and customized Word command scttlngs These items can

help you work faster on a particular type of document.” ' "

Ward provides templates for comman types of documents, such as memos, reports, busincss letlers,
fax forms, invaices cle, You can use any tcmplalc as it is or tatlor it to your SpC"iﬁC requirements,

Using Template WWirards

To have Word do moare of the work for you, you can usc a wizard to creale new documents.
Wizards take you slep by step through the process of creating common types of documents,

Formetting Texi i T 35
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There are Wizards for common documents such as letters, agenda lists, faxes ete. Let's find out
g |

how 1o use a wizard by ereating a lax cover sheet wilh the “Fax Wizard™.

Pleasc double click the “Fax Wizard™

-,
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The first time you use the. Fax wizard, you rcquired to fill in your personal information and select

“options for the, fax cover sheel.

sheet,

This information is then automatically placed on the fax cover

It is only necessary to enter your pcrsonal details the first time you use the fax wizard,

An cxample of how the lax cover sheet w:il look is displayed. You need to sc!cct whether you

want it to be prmtcd down the page (Porlrait) or across the page (Landscape).

In this example, let us sclect the “Portrait” setting which is common for fax cover sheets and .
continue. Click the “Next” button in' the dialog box. You can choose from thrcc styles for the fax
cove: sheet. The current onc is the “Conlcmporary style.

Let's creale

box.

a fax cover sheet using the “Madern® style.

Click the "Modern™ style in the dialog
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A preview of the “Modern™ style fax shcet is displ
n ilie dialog box. The name and compan
automatically inserted ints (he *Name” and
ames you want in the refevant baxes,

ayed. Let's continue by clicking the next button
y name that .was entered during installation is
“Company Name” boxes. To change it, just enter the

i S B

In this example, lot's leave this unchanged and enler the mailing address. First, let’s click inside

the Address box. Let's enter the mailing address which is (775 Eagle Rd, Lakeside CA 2049} in [
this example. .' ' = _ , :

Let’s go to the niext-step by, clicking the “Next” bution in the dialog box. .

] e S

Sunpslivpiaddigeaaniich o]

o
Y :
775 Eagle Rd
Lakezide CA 2049

The next step is to enler the-Tax and tele shone number information in the relevant boxes,
; | r

In (his example. let’s assume that our lclephone number is (245) 678-6518 and enter it in the

“Phone™ box and enterthe fax number which is (245) 678-2171 in the “fax™ box, |
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You can go back and change any of the information or sefections you made in’ previous steps via

Lhe “Back™ bullon.

The “Finish™ bulton creates the fax sheet with the options and personal information you entercd.
You iypically uscithis to create fux cover sheets after the first time, if none of your personal
informaltion has changed. - e C -

Let’s go lo the nexl step by clicking the “Next™ butlon in the dialog box.
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You sre given the oplion of displaying Help afier tac fax cover sheet is created Let s accept the
default setting which is “No" and create the fax shect.

A new document for the fax cover sheet has been crealed.

e —marmosE e - o .

To display this document at full sereen, click the “Full Screen” command in the “View” menu. .

You now save and namie the document as you would any other.

The next time you create. a fax sheel with the fax wizard you don’t need to enter the seader
information unless 1t has changed. - ‘

3.4.2 Starting a New Document from a Tcs;nplatc.

You can save lime by basing new documents such as memos, letters, and reports on one of the

templates (hat come with Word. Irom the Tile menu, choose New, and then sclect the template you
want.  The templale you can use are displayed alphabetic in the ‘Template” list. “Normal”
Template is the defauis for Word and is the one you use when you click the “Néw Document”

bulton.

—EML TSR
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A short dcscrip'tiOn of the current template is displayed in the “Description” box. You select the
template thal matches the type of document you want to create. For example, 1f you want to create
invoices you would use the “Invoice” template.

When, you select. a.lemplale, Word opens a copy of the template as a new document. All of the
information in the template is copied into the new document. ‘

Check Your Pirogress

[." To copy character formalti.ng from place to place in a document, choose the
2} AutoForniat I.Jutton‘
M) Format Painler button
¢y Style command in Format menu

dy Style Gallery command in Format menu

2. You can uge styles to:
- a) format yvour documents
b) Save changes (o documents
) Dglcle-léxl i documents

d) Make copics of documents

3, Toremovc a (ab from the ruler

a) Double-click the tab on the Ruler
b} Scieet the tab and press the Delete kgy
c) Select the tab and press the backspace key

d) Drag the tab from the ruler

4. The dﬁf’ault line spacing ft;r text is
105 v

2) 1.0

3) 1.5

4) 2.0
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5. Document templates allow you ta
I} Use pre-desi gnéd deeuments for specitic purposes
2) ‘Create documents step by slep afler asking the questions

3} Create and save the docnment aulomatically

ITTTETT

4) Save the changes'to the document

3.5 SUMMARY

In this unit, we have focused our main attention to formatting text which includes the two kinds of
siyles '

1, The Paragraph Styic -
2. The Character Style

By using styles to format text, you can quickly produce professional looking documents and
maintain consistunt formatting. Various formatting techniques including embellishing individual
characters. changing the indentation of puragraphs, adjusting the white space bctween lines and
paragraphs etc. have been exphiined in this unit.

'

-
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20 INTRODUCTION =

In the last unit, you've leamt a lot about Word's formatting capabilitics and how to combine
formats'to creale professional looking documents. In this unit, we’ll show you a few more tricks
fordesigning a document. For instance, the page sefup. options which included paper.size &.page .,
orientalion ete. are normally sel at the beginning of a document can be easily changed at any time. -,
We.ll-also;cover howtg ereate tables to present facts and figures.. If you've. already. set up your .
information in a sprcad_she_cl-.prqgram and don’t relish the thought of having to recreate it in Word,
you’ll be pleased to know that you can import spreadsheet data directly into.a word table. This unit
also describes how (0 create on-line forms.  Also it intraduces. you. to another:term eglled. frame.:
which is nothing buta conlainer for carrying any item, such as a graphics, a table, text or an object

linked to another file, and drag it to any place on the page. _ . o
e e RFMTs e - R RS SEEEE wrocenandd
4.1 .OBIECTIVES: . : - |

Afier going throtigh (his unit, you will beableto = - - -

© - sel up A page i.e. its layoul, margins, paper size and ils source
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» . page erientalion i.c. portriil or lundscape
« - create mirror image of the page

set up headers and footers

»
+ create tables and enter text in the lables
e sel rows & column wid(h and sct gutlers.

4.2 PAGE SETUP

You should starl cach new project by thinking about the ddcument’s overall design and final |

appearance. Word for windows gives you on-screen clues about how your document will [ook on
paper. If you give Word some basic information, such as the paper size and the kind of printer you
wili be using, it can show vou line endings, page endings, the relative size and placement of texi,
graphics, margins and so on. [n arder (o do this, Word needs some information from you, such as
the paper size and the kind of printer you will be sing. The Page Setup dialog box, allows you o
give Word all the inforination it needs,

‘The Page Sctup command in the file menu enables to set the paper su:c, page oncntatlon (portlalt or
landscape), the working of headers and fdoters, and similar ophons before you began a document.
But you can casily changc these and other settings at any ume You can also use sections and set
K I'f‘(,renl ontions For anh sccnon ‘

d.2,1 PuperSize & P;lgc QOricniation

rhc paper size tab in lhc Pdgc Sclup dlalog box ‘can be-used for selecting the paper size and the
options thal are available depend on the capabilities of the printer you selected

To use a cusiom paper size, type the dimensions of the paper you want to use and also be sure that
the printer is capable of feeding (e custom paper size through its printing mechanism.

Once you specity lhc size of the paper on which you wx!] print the: document, Word caiculales :

marging by measuring in from the edpes of the paper.

Page oricnlation cl;:m be verlical (Portrait) or horizontal (Landscape).

Te seleet (he papér size and page origniation follow these steps:

1. Select the Ilcxl- you want (o 'have a di-ffc_rcnl paper size qupage orientation,

2. From (he File menu, choose Page Setup and then select the Paper size-tab.

S{.Icct the paper size on which you want to print and the page uncntahon

Jh.

In the Apply To box, select how much of the document you want to prmt on the selected paper
size or in the selected arientation. Then click the OK button. -

Alsa it is possible (o change the default page size and omntahon Like, lfyou often print on paper

other tlmn the shmim' letter size '~ B.5x1! inches or if you use landscape orientation more

A ) S Page Design and Layout
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.' frequently thah portrail arientation, you can save time by changing the default settings. After

-4.2.2 Page Marpius

:.' Changing Docunwent Murgins

speciying the new settugs, choose the default button.  When Word asks you that you want to
change the defuult, choose the Yes butlon. Word saves the new deflault setlings.in the tempiate
attached to the dacument,

o
L

Margins delermine lhc distance between the text and the page of the paper. .In Word, text and : ‘_
praphics are normally printed inside the margins while headers, footers, and page numbers -are !

printed in the margins.

Ward gives you three ways to sel margins. The most straightforward method is to use, the Margins
portion of the Page Sclup dialog box, reached with the File — Page Sclup command.
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You ean afso drag marging using the rulers in Print Preview. This lets you see the resulls of margin
changes alter a slight repagination delay.

b RO,

cinally, you can drag new me:rgins wilh the rulers in Page Layout view, The margin brackels are
located on'the.ruler. Let's look at all three techniques, slarting with the dialog box.

Follow these peneral steps to change margins [rom within the Page Setup dialog box:

1. Place the inserlion-point on the page where you wanl margln seltmgs lo be changed (unlcq

plan io sce the Whole Document ¢l.oice). o .
. b .

2. Choose I7ile -= Page Setup,
3. Ifneed be, change papu size and vrigntation by using lhc Paper SILC tab.
4. Switch o the Marging tah ifitisnot 1I|Lndy displaycd,

§. Curicnt scttings arc shown in (he various margin dimension boxes.

Page Design and Layont ’ . i



6. Type the dimensions you desire. or ¢lick the little triangles to increase and. decrease settings.
The Preview will change as you work.

.
¢

7. ,._whcn satis(icd. click OK.

Dlmcnsmnai settings m most of Word dialog boxes can be expressed in inches (m) pomts {pt),
centimeters (cm). picas (pi), and, frequently lines (Ji). For instance, 10 set a-top margin’s height 1o
12 points, you would type 12 pt in the Top margin box, to set a onc-and-one half line top mdq,m
you'd type I 51i, ele.

While you can Iype other measurements, Word will convert them to the default measurement wlen
vou close he diatog box. You chunge the defiwlt measurement in the (.:cnn,ral tab of the Options
dialog box (Tools — Gptions).

A {!enmn.' Fucing (Mm r:r) Murping

Select 111(: Mirvor Margins feature in the Margins tab of the Page Setup dialog box (Fife — Page
Setup) when you want difterent left and right margin widths and your final output will be two-
sided. Word makes inside margins of odd and cven numbered pages the same size; and does the
same with the outside margins of odd and cven pages. This is how you get white space on the
- appropriate side of cven and odd. two-sided pages.

When admshng margins in Print Preview, if you've chosen the Mirror Oddeven fcature display
two pages in Print Prcv:ew so that you ¢an scc the diftferent margins.

Gutters Facilitate Bf'mh'ng

Gutter margins-additional white space in (he inside margins-compensalte for the paper tucked away
in the binding of a two-sided book (hat would be unrcadable. The gutter width, which you specify
in the Margin tub of the Page Seuup dialog box (IFile = Page Sctup), reduces the text area. Instead
of using putters, you might simply want to incrcase the size of the inside margins to accommeodale
binding.

: 4.2.3 Headers and Footers

"f’cadw s and Foofers are plices w put repelitive mformation in a document’s 19p and boltom
margins-headers print at the wp, Tooters ut the bottom. You can yse headers and footers to print
something simple on-vach page, such as you name. or something complex, such as a graphic.
Styblized test, dates and awomalic page numbering can all be included in headers and footers,

You can use identical headers and footers on all pages in your document, or you can specify
dilTerent contents [or cach section of the document, OQdd and even pages can have different designs
iFyou wish, 1he first page of each docoment ol ¢ach scetion can'be unigue.

I Ward 6. header and Tooter cditing alvays rakes place in Page Layout view. You work right in
the header wnd Iooter arca of your document after double-clicking to unhide it. -

You can apply vistuadly any paragraph or character style to your headers and' footers using the
Formatibng toolbar and rulers, They will repeat on all pages thereafier. '
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" Once headers and foolers have been added o a docurment, it is powlblc to sce z'.nd cdlt them in P'l,g,c

5.

" You enter foolers the sane way as hc;ldcrs. CXC

Layout view. Thev arc aisn dispiayed in Print Preview, but when you attempt to open o header or

footer in Normal view or Print Preview, Word swilches you to Page Layout view and displays-the
Header and Footer toolbur.

Creating Basic Headers and Footers

To enter a header that repedts on alf pages in ynur document:

I.- Choose View = Header and Footer or double-click in the header arca of the first page to be
madificd in Page Layout view or Print Preview,

2. Word wrll switch (o Page Lay ot view §f° it is not a!rcady there and display the Header and

Fooler toolbar.
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Crcate und edit headet text as you would any other.
otherwisc format you work normally,

Use the autoematic page-number., (ime- stdmpuu,. and date-stamping features described later i
this chapl(.r

Double-click in the main document 1o relurn 1o work there.

pl that you work in a Footer window,

The Layout tab of the Page Setup dlafm.. box hCII]b in:
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1. .Crcating Different Headers and Footers for Odd and Even Pages

2. Creating Different Headers and Footers for the First Page
]

4.2.4 Putting Page Numbers -il:l Headers and Footers

automatically number pages. You can choose from many

bers nearly anywhere that pleases

d paginatidn on
i

Word offers o variety of tools to_help you
page numbering foymal and style choices and position page num
you. Lel's explorc these features and discuss the effects of document sections an

- page humbering.

If you plan 1o break a document inlo multiple scetion, you may want 0 insert page numbers before
yau split the document into sections. Olherwise, you will have lo repeat the pagc-numberinifor

each section ol your document. S , : £
Page Breaky

Ward uses “Solt” and “Hard™ page breaks to indicate when one page cnds and another begins.
Then arc two categories of page breaks: ' S :

a) Solt Page Break
by Hard DPage Break

a) Soft Page Break are automatically inserted b'y Word, when text reaches the bottom ‘of the
- page and are represented by a dotted line across the document. The text beneath it will
appear on the second page if we print this document. - -

. The position of Soft Page Breaks in a document automatically changes when text is added
or deleted to reflect the new page boundaries. '
b) You insert Hard Pagé Breaks when you want to end onc page and begin another. This is
' done via the “Break” command in the Insert menu, or by pressing the “Cyl+Enter”.

Hard Page Breaks appear wilh_ the words “Page Break™ on the line. They remain at the
exacl same spol in the document regardiess of any text changes you make.

To remove a hard page break you position the cursor just after it and press the backspace
key, or position the curser at the start of the page break and press the “Delete™ key.

Repagination

In order to display and print page breaks properly, Word must recalculale page endings after you've
made changes. Normally, this is done automatically in the background whenever Word can sical
some otherwise unused computer lime. This process is called automatic repagination. Since page
endings affect certainother features word always repaginales when you '

¢ askitto point
» arc in Print Preview ar Page Layout view

o complele a Table of Conlents or Index,
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Word’s Tables feature, enables you to arrange columns of numbers and text in.a document without
using tabs. It helps you to/organize complex columnar information. - 5. o oo on D -
Tables also provide a convenient way to present text _iﬁ I's'icie-.by}side' paragraphs-gs in a resume, or
to amange text beside graphics: You can use them to. create such diverse documents as forms,
television seripts, financial reports, parts catalog, and resumes. You can'insert tables anywhere you
nced, them in.Word documents, Word's table feature and the terminology used to describe “it,
reminds you of'a spreadsheet. ' o '

Word tables consist of horizontal rows and vertical columns. You do the typing in arcas called
cells. Cells can contain text, numbers, or graphics. The text in cells is edited and embellished as
usual with Word’s formatting toolbar and ruler. '

.

Cqumn"
| NAlAE® | ADDRESS0
,][Amrs:u """"""""" lesnsrmrwa\ .
| , e N
Rows End-of-cell marker ~ End-of-row marker,

.Nonprinting table gridlines. ’_ s et

L T

A number of table spec;iﬂé features let you control.the sme, shape,and appeamnce Bf éeIIs. . Border
and Shading features are available. It is also casy to insert and deléte rows and columns.

They can be created from existing text without needless rer}ping. 'Alsq t_hE table featurc can Le
used 10 organize information and then convert your table 1o text. - e

. i

Another feature, Table Wizard, helps you automate table creation. The doticd lines around cach
cell represent nonprinting table gridlines. ' '

Format — Borders And Shading command can be used to add pﬁﬁsing borders.

4.3.1 'Table Creation

A simple table can be created with the Table button on the Standard toolbar and a complex table by
the Insert Table command of the Table menu, o

To create a table with the Table button

. Place the insertion point where you want to insert a table,
2. Click the Table button on the Standard toolbar, then drag while holding down the mouse button
to highlight the number of rows and columns you want in your table. :
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3. When the displayéd grid represents the desived number of rows and columns, relcase the mouse
button, An cmply table will be inserted at the insertion point when the mouse button is
religased. .
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To create a table using the Table menut

The Table — Insert Tabic command can be used to crcalé ‘more eomplex tahles by specifying the
Number of Columns and Rows in the Insert Table diafog box.
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Entering and Editing text in a Tuble

You navigate, enjér ind edil (able lext iust as you do any other Word lext. The mouse or arrow
Keys are uscd to ilositinn the insertion point. The cells are thought of as miniature pages and the
cchi borders as margins. Type the text normally within these cells and Word will automatically
wrap text within' the cell as you reach Lhe right edge Rows will automatically grow (alicr as
necessary to accopimedate your lyping. '

To move from ¢ell to cell within a table, either use the Tab key to go forward and Shifi+Tab to go
backward.

Prassing Tab in (he vichuaost column will move down the insertion point to the beginning of -the
nexi tow and pressing Shifi+Tab past the lefimost column will move the inserlion point to the end
of the previous row, '
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The familiar character formatling toolbar, ruler and menu features work in the same manner to all
or seleeted characters in a lable.

A cell can contain more than one paragraph. Paragraph creation is done in the usual way: anﬂ
Waord’s paragraph format apply to pi 1r'u_n1|)h:~. in cells.

Within a cell. youg can have several different indent setlings, line-spacing specifications styles. etc.

Converting Text to or from & Tahle

You can converl lext separated by paragraph marks, commas, or tab charactcrs into cells in a l"lblé
and also convert a 1able te ordinary text paragraphs,

This is required al limes when you'll slart a project usmb tabs and wish you'd crcnlt.d a table or a
co-worker will pive you samc tabbed text.

Converting Text o Tabley

To converl text to a Lable, highlight the text you want to lurn into a table. Choose-Table — Convert
Text o Table.... and ¢lick the appropriate option bulton in the resulting dialog bo*c. Here's an
explanation ol the eheices: . .

Tab Lincs of text separated by paragraph marks or the breaks will become rows in you
table.” Tab-separated strings of.text within those lines will become cell entrics in the
row, Word will automalically create the nceessary number of cclumns based on the
maxinum number of tubs in .l. line,

Comma Lincs o text separated by paragraph marks or line breaks’ will become rows in you,

table. Comma-separaied strings of text within those-lines will become cell entries iz

ihe row. Word will automalically create the necessary number of columns based on
{he maximum number of commas in a line. Beware of commas that might create
uninlcnlional cells, - '

Paragraphs  Wourd will propose a single column and creale as many rows as you have paragraphs.
Changing the number ol columns will d:slnbulc paragraphs among, the columns
Irom left to right. In a tvo-column layout, the first paragraph would end up in the
top-lelt eell of the new tble, the sceond para;,raph in the. top nbht cell, the third in
(he lef u.l! of row Lo, and 50 on,

Converting Tubins o ! ext

To convert an cﬁisling table to text, seleet the able cells you wish to convert, or Alt-+double-click
- to seleet the whetle table. Choose Tuble —> Convert Table To Text. Word will display a Table to
Text dialog box, whiclt asks il' you want the table convertéd o parabrdphs, tab- dcllmllcd text, or
comnui-deiimited ext. Pick ane,

Choosiig ihe paragraph option will convert cach old lable ccll into at least one paragraph: If the
table’s cells contain multiple paragraphs,’ the paragraph marks are retainéd during the conversion,
s0 some cells will create more than one new paragraph, - ’
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If you pick the comma or tab options. . Word. will'convert each row af your table into ihc paragraph.
Cells from the tables will be separated within the paragraphs by tabs or commas. '

The Table Wr‘zrri“d

The Table Wizard will ask you some questions and format your table. Here are the basic steps (o
using the Wizard; '

—

. Pluce the insertion point where you want ihe table. Tap -l once or twice il' you've just opened a
new document, : '

ED

Choose Table — Insert Table.

3. Click the Wizard butlon in the resulting dialog box. You will be presented with a number of
screens asking you questions. '

4. Look at cach choice carefully, and select one of them.
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3. Click the Next bulton after cazh choice or the Back button to back up onc screen.

6.. When the Wizard runs out of questions, click Finish. You'll be presented with the Table
AutoFormat dialog box (which you read about carlier). '

7. Cruise the forrhial samples until you lind just the right mood, then click OK,
432  Table Modification

Modifying a table involves selecting, inserting, deleting, copying and moving rows, columns and
cells. Tt also describes how ta change the spacing and column widih and how to split a 1able.

1 Selecting in Tables

As already scen, you can selegl characters, words, and other items in table cells using Word's ysual
mouse and keyboard [eatures. In addition, Word: ajco provides table-specific sclection tools
enabling you to sclect whole cells, entire rows, columns, or arcas. The area between he first
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character in a cell and the left cdue of the cell is called the cell selection bar. When you point to it,
the mouse pointer changes directions (pomh to the right). Cllcmm, on it selects the contents of the

entire cetl.

To select a column, move the mouse pointer to the area called the column selection bar at the top of
a column, when the pointer clianges into-a large, down-pointing arrow. Holding down the Alt key

‘while clicking anywhere in a calumn will also sclect the entire column.

Selecting R vy

Ta seleet the enlire row, double-click any cell selection bar.  The same can be accomplished by
seleeting and dragging the Jeftmost er rightmost celt i a row.

Selecting Adjucent Groups of Cells

To seleet proups of adjacent cells, cither drag through the cells or click in one cell and Shift+elick
i Lhe others.

Selecting the Whole Table

To sclecl an entire table, hold down the Alt key and double-click anywhere in the table. 1f your
documenl contains multiple tables and they are not separated by paragraph marks, this technique

" will select ab! adjacent tables.

2 Tuserting Cells, Rows, and Coluynuns

A new row can be inserted above the sclecled row, a new column to the left of the selected column
and a new cell at the specificd location. To insert a new cell, row or a column, first selcet an
existing cellorow or cohimn. : _ ' :

a) To add dells to a 1able, select the number of cells from this table, next to which you want to
add new cells and click the [nsert Cells button on the Standard toolbar. The number of cclls
insericd will be the same-as llu, number of cells selected in this lab!e.

2) “To insert row in a table, sulccl lhe same number of rows below wh:ch you want new rows (o
be added and click the Insert Rows button on the Standard toolbar. The number of rows
will bc same as lhose selccted i this table.

To ucld arow at the end of a lable. position the insertion hpdint in the last cell of the last row
and then press the TAB key, The cells in the new row have-the formatting of the cells in the
preeeding row. '

c) To insert columns in a table, sclecl a column or group of columns to the right of which yo
want lo insert a new column or columns and click the Insert Columns. Word inserts a
column or celumns to the lell of the sclected column or columns.

J. Deleting Cells, Rows, and Columns | . -
The. Cells. Rows and Colunms in a Table can be deleted by lhe Delete command on the Tablc
menu, which changes according (0 what is selected.

w
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1. Changing Colimn Wiith

The: width of selected cells and entire columns can be changed by dragging the table column

markers on the ruler or by dragging the column boundaries.

To change the column width automatically, use the Autofit bution to adjust the width of columns
quickly.

J. Changiitg Row Heights

Normally, Ward sets the height of each row automatically to accommodate the cell containing the
tallest entry. For instance, if ane cell in a row needs 2.0" to accommodate the text or graphic it
contains; all el the cells in that row will be 2,07 hih.

To drag a vow to sew heiglits, Click anywhere in the row you wish to resize, The Row heights can
also be resized by.the Table - Cell Height and Width.

. Splitiing a Tuble

-

To split a table, »osilion the insertion point in the row where you want the new lable to start and
then choose split table from the Table menu. '

4.3.3 Table Formatting

The rcadability of a table can be improved by formatting the text within the table, aligning text,
creating column headings. and adding borders and shading. . The AutoFormat command from the
Table menu can also be used to automatically format the table for you, '

Formatiing Text in a Tuble

Text formatting within the table can be done in a similar manner as it is done with the rest of the

textin the document i.e, by using the formatting toolbar, format menu commands, or the ruler,

The TAB key in a table cell has a different function. It will just move the insertion p'oint between
cells. To insert a tab character in a cell, press CTRL+TAR, -

. Centering a Tuble and Aligning Rows

To center a table or chanpe row alignn‘mnl :
1. Sclﬁct the cnli;fe lable or rows you wish to align,
2. Choose Table ~ Celt leight and Width and s.c-lccl the Row tab.
3. The various orlglinns are }islcti below.
a} To center the table. choose the eenter option bullon under alignment.

b), To sct an dract amount of indentation from the left margin, type or sclect a number in the
“Indent from el box. ’ '
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_¢) Toset the alignment in relation to the page margins, sclect the Left, Center or Right option
button under Alipnment.

Creation of Table Headings

Table Headings that span several columns can be created by merging cclls. Use the Merge Cells
feature to combine the contents of multiple celis - for example, to'make a heading in onc cell span
an entire lable or a selected group of columns. You select the cells to merge, then choose Table —
Merge Cell, and the contents of the designated cells will merge. You may need to reformat text
merged this wary, ’ ‘

You can repeat table headings when a table is split betweep pages. Word m.ilomdtically repeats
table headings only lor lables that are split by “soft” page breaks, Ifa “hard page™ break is inserted
within a table or the split Table command is used then the heading is not automatically repeated.

The Page Layout view, only dispiays the Repeated Table headings on dach page.
Table Borders and Shading

An casy way to dress up a table is to add printing borders and shading. Select the cell or cells you
wish to cmbellish, then use the line thickness portion of the Borders toolbar. - Pick the desired

combination of line thickness and apply the borders Just as you would add them to. word

paragraphs. Add shading to some or all of the cells, -

Sunrise:  Stant the Offers the || |Swsrise | Start the day .
Special day with a  best price Special | with a sunrise | best price for
sunrisc for groups breakfast groups  of
break fast of four or sailing in a | four or fewer
sailingina  fewer ba!loon! R
Balloon! School | Bring  your | Special
- Day ~ {class for .a | arrangements .
School  Bring your  Special Special | tour of the | for the
Day class for 2 arrangeme grounds _ard | school
Special  ¢our of the nts for the a short trip in groups
grounds school a balloon include a box
and a short °© pgroups -lunch

Offers . the

Before adding borders and shading

AutoFormatting Tables

Word's Tablc — Table AutoFormal comm

table,

The basic steps for using Table AutoFormat are:

After adding borders and shading

and attempts to pick cell setlings that make a presentable

I. Enter, edit, spell-check, recognize and otherwise finish with your table.

2. Save the document, -

Page Dexign and Layout
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3. Select the entire table.
4, Choosc Table - Table AutoFormat to open the Table AutoFormat dialog box.

5. Preview the format choices from the scrolling list by highlighting their names one at'a time.,

6. Pick a style by highlighting it and click OK.
4.3.4 Sorting and Numbering Cells

Word’s Table = Sort Text command will attempt to sort sclected text alphabctlcally, numerically,
or chronologically at your request, Sert can be up to three levels “deep”.

To sort a table with this command, follow thcse steps:
1. Save the Iable.
2. Place the insertion point in the table'you wish to sort.

3. Pick Table — Sort Text. Word will highlight (select) the entire tabic, and you will see the Sort
Dialog box. ' - ' .

4. If you have labels at the [op of your table, choose the option My List Hus Header Row. "There
will be up to three drop-down lists contnining the column labels or column labels or column
numbers, :

Specify the sort order by chc'Josing the desired column for cach sort level. -

Choose a sort order for each column. - .

o

|

drop-down lists.

3. Click Ok and Word will sort,

435 Speciul Tasks with Tables

r

The special tasks wluch cdn be performed withtables can be pcrform ca.lculahons import data from
Microaot’t Excel, creq{e a praph, or set up a dalab'lsc .

Performing Cafcuiations ina T abfe

You dan add subtract, rnulnpl)r and divide numbers in a word tablc You can also pcrform other-

calcuiations like averages, percentages, mirimum and maxlmum values etc,

- To sum a row or column of cells, po:,mon the insertion point in thc last cell of a row or column.
The cell does not have to be emply; however, if it contains a number and you want the result of the
calculation 1o replace that number, you must select the nuinber, Otherwise Word inserts the results

without remeving the original number in the.cell. Choose the formula command from the Table
menu. Click the expression in the formula box to make sure it will sum the numbers you want to
add, then chuose the Ok bution.

Tell Word, if the data‘in each column are text, numbcrs or dates by chOOSmg from the Type "
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“I'o perfarm other caleulations, you speeify which cells to use in the calculatiqn and use the formula
for each ealculation, [n the formula box,. type between the parentheses, the cell references you want
(wy nse i the caleulhiion,

fixchuanging Date with Microsoft Eveel T
LUt S

Ward his a leenre to paste Microsoft Excel Worksheet inwo a word document. Word then converts
the worksiieet o a word tible, Word commainds can then be applied to work with the' data. The
reverse 15 ilse e,

in addition to copying and pasting worksheets, you can link and embed Microsoft Excel Worksheet.

Using o Table to Create o Graph

Word makes il casy to create a graph, or chart from data in a table. Select all or any part of the
tabic and then click the [nsert Chart button on the Standard toolbar, Word opens MS-Graph which
uscs (he selection to create a graph. You can use any of the commands in MS-Graph to format the
grapi. The graph uppears immediately below the table you selected. The inserted graph js an
embedded object. ‘

Using a Table as a Database

. Word table can-be used as a mmplc databasc for slonng information sych as addresses or client
records.

To usc o lable as a database, be sure that the insertion point is within the table, then click the Data
Form button an the Dalabase mnllnr Word displays the Data Form dialog box. Type information
i the Nclds provided.

- Check '1’0ur; Progress
[. Vo view multiple columns on the screen, switch {o
1) Page Layout view
i) Normal IVicw
tii) Culline View
i';-) Master Document View -
2. Which of the following is incorrect
i) P;lg'c Oricntation in the Page Setup command can bé either Portrait or Landscape ,

il} The Gutter feature in the Margins tab of the Page Setup dinlog box allows you to set
different left and right margin widths

iii) Heador & Footer editing always (akes place in l’age Layout View

3. The default units for the docunient m:u:gms cen be changcd by choosing whxch of the following
labq in the oplion box.

l) View (ah
1) Edit tab ‘

Page Design and Layout . ) - 85
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i) General 1ab -

iv)‘ Print tab

The maximum number of columns.in a table can be
.21

i) 30

iij) 31

iv) 11

To insert a tab characier in a cell

i) Press CTRL+TARB

i) Press SHIFT+TAB
iii} Press ALT+TAD
‘iv) Press CTRL+ALT+TADB

4.4 SUMMARY

The various options that affect the appearance of a document include the following:

9

Paper 'sizc

" Page orientation (Portrait or Landscape)

Margins

. Headers and Footers

Page Numbers .
Line Numbers

Number of newspaper style columns

When.you use the Page Setup command on the file menu 1o specify a paper size, the options that
are available depend upon the capabilities of the prinler you selected.

By the end of this unit, you must have also learnt the crealion and usage of Tables, Frames.

Page Desigys and Layout
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Structure
. 5.0  Introduction
5.1 Objectives
5.2 Mail Merge ' | .
5.2.1 Dara Sources-& Main documents

5.2.2 Starting & Editing the Main document
5.2.3 Merge Printing Envelopes & Labels

53 Summary

5.0 INTRODUCTION

The Mail Merge feature and the Macros have been described in this unit. Word’s Mail Merge
feature is a quick and casy way for mass producing form letters, envelopes, mailing labels, phone
lists cte. By using Mail Merge, you can send the same leiter to a number of people, without typing
the original letter more than once, ' S :

The Macro is a sequence of actions that is named and stored.” When 'you run a magro, Word
‘performs all the assigned actions-in sequence. You can assign ¥ macro 10 i key, a combination of
keys, a loo! button, or a menu. The Macro feature basically helps in faster editing and formatting,

5.1 OBJECTIVES

After going through this unit; you will be able 1o
* creale a dala source for the document

" merge the addresses for printing on envelops and labels

52 MAIL MERGE .

Word's Mail Merge feature Jots you quickly create personalized corresﬁondcnce' and other
documents by combining information (merging) information from two different files. '

For instance, you could merge a list of names and addresses from one file (your data document)
with anolher file (your main document) to preduce a number of personalized form letters.

vl
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You could also create catalogs; forms with variable information l{[ds, of labels, You inscrt data
instructions (ficlds) in the main document wherever you want data {rom the data source to appear in
your merged documents. ' '

Mail Merge featuré can also be used to prepare other kinds of merged documeats such as catalogs,
parts lists, directory lists, forms or invoices, print addresses on envelopes and mailing labels.

- \\

5.2.1 IDat:! Sources & Main Documents p

'Data 8ources are organized collections of information - databases-stored as Word tables, *Word can

also usc data from other applications such as MS Excel or MS Access. After opening a data source
in another application, make surc that the merge ficlds in your document match thosc in the data
source. All data sources, no matter where they come from, contain records and ficlds, For
cxample, an employce data source would contain one record for cach employee. This record would
contain multiples fields - one for the employee’s first name, one for the rmddlc mlt:al onc for the
last name, one for each part of the address and so on.

The data source conlains the information that can vary in each version of a form letter, such as the
names and addresses. :

You can cither open an existing data source or create a new one in Word,

Main documents as menuoncd carlicr contain the text of your prOJEct (the body of a Iettcr), fields,

and mcrge instructions.
Mzun Documents can be used from carlier versions of Word or from other Applications.

While using the Main document from other applications, open that document in Word 6 and
convert its contents 1o Word for Windows. However, ficld names and formatting. from some
applications may not translale well inlo Word {or Windows format. Check the {ields in your main
document and adjust them it necessury before completing the merpe or you can paste the main
document into Word for-Windows as plain text, then apply the formatting a.nd‘ centering the field
names.

5.2.2. Starting & Editing the Main Document ’ '

Creating a merge main document. such as form lettcr, is a three=slep process.

. Step I To set up the main document, which contains the text, punctuation, and.other items

that remain thc same in cach version of the form letter.

Step 2 To det up a data source which contains the mtormatmn that varics in each version.
' This can be done cither by opening an cxisling data source or crealing a new onc.

Step 3: To complete the main document by inserting merge ficlds and by typing or adding
informalion you want to be the same in cach form letter, such as the body of the
letter, your address and your logs.

Slep 1. To start the main document;

5‘3 ‘ I h ‘ Mail Merge
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i} Sclect the creale button to start creating your main document.. A list will drop down offcnng
you Four choices-Forni Lelters, \dtnlmb Labels, Envclopcs and Catalogs.

i Select the Lype of main, document you wanl A dlalo;, box appcars offering you the chmcc of'

the dctive wmdow or 4 new Main documcnl

iii) Choose the Active Window butlon if the active “window contain information for your maif -~ -

dacument or choose ilie New Main Document buuon if the active wmdow doesn’t contain any
information for the mail mérge.

Whichever bullon you choose, Word will return to the Mait Merge Helper dialog box and the space
below the creale bulton now lists the information you've entered so far-the type of merge and the
main document 1 use. : : :

Step 2: Nexl, you l'll..Cd lo specify the data source. and arrange-in it the fields that wxlI be

available 1o your main document for the merge.

i) Click the Get Dnla butlon to dlbp|(ly a lisl of options for your dala sou:cc i

i) II‘you '1]rcady have a data source that you want o use, select Open Data Sou:ce ar. 1f you want
to create a new onc, select Crc.m. Data Sourcc . : Cee

Crean'ng u Daia Source

The Create.Data Source dialog box (hat appears when you choose Create Data Source contains.a list
of commonly used ficld names under “Field Names in Header Row” box. The next step is to add
ficld names in the dala source. This can be done by selecting the field names from the Field Name
in Header Row hox or by adding the new ones to it. These ficld names. can be upto 40 characters
long and contain letiers, numbers, and underscore ( _). They cannot contain spaces and must start
with a letter. The followmg operalions on the [ieid names can be done: :

1. - To delete a category rem the dala souree, seleet il and choosc Remove Field Namc buﬂon

2. To Add a category-te the data source, type the new hcld name in the Field Narnc box and thén
choose Add Field Name bution.

3. To change the order of ficld names. scleet a field name in the field names in Header Row box,
and then click the up or down arrow at the right of the hst until thc field name ls in the dcsm-d

position.

thn you {inish creating (e ficld names, choose the OK button ‘Word then displays the Savc Data -

source dnlog box. You save the new data source by z_.,wmg anew ﬁlcnamc to it.

T

Word thcn displays a message asking you whelher you want lo edit the dala‘ source or ¢dit the main,-

document. Choosc the Edil Dala Source bulton to type the information that varies in each version.

The Data form dialog box appears. Type the information you want in each data field box and-then-

press ENTER. Te move to the next or prccrious data ficld box, press TAB or SHIFT+TABZ

i

OK button in the last:

Continue lypnu, Miformation, choomnb the Add New button to start, each new record.  Choose the
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Opening a Data .é'o:rrce
i

To open an existing data source, Sclect Open Data Source from the Get Data drop-down list. The
Open Data Sourcc dialog box that appears works just like the File Open dialog box. Select the
document you want to use and click OK, Word ml! open the document and return you to the Mail
Merge Helper dnJoL, box.

Step 3: .On_c you've completed the sccond step-Creating a new data source or 'Opening an
existing data sourcc-you can complele the main document by inserfing merge fields
angl by typing or adding information you want to be the same in cach form letter.

This can be dene by:
a) Completing i form letter main document:

Type or add any text and graphics you want to include in cach lctter. Then insert a merge
field where you want cach category of addressee information to be printed. Place the
insertion point in the document.where you want to insert information from the data source,
click the 'Inscr} Merpe ficld bution on the Mail Merge toolbar and then choose the
appropriate merge ficld. Choose save from the file menu after editing the main document.

b) Merging the data source with tl_m' main document:

Before merging the main document with the data source, the following .thiﬁgs should have
been done: '

1.. All the addressee information in the data source should have been typed.
m

2. All the merge fields should have been insertcd at the .desired location into the main
document. :

. To merge a data source with the main document

l. Cligk, (he View Merged Data button on the Mail Merge toolbar while the main document is in
the active wipdow Word displays information from the first data record in place of the merge
fields in the main document text. Teo view information from other data records, click onc of the
arrow buttons on the Mail Merge toolbar, or type a record number in the Go To Record box.

523 Merge P}'inting Labels & Cnvelopes

Word's Mail Merge Heiper can also be used to merge labels and envelopes. The procedures for.

merging labels and envelopes are very similar to those for form letters.

Printing Addresses on Envelopes

Wil A offers the ability o print addresses on envelopes. This can be convenient for small number
of envelopes; but as most laser printers require you to feed envelopes in by hand, printing large
numbers of envelopes can be a slow business.

60 ' - Mail Merge
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To print envelopes by using the Mail Merge command
1. Select Toota— Mail Merge (o fire up the Mail Merge Helper.

2. Click the Cieale hlill(_;n o drop down a list of aptions and sclect Envelopes from this drop-down
list, : :

3. Arrange the d:u;t'.g,mu-cd__a;: usual, Then click the Mail Merge Helper button on the Mail Merpe
toolbar and under Main document, choose the Set up button. In the Envelope options dialog
box that appicars, make the appropriate choices for your cnvelopes. :

* On the Envelope options tab, click the font butlon in the Dcli{zcry Address box or the font
bulton in the Relurn Address box to change the fon! in which the addresses appear. You can
also adjust the position df thie delivery address or retumn address by entering from Top and
[rom Left messurements in their boxes. Sl

° Onthe Pfi.nting Options Tdb, select the fecd method and the tray to feed from. i

4. Choose OK to closc ihe dialog box.

5. Next, the Envelope Address dialog box appears. Position the insertion point in the Sample
Envelope Address box. Then choose the Insert Merge Field button and choose the appropriate
merge ficlds. Type any spaces and punctuation you want between the merge ficlds, and press-
ENTER at the end of each line. Choose the OK button to ¢lose the Envelope Address dislog
box. : B

6. In the Mail Merge Helper dialog box choose the Edit bution under main docurnent and then*-

* ‘choose Envelope document from the list. Word displays the envelope main document in Page
Layoutl view. If the user'Info Tab in the Option- dialog box (Tools menu) has an address
specified in the Mailing Address box, then that address is used as the return address,

7. Check whether your prinler is ready to print envelopes: Then click the Merge To Printer button
on the Mail Merge toolbar, ' : :

Printing Labels on Laser Printers

Thie Mail Merge Helper makes merging labels on a laser printer deal simple. You use the Mail
Merge Helper to create a mizin document containing a table with fixed-size cells and cell spacing

- that match the size and position of your blank iabéls, then insert merge-insiructions in cach table
cell. : . : ‘ ' T

R a

1. Seleet Tools — Mail Merge to fire‘up the Maii Meige Helner, .

2. Click the Creale bution to drbp_ down a list of options. .

3. Sclect Mailing Labels from the &roﬁ-dowﬁ tist,

4. Arange the data source as usual. Word will then invite you to set up yaour main decument. In

the Label Options dialog box that appears, make the appropriate choices for your printer and
labels:. - T - A : :

» In the Printcr Information Box, selecl Laser or Dol Matrix as approprialc.

Mail Merge . . ' : , 3!
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5.

6.

8.

When you've chosen the labels (o uise, choose OK to close the dialog box.

. The Create Labcls dialog box will appear. Position thé insertion point-in the Sample Label box.

Choose the Insert Merge ficld button and choose the appropriate merge ficlds. Type any spaces -
and punctuation you want between the merge fields and press ENTER at the end of each line. '

Open the Mail Merge Melper dialog box and choose the Mcrgc' button to anerge your data
source with the main document. Chioose whether (o merge to new document or o the printer.
(You can also usc the verge to New Documcnt and Merge to Printer buttons on the Mail Merge

- Toolbar here}.

Save your documents with meaningful names.

Check Your Progress

t.

While using the data from other applications in the data source file,

i) the records musl contain multiple fields
ii) the merge ficlds in the documents must match those in the data source
iii) you myst first ¢lick the Create Data Source button

iv} nonc of the above
The Date and Time command

i) Inseris the date-and time you can specify J.
i) Automhtically adds the current date and time
iii) Shows the date a file was created

iv) Shows the datc a file was last revised
The View Merged Data buiton

i) Allows you to view all the records in the data source file
i) Allows you to insert records into the main document
iii} Allows you to view how the-form letter will appear

iv) Allows you to select the records to be mcrged. '
The Macrds can be assigned (o a toolbar, a menu or.shortcut keys by using:,

i) the Options command in Tools menu
i} ‘the Macro command in the Tools menu

iii) the Customize command in the Tools menu -~ . . oo

5.3 SUMMARY

Mail Merpe has an advanced feature of printing envelopes and labels. Thts feature is.not present m
the Mail Merge feature of WordStar Macros. in Word can be assigned to menu, kcyboard shortcut

keys or taolbar. By this, the Opcrmon of the macro can be made. faster and easier.
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6.0 Introduction
6.1-  Objectives
6.2 Opening, Saving & Prolecling Documents
6.3 Finding documents

0.4 Printing & document

6.5 Sumumary )

6.0 INTRODUCTION . D

lhls unit explaing the detpils of managing Word documcnts which lncludes creatmg'. ‘opcmng,
saving, restoring and protecting documents. It also deals with'locating’ the doclJments either-by
sm:chmg il dlbi\ divectorics or folders for filenames or by using the summary mformallon. '

(&ummdry Info) that will Tater hclp you find the file. And if at a later. stag,e you wishito' changc this -
- information stored with the file, you can do lh:s by 51rnp!y choosmg Summary mfo dialog box,

‘make the changes and click OK. r T R Tl B PR

The end product of o Word Processing session is usually a prmted documenl Beforc. pnnlmg from.-
Word for the first time, you must check that your printer setup is correct. And Word’s Print
Preview feature used before printing any documents, helps in checking. that all'its elements’ ‘are. i’
place. - All these printing options have been c>.p|.un{.d in detail in lhls umt

LS

‘i A'—"Il'l s

6.1 OBJECTIVES :
Alter going thr ough this unit, you w:ll be able lo
v p.rolcusl your document

= - find yoﬁr-clocumcnt_

° printing specific pages ol your docafmunt‘ .

°  print more than onc copy of the dociment

1

o change the printer
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6.2 OPENING, SAVING & PROTECTING DOCUMENTS

The major file management operations inclide creating, opening, saving, restoring and protecting
documents, This detail about crealing, opening and saving the documents have been explained -
_eardier in unit 1. This section mainly deals with protecting documents. -

Profecting u doctmeny

Protecting a document implics suving it from being changed either accidentally by some other user.
A document can fe protected in bwo ways: :

1. Qpening a document us read only,

2. Prolecling a document with a password.

1. When a document is apened as read-only, the user cannot make any changes to the document,
- Thiscan be achieved by sclecting the Read-Only check box in the Open dialog box. This Read-
Only option will nol allow any changes in the document to be saved. o

2. The other way to protect a document is to use the Protection. Password, which is typed in the
Prolection Passward box, In this way, the users who know the password can only open the
document. These passwords can be changed and deleted. too. :

6.3 FINDING DOCUMENTS o -
Word documents can he located based on ils filename, creation date or last modification daﬁ:. The

s‘ummury information included with a document helps 16 search a docurnc_:nt based on its author, a
descriptive title, or keywords. .

The information used to search for documents are called search criteria,

The Find file command from the file menu or the Find File button in the Open dialog box can be
used to locate a document, The first time file option is chosen; the search dialog box appears in
which you can specify filename. file type and drive scarch criteria. Once a search is completed,
Word will display 4 list of files that meet the current'search criteria, .

Searching by Filename and Drive

;

The steps followed for localing a document when the seurch crileria is filename and drive are:

[, Click Find File from the file menu. "The search dialog box appears. Click the Search button.

2. Under Search far, type (he namc ol a specific document in the file name box and in-the location
box, you can seleci a drive or volume you want 1o search or type and edit the paths you want to
scarch. '

3. Also, you can search all subdircctories of the sclecled dircctory by sclecting include
subdirectorics check box. Word will display the list of files it finds in the listed files box.

04 _ ' .. Document Management
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4. When finished scarching for documents, Click the close buiton.

.

Searching with Advanced Scareh Criferiu

The Advaneed Segreh butlon in the scarch display box can be used to specily additional criteria
stch as a speetlic directory or lolder, ereation dnd modificalion dates. or summary information, By

elicking the Advanced Search buton iy the search dialog box, the Ad\{anccd scarch dialog box
appears: : : S

. . - .
*  Sclect the Localion tab for searching by location. Tvpe the name of the file in the file name box
for scarching by flename. I Windows, 10 search o diréelory thal'is not listed in'the Search In
box, select the direclory in lth Directories box, and then choose the Add' button, To. delele a
dircctory from the Search In box, select it and then choose the Remove batton. To remove all

* directorics from the Search In box, choose the Remove Al bution, - o T

¢ Select the Summary tab for locating 4 lile by stmmury information or content,

¢ Scleet the Timeitamp tab for searching for the date a file was created or last saved. Type the
range of dates during which the file was created or last saved. In the By box, type the hame of
the parson who created or saved the file, ' ' :

6,4 PRINTING A DOCUMENT

While printing a document. you can:

1. Print the entire document or only speeific PIIECS.

B

2. Print summary information, snaolyljons of list ol styles, AuloTes( enlries or key assignments,
3. Print a draft copy, which omits graphies (o allow faster printing.

4. Sel prinling options, such as number of copics..
Yaou can also automaltically creite and print an envelope, using an address from a’document or ong
thijt you type. You can cither print directly on an envelope or store the information so that you can
print the cnivelope later. - SR o
. - . 7
The printer you can use afTecl the.way Word prints and displays text on the sercen. - Before you
print a documeit, you must install and select the printer you intend to use to print the document, .

. ; _

Ward displays a document as 1t will look when vau print it, If you want to preview a document

before you print it, use page layoul view or print preview. In cach-of these views, you can make

last minute changes to text farmatting, page breaks and margins,

Line breaks and page breaks should be tie same on ihe screen and in the printed . document.
However, the fonts and view options you cheose can afieel the malch belween what, you see on the
sereen and what appears on the printed page,

Three kinds of fonts allect your work in Wowd: Scaleable fonts. Printer fonts and Screen fonts.

L I
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Use ScpleaBlc fonts, such as ue Type lonts to ensure that what you sce on’the sereen is what
appears on the printed page. .

For using printer fonts, you must have a {.orrespondmg screen font-and font size to display each
font on the screen. [T each sereen lonl you use has a matching printer lonl, the screen display of the
document will closely mateh the printed document. ot

The thrze basic steps lor printing a document are:

[. Conneciing the Printer: .

Conncet the prinler cither direclly lo your computer or to a network,

2. Seclecting the Prinier:

Chaose Print from the lile menru then choose the Printer button and bt.lccl the prmlcr you want
10 115¢,

“

3. Printing the Dacnment;

Click the Print bulton o the Siandard toolbar, In Wmdows. Word prints one copy of thc
active documen, using the word delaalt print 5cu|nbs.

ChcckYourPgogrcss. | ' c .-

1. To prevent other users lrom opcmn[, a dosument which of the [ol[owmg should be cl:ckcd in
the oplions command in Tools menu . . '

i) Proltlgtion Password box

it) Write Reservation Password box

iif) -Read-only Recommended box

iv) Either (i) or (i)

. - ! '

2. While Saving a document, a filename without the extension can have maximum of

i) 15_,charnclcrs'

i1y 11 characters ' -

iii) 8 characters -

iv) . 10 characters

e

3. . List the steps followed Tor finding a document based on the scarch criteria.

G6 ' '_ : Document Management



6.5 SUMMARY

After gaing thraugh (his unil, vou must have seen (hat document: management mvo[vcs opening,
saving, protecting documents and the information stored while saving {he documents can further be
asedl for locating the documents. The Advanced Scarch Criteria described in this unit can help you
in locating the {ile based on the modilication dates as well,

Daciment Management ’ ) ’ : ' PR 67'
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simple row and column arithmetic of accounting worksheet evolved the electronic version of this
as Spreadsheets. A Spreadshecet is an integraled package that comes with a worksheet program,
graph program and’a database management program. Since then Sprcacishcqls have become the
niost widely ased Compuler Software for years!

Fxcel is used o automale financial statements, business forccasting, transaction registers, inventory
contral. accounts receivable and accounts payable. 1t also provides multiple facilities Jike gnaking
graphs. analyzing situations and also helps people at the managerial level in taking decisions.

Ehmy enhanced leatures have been added in Excel. These features are Worksheets a Workbook,
tabbed dialoy box, cascading menus, drag and drop data, tip wizards, editing cell contents within
the eells, Tormatting ol individual characters within the cell, simplified and sorting and filtering of
data.. Microsoft has come out with @ package cailed MS-Office which has built-in software call
MS-Lxcel. This software has the power to do much more than LOTUS 1-2-3.
. . .
Parmatling techniques of Tixeel help us o present the data in the way we want. [t inclides sclling
of Column width and rovw height, choose fonts of character from Lhe large variety of the same,
N el dann B o the displiy formal of numbers ele. We can also choose The recZv-made
iarmals {rom o s oi Inrmals of workshee! using-AutoFormat option.
Page solug is necessany (o get the printoul of the spreadsheet. We will also learn about how to get
the selected dala printed.. Custom dialog boxcs provide greater conlral of events which also help in
application development. )

Charts are an effective way to present the data for analysis in the graphical form. This is achicved
by a varicly of charts available with.Excel. This version is provided with the features of
mamtaining databases that reside in worksheels, C
“Help” (Press I'1, wherever you get slruck, (o call for help) provided with the application package
Cxcel will hielp you for all these topics. You can also refer to the following material Lo have more
information of the package: : '

o The Complete Guide to Microsolt Office BPB Publication

v Mastering 1Excel 5.0 for WindowsBPB Publication

»  Manual provided with the software of Excel 5.0

The working knowledge of Windows is the presvequisite to fearn Excel.
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INTRODUCTION
AdSHHxeel is a Windows based application package that can be uscd to aulomate tasks such ac -

calculation and analysis of dat.

MS-Lixcel warks the wiy you want i.e. it can be customized. It provides case of work wilh the
(ol lowing: features:

Tip Wivard - Guides you io work more eflectively while you work by displaying various hely[ul
tips and techniques based on what you are doing.

E e ey e T

g and Dreop Feture - [0 Telp you (o repasition’ the data and text by simply dmbynb the data
wilh the help ol mouse,

Autofill - Bohelps you o 1ill rows ar columns with (he series of data.
Aulosum - You can add @ large range ol dala by simply selecling a tool bullon.
Windows Inferface - As Exeel is Windows based package therefore (he user interface is consistent.

Shorteat Menus - Commands appropriate lo the task thal you are doing appcar by clicking the
righlt mousce hulton

Buili-in Spcl! Checle - You can maintain a diclionary ol the words usually used in your work and
spell-cheek your '~‘-|‘}IC'1(.1!:,|]CCI -

1.1 OBJECTIVES

Alter poing throuph this unit, youwill be able to : ' .

e

« start EXCEL from the WINDOWS application
= lentily different parts of the worksheel

o cyeate, apen, delete, save i workbook

= entet data and edit a workboak

= npvigale within a workbook

+ specldy range of cells

*  suve your work

1.3 EXCIEL BASICS

Before you start working on lhe worisheat, the knowledpe of the concepts and movement on the

workhook b necessioy,

L2 T Start Fxeel

FoooSan Windew s, : -

. R N
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Ciick on the Program Manager icon.

3. Iathe Program Manager window, click on MS-Office icon.

-

I the MS-Ollice window, click on MS-12xcel icon as shown-below:

- Microsoft
scel

(2.2 Wm-&plﬁcc of Iixcel Sprc;ld'hcct

Active Ccli btanda:d Toolbar -Menu Bar
«Name 3ox Formula Bar ~ Column Headings

| o |
HE ‘

_;';;'s F 0 Tools [lata Wlndnw H Ip 31
Thrial i[&:]fm i,
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Status Bar | Scroll Bar
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Menu Bar - Different-optis 1s Jor selection,

Standard Toothar -1l is displayed by default and provides shorteuls for the common commands
used.

Formula Bar - Any text, data or formula that is being keyed-in or cdited is displayed inil. -
Nanme Box - Digplays the address of the earrent cell.

» .
Seroll Bais - Used 10 move up or down in the worksheel using mouse, -

Sheet Tab - Displays the name ol the current worksheet that can be changed by double clicking on
iLand giving a new name in the dialogue box.

Status Bar - Left part displays (he various messages like Ready mode (when Excel is ready Lo
accept data into the spreadsheet) or Edit mode (while in the editing mode). The right part hl;,hllghl:,
the status of keys of the keyboard.

Row Headings - They arc numbered as 1,2,3 ..., 6384,
Column Headings - These are addressed as A, B; C,...0V. ' -

Active Cell - Intersection of cach row and column 15 called a cell.

1.3 WORKSIIEETS WITHIN WORKBOOK_ g

MS-Lxeel docum(,nt is called as a; Workbook Each Workbook contains- 16-worksheets: by default
This number can be' changed if vequired by resetting the default options. Worksheets within
Workbooks. make il casy to bind -files of related information. When a Workbook is opcm.d all
workshects ofthdl workbook becomie wal]ablc to the user aulomdllcally '

1.4 GET'I.'ING STARTED W,ITH EXCEL

~ Firstly, open the workbook Lo slarl your work on a worluhn.cl At times, you might require (o inscrt
or delele a workshect, and cells 1o be HC[LLlLd

4.1 Createa \Vm'ldmnlc

Seleet the New., command {rom the File.menu. The Workbook is opened by the default name ol -

BOOKT.
142 Opena Workbeok

To opr.n an c\ulmg Workbook select Qpen option from the File menu. Narhes of the recently

uscd files are listed in the File menu and can be bclcclcd by merely clicking on' the name of the fi'e

Y

(o be epened.

8 ' : . ‘ Introducting (6 Eved?
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L4 Nad o Workbaonls

Chaese File -> Open conmand. Select Find File., option from the dinjouue box that s opened.
Conseruently, another dialogue box is opened i which the details Tlike file name. (Iircclofy are 1o
he given. '

P Inxert a Warksheet

Toinsert o Worksheel between nwo worksheets choose Worlislicet option Irom the Insert menu,

oS Yelete a Warksheet

e reove aworksheer from the workbook, selecl Delete Sheet from the Fdit menn, A dialogue
besswiHl appear (o conlinm this aclion,

.46 Maove the Worksheet

o meve the worksheel in the same workbook, place the mo: mier on the sheet tab, press the
ieitmouse button and drag it 10 the desired posilion. Release the  .rom.

LT Seleeting Cells - .

i enn seleet asingle cell'or a group of cells using mousc or keyboard.

Uzing Mouse: Click on the cell with the left mouse button, That ccli gets selected and becomes the
petive ceil, Whatever you type goes into this cell, To scleet a range of cells, click on one cell, hold
deswn the left mouse butlon and drag the mouse pointer 1o the last cell of the range you want io
seicet.

Lxing Weyhonrd |

To Sclect ) Press

Current Celd | Enter

Entire Column Ctrl + Spacchar

Entire Row o Shift + Spacebar
fintire Worksheet Ctrl + Shift + Spaccb:tr

Iixtend Sgleélion o End of  End, Shifl + Arrow key

Dala Block *

1.5 ENTER AND EDIT DATA

The various kinds of entries that can be made in a cell are :

Text: First sclect the cell in which the data has to be entered and type-in the text,

cedadnoeduasing_to fiemal - ‘(-
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Press ENTER key to finish your entry. The data will be displayed in the active cell as well as in the
formula bar. Toe enter digits as text {¢alculations cannot be done using these kind of entrics ) usc an
apostrophe () as lhc first character.

Number: Numbers include digits from 0 to 9 and some special characters like
S%+-1(),

Date” and. Time: Date and Time entries arc inlerpreted in a special way in Excel. They ar
represented as numbers for Excel given to cach day from 01:01:1900 (serial number [}
31:12:2078 (serial number 65380). Although when you type a date in the cell llke 01/01797, it wil
be displayed as il is.

Exnmplc': T}pc TODAY() in a blank ccll and press ENTER key:

(This.function will displdy the system date and time)

Data in Series: You can fill a range ol cells either with the same value or with the serics of valuer
This can be done using Autofilt handle (small square on the bottom-right corner of the aclive ce!?)

Fill Handle .

Drag this handle till the last cell to create a range of cells which are to be filled-in with the values.

Fxample:
I. Enter MONDAY in cell E20.

2. Drag the Auloi'll handle 1il] the cell K20. .

(The who]c (angc will be filled with days from MONDAY to SUNDAY )

To create a .nzr:-;s of numbers :

]

Example ; Select the cell H20 and enter | in it.

Scleet the range from H20 to HI [

el
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Though Tixcel provides the lacility -of built-in lists (e.g.’ MONDAY to SUNDAY) to pcuonn

Autofill, the users.can also create their own custom Ilsts which are used [requently in your
worksheels. :

1.5.I To Create a Custom List

I. Enter the given list starting from cell L5 (o L8
LEFT
RIGHT
up

DOWN.

A% ]

Sclect this range of cells,
Select Optious.. from Tools menu,
Select Customs tab from the Custom dialogue box.

Click on OK.

[V S

or
t. Select Tools -> Options.
2. Click on Cistom List tab °
3. Type the custom list in the List Entries Box.
4, Click on OK. |

Data, if written incorrectly, can be edited by followmg Ways

1. Sclcct lhc cell with somc valuc to be edlted

Introduction to Exce! - , . ' - {1
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2. Press I'2 and using Backspace key crase the previous entry. You can'retype the correct data,
' or .
Simply seleet the eell and retype the entry.”

To bring back the previous entry cither click on Undoe button on Standard Toolbar or choos
dit ~> Unda option, ' .

or
Pressing Alt - Buekspace or ctrl-Z keys can also be used to perform the undo task,
or ' '

To clear the cell entry, select the cell 1o be cleared and press Delete key.
152 Cell References

There are 16584 rows and 2356 colurins in one worksheet. The first ccll is labeled as Al (eolumn as
A and row number as Dor R1CI,

Example 1 R3CT refers to row 3 column 3 and is equivalent to C3. Thus he last cell.is labeled as
IVIGIRY, This is called the cell address and they reused to identify the cell.

Cell references are given in different ways
Relative: This refers to the cell relative to the given position.
Example:  Lnwer e I'nllowilng_ values
Incelt A3 enter the vaiuc 34
Inccll Ad enter the value 23
Incell AS enter the value 89
Incell A6 enter the formula = A3 + Ad + AS
Copy this formula to the cell A7, and sec the résult. "

Obscrve the formula entered in cell A7. It is A4 + A5 + A6. The formula entertd in cell A6 mean:
the sum of the values given in the three cell given above the current cell. Therefore when we move
down, the relation specificd in the formula was copied (i.e. the three values given above the current
cell which is A7 now). ' '

Absalute: This refers Lo the specific cell irrespective of the position of the formula. The '§' sign is
used to denole an absolule relerence.

Example : o the cell B3 copy the formula SAS3 + SASS + $ASS
Copy this Tormula to the cell B4, h

We find that the result and the formula remains the same.

Introduction to Exce!
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ViR,

Mixed: It is a combination of botli relative and mixed references. It has one absolule co-ordinate
and ane relative co-ordinate. 3D and D$1 are bot- . -xamples of mixed references.

[.6 RANGE NAMES

A name can ve given to a single cell or a range of cells (c.g: B3:F9). The range name can be used in
place of these eell references. Also the range specified for a range name can be modified.

To dcfine a name, lollowing points hiave o be considered :-

b Name cantain only letters from A-Z, or a-z, numbers 149, the periad () and the underscore

1

Maximum length can be'upto 255 characters.

Ly

Name cannot be same as cell reference fike SF$10 or FIQ.

4. Spaces are not allowed.

Valid Range Names Invalid Range Narces .'
wicnlhs . " First Name

Final_ year . 5 Days- .

Daie_of join .~ - . RSCI2

Basic_salary ‘ ‘

Years

Woavs to creale npame :

Using Name Bax?
I. Sclect the range of cells.
2. Click on Name Box on Formula Bar and type-the name.

M v

You'll will be warned if the same name is given.which has already been defined.
Using Define Naine Dialogue Box: .

i. Sclect the range ol celis.

-

Chaose Ingert -» Name -=> Dcﬁnc.

-

Intracliction to Exnel
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specily the Range Name in this text box

'ﬂ‘f".

Namc-; !n:kaboak

l |

s

Range of cells.

Using Create Nume Dialogue Box

L

', Enter the piven dala,
o ATy ";"?‘”2‘-'-"*:'?’-'-’4“‘5‘. i
R DR fa*’% VR
2. -8Select the range B2:C3.
3. Choose Insert -> Name -> Creates This will display-the Create Nameés-dialogue box.

Press 4.

4 - : . introduction to Excel
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1.7 NAVIGATE WORKSHEET

With Mouse

You can move Lhe mouse pointer to move to any ccll of any worksheet of the workbook. This is

done Lhrough :-

1. Click on up-arrow or down-arrow button on the scroll bar.

2. Click on the sheet 1abs.

3. Click onany cell.

4. To move Iquickly to any cell Choose Edit -> Goto:

With Keyhoard

TO MOVE KEYS PRESSED
Ri ght, Left, Up, Down Arrow Keys _
One cell ' (TAB to move to right onc cell)
Up or Down one screen PgUp or-PgDown
G MOVE KEYS PRESSED
Beginning of row HOME
To cell Al -Cir} + HOME
To lower right corner Ctrl + End
To last cell in current row END, ENTER

To lower right corner of
window

To upper lefl corner of
window

’ END (with scrofl lock on)

HOME (with scrolf lock oh)

(.83 SEARCH AND REPLACE DATA

To lodk for the data which is entered by lhc_l_.lscr, .ch_oos;c Edit -> Find.

Introduction to Excel
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Diats o Iind

Find What: I

o F:nd Ent:re Cells Unly it
Look ln:{Fo_rmulas é_, anT s

|

3 | .
i __S_carch:]By Rows ¥ r Halch Case
|

|

To replace the data. elick on Replace... button

or

Choose Lidit -> Replace.

1.9 REARRANGE CELL CONTENTS

Rearranging ccll contents includes moving or copying or clearing cell contents. This also involves
inserting or delcting rows or columns. This can be donce cither by cul and paste method or drag and
drop methad.

1.9.1 Move or Copy Cell Contents-

Drag and Drop Method

1. Select the vange of cells which are to be moved.

rJ

“Point to the border of range. The mouse pointer will change its shape 1o an arrow.

Ta mave press the lelt mouse button, drag it to the new location and release the mousc button.
_ N X

—

To copy. press i £t ey while drapging the contents.
Short-cuf mens

[. Press the richt moeuse bulton while dragging and dropping cell contents.

2. TFrom the short-cut menu, choose Move lo move the contents, or choose Copy ta copy the
contents,

IS - _ . ' ' Introduction i Exeei




Cot pad Euste Afothodd

t. Seleet the ceil ranpe.

2. Seleet Edit => Cut { to move e range of cells )

or
suieci it -> Copy ( 1o cepy ihe range of eells )

230 Seleet the vpper left corner of the new location where you want 1o place the cell contents.

-

(Choase Iaste oplion from Edit menu,

1.2.2 Inscrting or Deleting Rows and Columns *

Many Himes you may require 1o add a row of data or a column of data which you forgol to ealer .
cariier. Excel provides you the facility to insert rows or columns into the existing worksheet very.

casily. . -

One thing which has (o be taken care ol is that inserting n row of data will shift the rest of the rows
down and cause the last row of the warksheet to be removed. Same is the case while we insert o

wolumn in tie-workshecet, the rest of the columns shift right, This happens because the total. number
ol rows and columns remain the same. If there is any data in the last row or-column -of.the. -

[

worksheel ihatiwill be Inst, : : . L L

To insert cells, a row or column

1. Seclectthe cell(s) where you want to insert the cell(s), row or column.

2. From the Insert meny, |
Choose Entire Column (o insert the column
Choose Entire Row lo insert the row

Choosc Shift Cells Right or Snifr Cells Down (o insert the cell(s)

1.10. SAVE AND PROTECT "WORKBOGK

After you finish up your work with the workbook you will require.it to be saved so- that it can be
opened laler to resume the work in it

To give the nanie and save the workbook

Cheose File -> Save As conmand

To simply save the workbook

Choose File -> Save command

introduction to Excel . ' "I
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Click on the Save e Teal hulton

ii
2

To prolecl the Workbook ~ Your data can he very confidential which has lo be saved frem

unauthorized peaple.

Click on Qptions,., bulfon rom e File -> .‘S.:jvﬁ\é\}q dinlopue box.
R . lt ad

i . ::biréﬁh’-"'
4B agn 7 s AT JSWW

You can restrict the aceess of that workbook from ather users in 3 different ways:
Protection Passward

I, Type the password which will be required to open the workbook. The password can be upto 15
{,halacwn long. can include alphabets (uppcr case O lower case), numbers and special
charuciers, | is case sensitive also. '

T Vou will be asked to re-enter the same password,

a0 Click on OK.

Write Reservation Password

'

save that workboek, This prevents the unauthorized users to make "any modlfcauons in -the
w.*immnk Thcdes o give the password are same as Prolection Password.

This |1a-'<:v-'drd will be required when vou make changes in the existing workbook and then try Lo

e K _ ' - Intraduction 1o Excel




Read-nnly Recommendded

[T this option is checked, lhu followu.;, d.:llo[,uc box will be dlsplnycd cvcry lime you try {o op

the workhook,

3
e S B
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Tivis option is checked if you want (o discourage the other users from.making any changes by
mistake or you want to prevent the chianges to he made by more (han one users s:mullancou-:!y (this
is possible whcn niore lhan ong users are working on the samcworkbook)

1.11 EXITEXCEL

When your work is'linished and it has been saved properly, Lo close the file and exit MS-Excel,

1. Chonse File - Close command,

&, Chooge File == xif,

v

[f-you have nol saved your work lu.fmc closing lIlL. {ite, the dialogue box to save the worksheel is

displaved.

Cheelk Your Progress

| What arc he different leatures of Excel that provide the case ol work,

Mo rentnte betveeen o Workbhook and a Worksheel,

Intraduction to Fxcel
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3. Whatare the different types of data that can be cntered in Worksheet cells ?

4, What is Fill-handle and how is it uscful ? : R "",_:-

B e

5. Explain the three ways of réf'crcncing the eclls.

=

-

i

7. How the aceess of the Workbook can be restricted from other users 7.

1.12 SUMMARY
In this scssion, you learned

. Whatis an Excel workbook and worksheet, and how to work in it. o , :

2. Data is entered in the cells and can be edited, if required,

b

Names can be given (o a single cell or a range of cells.
. Yoil can move in the worksheet cither with keyboard, mouse or meny,

3. Data which has deen entered can be searched and replaced.

The contents of the cell con be copicd and moved anywhere in the workbook. -

7. The worl:shest which has been.created can be saved and you can also protect it from
unautharized users by aiving passwords. .

3. Commands to leave the Pxcel workplace and come out to Windows shell.

20
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2.0 INTRODUCTION

The formatting fealures of MS-Exeel enhance the appearance of the data which is presented in the
worksheels, Many formatting features are same as other MS-Office packages ( WORD, POWER-.

POINT ete.) like formatting of characters in cells. -

2.1 OBJECTIVES .

Afler going thrOL‘tgh this u.‘nit,.ybu will be able to
* sclupa page of t'llu; worksheet . |

« adjust the coluﬁlh width and row lteight

» choose fonts angd sat alién.mcnt of text

¢ format various Kinds of number data

o print your work




21 G_E-SET~U—P

l - -Ih

As’ Y‘”th clhcr Wmdowq Programs, ] seel also p:owclm you w:lh ihe fcaturc of WYSIWYG (wh ;_g‘a-

you'see is what you get). Therefore §
as a printer-copy alsa. For (his :

1. Open the File menu by elicking o

2. Click on the l’.m,c Set-up.

1 15 .dwwys bt.llcr lo slarl wnh the page I ayout which yéu want’™"

n fhe File.

The following dialogue box-is displayed,
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l'lu, Page 0|)l|(‘j'| allows ‘ou (o sel
Excel m:.t,rlt. automtic page-breaks

The i\'hrgin‘.' lnl: when clicked. dis
right margins ol the page.

the paper size) ()n(.m.mon of the data, scahng of the arca cle.
also,

plays the dmlnj,uc box. You can sct the top, bouom left and

These are the distancesYin inches [rom the edge of the page. This also’

allows you lo sce the pjcwcw 0[ the data when it \wll bc pnnlcd
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Header/Footer tab gives yau the option to set the héader {which will be displayed on top of'cvery--
page) and the fooler (which wall be displayed at the boltom of ¢very page). The header may includé
the name of the erpanization or date or any other thing you wish Lo write, The footer may include..
the page number or a line or something you wish to write! To add more dita as header or footer,
click on Custom Header.. or Custom Footer.. .
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The Sheet tab has the option to sclect the area to be printed (i.c. he range of cclls), set the row or i

column Litles (these will be printed on every page), or select the page order fromi the multiple -
workshect ele.
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3
2.3 COLUMN WIDTH AND ROW HEIGHT
The width of the column(s) and the height of the row(s) can biz«easil y changed by different ways : . t
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.',2.3'.'1-_,._':.Uiilglg_-Mp!xu Commands | o oo T
To Su‘ .rfu.' Calumn Width ;

. Select any cell(s) in the column(s) 1o change its width,

2, Choose Column aption [rom the Format menu,

. 3. From the cascading menu. choose Width.. option.

4. The defuult widih is $.43 which can he changed by typing-in the new width,

Widhe gt
L '-H&";-wi‘r‘r"'l‘ﬂ"‘ﬁ'.'-‘f;f:
T B Eorae
. l. |

INEORRG i’

dIETH
2”'1".. LA [ 'I?l*

The other option available for formatling columns are ;

AUTOFIT SELECTION - || adjusts the width of 1he column accordi;lg to the widest entry in that. -
column, - : : ,
HIDE - Hides the sclecied column, though the data is still there, Hiding the column does not clear
the ealrics of it “
UNRIDE - Select this option il you want to unhide lhc‘hiddcn columns, e.g. if you want to unhide |
' the column D select the columns from C 1o  and choost (his option. .

éi'I‘ANDARD WIDTH - You can give e défaull column standard width,
To Set the Row Height:

t. Select the celi(s) of the row(s).

T3

Choose Format -> Row -> Height, -

b

Give tie height of the row as shown below,

e Bt e




2.3.2  Using Mouse
To set the Colunn Teight ;

[, Tuke the mouse pointer (o the Jine between the (wo lctlers. Now -look- at the ecursor, i has
changed its shape. Move il little left or right, You will again notige the change in the look of the
cursor anid it has 1aken the snime shape.

{the shape of the pointer becomes crosshair),

L

Press the lelt mouse button and drag it to change the width of the column., .

ar

Double click the lidic hetween (wo column headings and the width will be adjustcd according to the
widest entry of the column.

Toxel the Row Hct'ghr ;

*

I. Take the mousc -poinler to the lane between the two row numbcrs (the.shape of the pointer
becomes crosshair).

2. Press the ieft mouse button and drag it up or down to change the height of the row.

2.4 FONTS

Fonts are the typetaces (c.g. TIMES NEW ROMAN, ARIAL cte,) which have Size (in points}
colour speeial cl'j'ccts (like strike lhrough superscript, and subscript)

Fonts can be in bold, ilalics, or regular. They could aiso be underlmcd Fonts can be changed ecither
through Formatting Toolbar,

i, Scleet the celis or characters to be formatted.
2. Click on the appropriale options on the Toolbar.

Font lFont Size Bold Underline Center-align ‘Border

1 \_ A\ 1/ ]
Mk R

y"r.---r-‘..‘..m-.mrw g 3, LY L) S e T T TR

ltalics  Left-align Right-align

Or, through the menu command :
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U Seleer the cells ar characters Lo b Tormaited,
2. Clhioose Format == Culls,

3, Scleet the Font b,

Following dizlosue box is displayed. - . :

- ) :‘
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!;'\:ial ] '|Flngu|ar :

; |l:||1c

I P[‘Arml' Hnlmw Silold :

o Jip Artal Rounded HT W Bold llallc |

\indethine: - G Colot i o S0k )
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2.5 ALIGNMENTS ;

- P

To position the clx n.u.lc:n h.n .1l|bm.d or ||3,h[ .sln_md chck on Ihc Allg,nmcnt tab of the Format
Cells diafogue box. The diatogue box is displayed. The various horizantal alignrient opljons are ;

s General - the (ext is len aligned and the numbers are right aligned. This is the default status.
s Lelt - aligns the contents to the lelt ol the celi.

s Center - aligns the eell contents 1a the center of the cell.

s Ilight - atigns ihe conionts Lo the right ol the celt,

s Fill - [ills the seiveted cells with the single character.
+ Justify - (his apiion is selected with multiple lines of text as it wraps the contents from left to
right. .

s Centor Across Selectiorr- centers the lext across multiple columps.
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" Vertical Alignment options are :
» Top -aligns the text at the top of the cell,

» Center - places the text in the center of the cell,
* DBottom -aligns the text on the bottom of the cell.
-+ Justify - wraps the text from top to bottom.

Orientation of the text can also be changed.

2.6 NUMBERS

Nuniber formats include the options to format various kind of number data, like

¢ Number
+ Dale
"s Time

» Percentage
» Scientific
¢ Fraction

1. Sclcct the Number tab from the Format Cclls dialogue bowﬁ

2. On choosing and category given on the lcfr. side different format codes are listed on the nght

side and the samplc is displayed at the bottom.
You can create your own numbcr, date and time formats inthe fo[]owmg way :

"1, Select the cells to format

Formatting.and Printing Worksheet e
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Y Openshe Farne Cellg dinlogie boy and click on the Number tab.
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Code B3ox : i
3. Inthe Code box vedii he hoi*=in format or type the new {ormat. i

4, Click on OK hullen.

f

277 GETTING WORKSHEET PRINTED

Info-vration can be cusily carled and lonked into on the screens but it is difficult to share it with
peagt) e nless you have the hard copy of the same. !

ey m———— e - - -e

e P LR O

To print vour worksheel: .
i. Scleel the range of the —orksheet to be'printed.
2. Yon can see the previev ol the hard copy you will get,

3. Cheek if the printer is o fine and Choose File -> P'rint command.

Select the appropriate aptiens in the dialogue box which is displayed.

5. Click on OK.
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Check Your Progress
T, Explain the following terms ¢

Aulelormat

Aulofit

Fonlk

Page Seiup

Z. What is Alignment ? What are its diiferent options that are avaitable ? | '.:

3. What is Format Painter and when is it useful 9

2.8 SUMMARY

In this scssionl, you {earncd the formatting techniques.

1. Page Set-up is necessary before starting your work, as all the formatting of 1he text can be done
according to that. If you give attributes for the page after formaning, you will have to make
changes again. '

¥

2. The width ol the columns and the height of the rows can be adjusted to fit in the data in the
cells. ) ‘
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- 3. Fonls can be selecled from’ the Formauting Toolbar as well as from the dialogue box. Special

formats can be sclected from the dialogue box only like superscript, subscript and strike
through. .

-I.‘-.

Alignment of'the data ¢an be changed.

5.. You can chouse the lormat of numbers 10 display and print from the list,

6. The oplions of Autoformat and Format Painter are also available to make (o make repetitive
lasks casier,

7. You can prinl the complele worksheet or o ranpe of cells from it.

Mt e e
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3.0 Intraduciion

-

Objectives:

d
-

Exeel Windows

.
"
i

321 Arranging Windows
3.2.2 0 Moving benween Windows
323 Hidinp/Unhiding Windows

|

L)

4 Splitting and Freezing Window Panes

"ad
ad

Worksheet at different Magnilications
4 sing Custom Controls

340 Forms Toolbar

3.4.2 Crente Controls on the kashucl

idd Forma C onlrols

-

344 Worksheet Controls

wd
i
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3.0 INTRODUCTION

Worliplace is '.lu, area of the workshect which is Vlhlb]b and where we worl-. The display ol tha
‘workplace can be Lllb[Ol‘.\l/Ld like we can arrange the different windows which are opened, md the
column ar rows can be [reezéd so (hat they do not seroll-off the screen when we move in (he
worksheel. |

Another imparfant feature which is provided with Microsoft Excel is that controls (edit box. check
bax, xpinners, radio bulten, list) can be ereated an the worksheet as well as in the dialog box. which
also cam be ereated and placed on the warksheet.

31 OBJECTIVES

Alter going through this unit, you will be able to

« open more than ane window and-arrange (he windows

o splitand freeze the windows T

L) - b
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»  Uusc custon L.omlols like bnllons clu,ck hox opllon box list box

I
P

PR

» arrange, ]'X(,EL windews horizonlal and‘verhc‘ai I BN

o moviapg and hiding windows
=

3.2 EXCEL WINDOWS

Onc ':{’;rkl:ook can e displaved in more than one window. This can be done by selecting Window
-> New Windmy command. Then thgre will be (wo windows of the same workbook
(<bookname>:t and <booknamc>:2). Similarly you can crcatc more than one window to arrange
the workspace to quickly nceess the information needed.

3.2.1  Arranging Windows

I'hczc are different ways 10 arrange the wmdows Crca!c 3 or r 4 wmdows of your workbook and
follow the given method:

Chonsc Mindow > Avrange comnmand

L}

The lollowing dialog box is displayed,
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The various options available are @

Tiled: Euch window is completely vmblt. in lhc loml work:-.p.;tcc whlch is divided cvenly to all the
windows. . : -

Horizontal: The windows are arranged horizontally and are fully visible.
Vertical: Again all the windows are completely visible but are arranged vertically.
Cascade: The windows are averlapped on cach other and only the title are visible of each window.
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3.2.2 Moviﬁg bebwveen Windows

Different ways are :

1. The list of all the windows arc gwcn in the. Windows menu. Choosc the window you want to
open.

3. Click on the title of the window you want to make the active'window,

3. Press Ctrl+I6 o go to the next window or Ctri+Shift+F6 to go to the previous windo_w.
3.2.3  Hiding/Unhiding Windows-

Yau ¢an temporarily hide the some of the windows to clear the workplace.

Choosc Window -> Hide to hide the active window. .

-

Choose Window > Unhide to unhide the hidder;-ﬁpdow.

324 Splitting and Frccziug Window Panes

While worlcing on a very large worksheet with row. and colum:n hcadmgs, when you move nght the
row headings scroll off to the left. When you move down to see the data the column headings scroll
up. To fix these . headings, you can split the, active. window into two, with row or column
headings in one window and the data on the othcr window., Follow thc gwen stcps

I. Seleet the entire row or column where you want to split thc wmdows

or

Seleet a single cell to split the wind_ow immcdiau:lly above and to the left of the cell.
2, Chaose Window «> Split comymand.
The dilTerent régi01as.u1'c scparately scrollable..
To freeze the heading row or column window(s),
chaose Window -> Ereeze Panes.

This command will allow you lo scrotl only the current section of the window. The rest of the
scelion(s) will be freezed or locked,

" To unfreeze the pancs, choose Window ->-'Unl'recze Panes. -

To-remove the splits, choose Window -> Remove Split command. -

3.3 WORKSHEET AT DIFFERENT MAGNIFICATIONS

You can Zeom-in or Zoont-out to view less number of cell or more cells in the workplace.

. Seleel View -> Zoom conunand,

Customizing Workplace ’ : S ' 33




2. In thedialog box, default zoom percentage is given. Click on new option or type-in new value
\ for magnification by clicking on Custon,
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3. Click OK and fook at the resulls.
or '

C.l:cL on the right arrow of (he Zoonr box on the Standard Toolbar.

2.C hoosc thc opnon ‘from the list. :

3.4 USING CUSTOM CONTROLS

Users input data in the worksheels and number of calculalions are donc on this data. Therefore the
dara plays a very significant role as important inlormation arc extracied through calculations done
on this data, Care s required (o enter the correct and validated data. This can be done by i increasing

user interface by placing controals on tlu. worksheet such as list boxes, chieck boxes and dialog
ho> s,

3.4.1‘ Forms 'l'rmlh:u'

'Iw umnoh are the special objeets which enhance user interface and facilitate user input. Example
instend of yping-in e respense, you e seleel the appropriate option from the drop-down list.
The ool bustons tha e usy d-to draw contral objects are found on the

Forms Toolbar. To display this no”m -
Choose View «> Taatbars,
Cheek the boZ ayamst Forms Toolbar.

(picture ol all the 10o) butions andsthe description
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Lo S TOOL BUTTONS.

fit]
0g+

label (text)

edit bva

, gn".)up box

button ‘

check box

option-button-

list-box

drop-down list box

list box linked to edit control’

Customizing Workplace
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. ;‘ comblnatlon_ ofedltcontrol”&" T
 — drop—down ; K

-

Fie
o)

scrollbar control

spinner contro]

The cdit conirol, list box linked to edit control, and combination of edit contro! & drop-down tool
buttons cannot be 'inked to worksheét cell. These controls can be used inside dialog box only. Onc
control can be linked to only one cell but one cell can have many controls linked (o it. '

3.4.2 Create Controls on the Worksheet

The sleps to place the contrai on the worksheet are

[ Display the Forms Toolbar on {he workshcet.

2. Click on the cqntrol object tool which you want to place on the worksheet,

3. Asthe shape of the mouse pomter chanpes (crosshair), draw the object on the worksheet as you

draw other 0b|c,cts
4. Choosc Format -> Object command,
5. Click on the Control tab from the dialog box which is displayed.

6. Enler the cell reference or cell name in the Cell Link box..
L3 Format Confrols

Formalting of conirol includes setting-up their propertics.
The sleps to lormat the control object are :
Scleet the objecl by clicking on the abject while you hold down the Ctrl key.

2. Choose Farmat «> Ohject command

or

Click on the object with the right mouse button which opens the short-cut menu. Click.on
Format Objeet optien,

ot p e LA L & U
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3. Set the appropriate options in the dialog box which-'i'_s displayed.

You can also move or resize ihe conlrol objects as you move or resize

34 Warksheel Controls

Some ol the controls on the worksheet are passive, (hat is, they cannot be clicked or interacted with.

Example : label and group box. Other conlrols

Checek Box: This box can be used to select or deselect an option and the cell linked to it displays

the resull as TRULE 7 FALSEE,

other graphic objects.

can be easily created to provide user interface, like

TRUE

---ﬁ.tchiev;ad_‘r_ar.gét._
. o

]
-
LT

Serollbar: This vhjeet controls the integer value in the cell(s). The range of the values which can
be given is (- 30600, The value ol the cell will increment / decrement oy 1 if you click on the
arrows of the serollbar, "Mhe value will increment/decrement if you click on the bar. The placement

ot the ohject is cither vertically or horizontally.

Experience is :

Onption Button: This bution'is used 1o select any onc of the oplions given against these buttons and

the value will be displiyed in the cell linked 1o

this control,

o L _____‘ ' (. First Qujarter
. E ! . . P .
Sales forthe quarter: [ T~ 1§ coond e
! ; '
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List Box: The control allows the user to choose anitém froi thé list of items given in the list box. ~

_ r |
. , NORTH % _
AR SOUTH | |——
Sale for theregion | 31 ;
' ' I |WEST-

Drop-dewn Ljst Box: This control is similar to List Box, except that you have to specify the
nuinber of lines it will use when ,thc list is dropped down. This is specified while sectting the
propcmcs of this control. :

T I -
— ‘ -
MONDAY &3
SUNDAY- |i&%
DNDA :
— == TUE SDAY -% —
----- —| WEDNESD{#¢—0-——
e _| THURSDANE
FRIDAY 79
I

_Spiuner - It is sm'ular to scrollbar cxccpt that Lhc increment / dccrcmcnt is by [ only. Spmner can
be placed ‘only verllcully . oo

Check Your Progress

I. What is the pse of creating more than onc window at a time 2

2. There are different ways for arranging the windows on;screen. What are thesc 7

3. What are lhci_ different workplace displays. Give the importance of cach.

o

38 B S . Customizing Workplace
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4, Explain the ternv Custom Conlrols. Name them, .

5. How Controls are created on the Worksheet ? Give the steps in sequence,

3.5 SUMMARY

In the session, you have lcarncd to cuslomize or arrange your workspace on the worksheet in many
dilferent WY

= You.can open more than ong window of the same workshcet and anangc the windows to have
(he view ol all the data you require.

e 1f you want that the row or column headings should not scroll-off the screen when you move to
the farther cells, you have the oplion to frecze those headings. ’ .

&ontrols, Like bullons checL box, option box, list box etc., can be placed on the worksheet to
make your lasks casier,

<+ Dialog Box gives the option for application development where all the ¢ontrols can be used.
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44 Summary

4.0 INTRODUCTION

Analysing data and manipulating text are important features in any spreadsheet. Excel also provides
these facilities using functions for different categorics of tasks, like manipulation of text, date and
litne, calculation of numbers, date.and time. '

Users might require o calculale percenluge, average, interest. They want to look for a fook for
specifie item in lhe large volume of dafa, All these tasks can be. easily done cither by typing in the
fuactions based fonmulas or by using function wizards. The concept of cell referénces will be
exlensively used, ' )

4.1 OBJECTIVES

Alter going through this unii, you will be able to

= chler formuias in your worksheet

« understand the concepls of operators and their order of precedonce

v use formulas with functions to form complex equation.-
!
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« understand diflerent catogories of funclions, ’
v use text . dale . tme cte conversions

o use lunction Wizard Lo enter functions

4.2 FORMULA BASICS

Iomml.n are widely uscd in simple (like addition, subtraction, mulnphcauon and division) and
advanced compuling. They provide the power (o analyse data extensively. -

Spreadsheels alse provide an imporlant fealure of auto-recalculation every tinte a change is made in
lhe celts. Any change made in one cell causes a npple effect in all the dependent cells. There are
basicplly two Kinds of reealeulalions :

1. Automatie: This is the default mode in which the change in the value of the cel causes the
recalculation of the whole worksheel automatically.

2. Manual: On sclecting this option, the recalculation of the complete worksheet is done’ only on
pressing 9 key. This oplion cun be selected by choosing Tools->Option aud then click on
Caleulation tab.

42,1 Busic Propertics of Formulas

1. A Tormula may consist of operalors, cell relerences, range names, values and functions.

[«

A formula always start with an equal to (=) sign,

3. When a formula is entered in the cell, after the Enter key Is pressed, only thc calculatcd result is
usplayed 1 the cell and not the formula.

fan

[Fwe make a ccl! containing formula, as an actlve cell, though it still shows Lhe value but in
the formula bar, the formula i1s displayed. -

2.2 Okder of Precedence of Operators

Opcrutq'r, " Description - Example
Range . . B2:B5
Space Intersection of Celis
- Nepation (single operand) =-10
% Pereentage . =25%
Al Exponential =1072

Calentations in Worksheet ) o 4!
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Operator Description ’ Exl'amplc'

. Multiplication (whichever) =5*3
Division  (comes {irst) . =24/3

o Addition  (whichever) =55+80
- Subtraction {comcs first) =40-25
& Joining Text =""work" &' book™
= Equal to | =ALSS
< Less than =B3< 1000
> Greater than =B3>1000
<= L.ess than or Equal 1o =B3<=1000
»= Greater than or. Equal to =A5>=250 .
< Not equal [o =A5<100

4,2.31 How to enfev o Formula?

Tolearn (o enter the farmulas, first enter the dala as sliown below :

i

q,

FRLOUS | % i 1700

124___ 'SIZLING FG0DS LTD;_ |

’3:1‘: o ._._I_M_...__._. _|_ b B '
%N@Mﬁ_m_._;tt_GHE-_____'BrJ_tS!C HRA DA |GROSS
ONJAMES 2 1 ots0 4o

BEKId B3 1480

L A,

. ﬂr MARY
SO GEORGE

T
%1 2000

et bt |

. I the eell D35, enler the emula as : =(40%)*C5

Copy his ['ormuin in cells DO to DY,

. In the celf ES3, enter the [ormula as

Copy this formula in cells 136 1o E9.

={20%)*C5

BE)

Lo,
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5. Tnthe cc]IFS;-cnlcr the formula as : =CS+DS+E5 .
6. Copy this fermula in cells F6 to Ff). _
Formulas can be entered by referring to the values of olhcr worksheets of lhc workbook or by
referring o the values stored in other workbook.

LExample:

By referring 1o other worksheet ccil =8heet2!B3 + A2

( Sheer2!B3 relers to the value stored in the L.cll B3 of Sheel2 whllc you arc working in
Sheerl.y -

By referring lo ihc cell of other workbook =100 {[Employce.x!s]Sheet ] !$D$2)'

( In the formula given above. {Employee.xls]Sheet| 1$D$2 refers o the cell D2 0]' Slu,cll ol

workbook Cmployce.xls.)

This also creates a link between worksheets and workbooks. Therefore, while making changes in
these linked worksheets and workbooks one has to be carcful as the change will affeet the
dependent and linked cells also.

4240 Editing Formula

The formulas ca.n be edited in the similar way as you have been editing text or number entrics, _
[. Youcan cc]il the formula by pressing F2 k.cy. and make changes digeclly in the cell, '

2. Type the changes in the formula bnr.'

1. Dauble-click on the cell conlammg the celt and make changcs as the f'ormula is d:apl.lyt..d in the

cell. .
b

4.3 TFUNCTIONS

The built-in formulas are called Tunctions. The users have to.provide the cell references or

addresses only. Theses are called arpuments of the function that are given between a- pair of

parcnlhcsis like (). The functions perform the operation on the given values and return the result
that is displayed in the same cell where the funclion was cntered The use offuncllons also shortens
the formula, :

Example : Suppose you wanl to add the values of ¢ells C10 through C20. You can enier the
formulaas :=CI0+ Clt + CI12+ CI3 -+ C14+CIS+CI16+Ci7+ CI8 + Cl9 + C20.

You can gel the same result il you use (he lunction instead, like = SUM(CH0:C20)

Complex formulas can be created us:ng functions. Somc of the tasks can bc accomplwhcd through
functions only.

Example : Ty dispiay the current daie and time,you have to use TODAY() or NOW(} functions.

Calewdoiiony in Worksheet ' : , o 43
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4.3.1 Categorics of Functions

Excel providcs\you with the various categorics of functions tliat are as below :
L

Arithmetic - These functions are used for sim ple mathematical caleulations of number data.
SIUM(numl, nume, ...} .
Returns the sum of all the numbers in the list of arguments.
Example : =SUM(A3,G3)

' - =SUM(B5:K5) -
. SUMIF(:'hugc, eriteria, SuIm_range).

Adds the cells specified by a givén criteria.

Range - is the range of cells vout want evalvaled.

Criteria - is the criteria in the form of a number, expression, or text that defines which cells will be
aclded.

Exﬁmplc i =SUMIF(AL:A4,">100",B1:B4)
ABS(number)

Returns the absolute value of a number, The absolutc value of g number is the numbcr
without its sign.

Number - is the real number-of -which yéﬁ want th-cl absolute value,
Example:  =ABS(-162)
~ABS(D?)
EVEN(number) - -~ %7/

Returns number rounded up to the nearest even integer. Regard less of the sign of number,

value is rounded up when adjusted away from zero. If number 1s an even integer, no
roundmg oceurs.

Number - is the value (o round.”
Examplc:. =EVEN(5\%)
<EVEN(S)
' =EVEN(@G)
=EVEN(-15)
EXP(numbcr) .

Returns ¢ raised to the power of number. The constant e equa!s 2. 71328132845904 thc
base of the natural logarithm. .

ad - Calculations in Worksheet
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- Mumber - s the exponent applied to the base c.
Example:  =EXDP()
INT(nuinber)

founds a number down to the nearest integer.

Number - is the real number you want to round down to an integer. .
Example:  =INT(6.2) |

_ =INT(6.2)

I*’ACT(numhcr). |

Ielurns e factorial of a number.

Number « is the non-negative number you wari the factorial of. If number is not an inteper,

it is truncaled.
“Example:  =TFACT(S)
MOD(ny mhcr, divisor)

Returns the remainder after number is divided by divisor. The result has the same:sign as
divisor, | Lo :

Number - is the number for which you want (o find the remainder.
Divisor - is'the number by wlrhich you want 1o dividc. number,
Ixanmiple:  =MOD(13, 2)
=MOD(15, -2)
PRODUCT(numberl, number2, ...)-

Mulliplies all the numbers given as arguments and relurns the product.

Numberl, NumberZ,... - arc [ to 30 numbers that you want to.multiply.
Example:  =PRODUCT(BS:F5) .
ROUN D(niﬁnbcr. num_digits)

Rounds a number to a specified number of digits.

Number - is the nunher you want to round,

Num_digits - specilics the number of digits to which you want to r;)mld number.
Lxampic:  =ROUND(96.54.0) '

SQRT{number} _ S BN

Relurns a positive square rool, - '

Caleulations in Worksheet . ' . 45
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" Signifleance - is the multiple to which you want to round.-

‘Example:  =LOG(16, 2

PR

Number « is the number lor which you want the square root. If numbcr 1is ncgauve, SQRT
returns ihe #NUNM! crror value,

Example: =SQRI(]00) '
CEILING(number, significance)
Returns number rounded up to the nearest multiple of significance. |

Number - is the value you wanl to round. .

Example : =CEILING(97.8,1) _ : ‘ N

RAND()
Rclurns an cvenly dlSll‘IbLllCd ldndom number greater than or equal to 0 and less than 1. A ,
new random number is returned every time the worksheet is calculated. If 'you wanpto use I
RAND (o generate a random number but-don't want the numbers 'to change every time the - I
|

cell is calculried, you can enter = RAND() in the formula bar and press F9 to change the
formula to a random number,

Example : To generale a random number grealer than o
eqml lo 0 but less than IOO =RAND(O*100
LOG(tzuxnber, base)
Returns the logarithm of a number to the base you specify. - N o , ' i:
Number - ie the positive reai number for which you want the logarithm. | '

Base - is the base of the logarithm, If base is omitted, it is as-summed to be 10.

Text - These lunclions are used lo manipulale (extual data.

. CONCATENATE 1o join text items.

“Textl, tc\tZ,Q -are | to 30 text items to be Jomed into a-single text item b

- Compares two tex! strings and returns TRUE if they are exaclly the same otherw:sc

CONCATENATE (text], text2, \..)

Joins scvcral text items inte one lext item. The “&" operator can be used mstead of

Ty ow e

The text items can be text strmgs numbers, or single-cell. references
Example : —CONCATENATE(“Soft" “ware"

EXA CT(tL\tI text2)

FALSE. It is case- scnsmve but i |gnmcs formatting differences.
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Testl =iz the BirsUext string.

Texi2 - ix the seeond ext siring,

fxamyple ENACTpoor™, “pour™) : .
FIND{ind_texr, within_text, start_num)

Finds one sivine ol text within another string ol text and retumns the number of the character
al which [ind_text fust oceurs.

Find_text - 15 the lext vou want (o find.
Within_text - is (he et containing the ext you want to find.
Start_nim - specilies the character al which o start Ilhc'scarch. If you do nd.l specify he
start_num, iis ken as 1= the firs) character of wilhin_text. '
‘ I":k:lmplt' : = INDE&T, Chaek & WY
l_,,l".l'j'l'{lt.‘.\'l. .HIIIII_L'II:I rs)
Reiurns the Grst (or iitmost) ch waeter or characters in a text slrlng

Text - is the 1ex1 string conlaining the characters you want (o c‘clracl

Num_clurs. - specilios how mawy charaeters you want LEFT la return Num_chars must be
arcater than or caual 1o zera. *

Iix:;||||1lc - =LETFTS |lt.sm.m 5)._

RIGHT(text, num_cliws)
Returns the last (or rightmost) character or characters in a text string,
Text - is the tex string containing the characters you want to extract,
Num_i:-h:n's - specilies how many chuarncters you want to extract,

Example : =R!GH'l'("SnIesn‘n111'f. 3)

EN(1ext)
_ Retuens the number nl‘chumctc:js inalext string.

Text - is the lext whose length you want 1o [ind. Spaces count as characir’:;s. '

Example:  =LEN{ABRACADABRA™ Y

LOMWILR{text)

Converls all upperease leters 1n o test steing to lowercase,

Celewlations in Forksheot

TN T T



Text « is the text you want to convert to towercase. LOWER does not change char
text that arc not letters,

Example:  =LOWER("Limit")
UPPER(text)
Converls (ext to uppercase.

Text - is the text you want converled Lo uppcr;:asc. Text can be a reference or text siring.
Example:  =UPPER(“limit™) _ |
MID(text, stnrt_num, num_chnrs)

Relurns a specific number of characters from a text string, starting -at ‘the position you
specify. : -

Text - is the text slring containing the charaeters you want.to extract.

Start_rum - is the posilion of the (irst character you want'to- extract in text. The first
chmaclcr u text has starl_nuim 1, and so on. .

!
MNum_chars - specifics how many characlers to return from text.

Example:  =MID({"Microwave", 3, 4)
PROPER(tc\:t)

Capitalises the first letier in text and any other lelters in text that follow any character cther than a
letter. It converts all other letters to lowcrcasc : ,-

Toxt - is text cnclosed in quotation marks, a formula lhat retums text, QI' a. rcferencc to a ceil
" containing the text you want to partially capitalise.

Example:  =PROPER(“the high QUALITY™)

REPLACE(old_text, start_num, num_chars, new_text)

Replaces part o a text string witli a different text string.

Old_text - is text in which you want to replace same char-actcrs. N

Start_num - is the posilion of the character i in old_text that you want to replice with
new _text.

Num_chars - is the number of characters in old _toxt that you want to replace with
new_text, )

New_text -is the text that wiil replace characters in old_text,
Example:  =REPLACLE(“Near™, I, 1, “Py

SEARCH(find_text, within_text, start_num)
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Rclurm the number ol the che-aerer al which a specific character or WKt string is first found,
reading from lefl o right. [0 nol case - sensilive,

Find_faxt - is (he ext you want to find.
Within_text - is the texi in which you wanl to scarch for ﬁnd_-l_cxt.

Starl_num - ix the chzu'actcr number in within_text, counting from thc left, at- wh;c‘\ you
witnt {o slart searching. -

Example: =SEARCHL”, “Quality™)
TRIM(te:t)
Removes ail spaces [rom lexl excepl for single spaces between \-vords..l"
Text-is the text from which you want spaces removed.
Bxample:  TRIM(" First Quarter Earnings ")
SUBSTTTUTE(ext, old_text, new_lext, instance_num)
Su!mlitulcs new_text for old_text in a text string.
‘Text - is the rext or the reference 16 a cell containing text for which You want 1o substitut
characters.
Ofd_text - is the text yau want to replace.
New_text - is the text you wunt to replace old_text with.
h‘:stnncu_num - specilies which occurrence of old_Llext you want to rpp!acé wnth ncvg__tcx.t.

Example: = bUBSTITUTL(“Sulc Price”, “Sale”, “Cost”)

Date aud Time - Exeel stores Daote and Time as serial numbers.

JThough the values are displayed in the appropriate format which is rccogmscd by thc uscr,
The lunctions 1o maniputate date and time are :

DATE(year, month, day)
Rcz_lurns the serial number of a particular dale.
Yiear - iy o nu;nhcr from 1900 to 2078 in whicrosolt Exeel for Wirlldows'_:-
Month - is a1 number rcprc;sc'nling the month of the year. N
Day - is a number representing the day ef the month.
Example:  =DATE{O7.2.12)

DATEVALUE(date_text)
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Returns thc serial number of the date represented by date_text. .Date_text - is text that
returns a@ate in a Microsolt Excel date format. -

Example:  =DATEVALUE(“22-AUG-96")"
: DAY(scrinl number)

Returns the day of the monlh couuspondmg {0 scrml number. The day is given a5 an
integer ranging from | to 31.

Serial_number - is he date- tnnc code used by Microsoft Excel ‘for date and time
calcu]allons

Ex:unplc b =DAY(“16-JAN")
MONTI‘I(':criaI _humber)

Relurnys the momh co:rcspondmb lo scrial_number. The month is gwcn ‘as an integer,
ranging from 1 (January) to 12 (Dcccmbcr) -

Serial_number - is the date-time -code used by Mlcrosoft Excel for date and time
c1iculallonb

“Example: =MONTI("6-MAY")
YEAR(serial_number)

Returns the yc:'u corresponding to -serial_number. Thc ycar is gwen as an lnteger in the
range 1900-2078.

Serial numbcr - is the dale-llme codc used by MICFOSOR Excel for date and ‘time
calculatmns .

Example:  =YEAR(“7/5/96") _

WEEKDAY (scrial- number, relurn_type) - N
Returns the day of the week corresponding to serial_number.. The day is given as an
integer, ranging from | (Sunday) to 7 (Saturday). i

Scrinl_number - is the date-time code used by MlOl‘OSOft Excq] for date and tlme
aICUIauons : :

‘Return_type - is a number th'tl dctcrmmes the type of retum valub

Example : ~w1;n1cnw(“2;12;97")

SRR

I~IO|JR(:,cr'11 _number)

Retums the hour corres ponding to scr:a] number. The hour i is gwcn 85 an Intogcr, mngmg
from 0 (12:00 A.M.) to 23 (11:00 P.M.).

Serial_number - is the date-time code used by Mzcrosoﬁ Exccl for datc nnd time
ci xlculat:ons
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Iexample : =[HOURM3:35 PM™)
MINLUTEfserint_nuinber)

e minule conespanding lo .cu.l number,” The mmulc 1s ;,wcn as an mlcgcz

AETE] {) 1y _"'r ¥ . . \. .--. - L Lo ) R o "

- o
'

HEA R

Sueial_pnmber - iz ihe dale-time eode used by Microsolt Excel’ for .date and thne !
vitlenlatine o o

e
e -

Example : =MINUTE(3:35 PM™)

HOW()

Reterns the serial number of the current date and time.,
Fxample:  =RNOW()

TODAY()

Returns the serial nuntber ol the current date.
Example : =TODAY()
Lookup and References < These functions are used to scarcl.l for the values in the table.
-HiLOOKUPookuy value, in‘nk‘uprci'. columnno, nearest)
Senrchies e lﬁp row ol an areay lor & particular value, and returns the value in the indjcated

et Lise tiis function whea your camparisen values are located in a row acress the top of a
table of data and yon wani 1o ook down a snecificd number of TOWS,

Lookup value - is the value to b found i the first row of the table.

,ookuplu"- is a lable of information in which data is looked up. Columnno - is lhc ToWw
number In table_array from which the matching value should be returncd. '

Nearest ~ Is a fogical value that speeifies whether you want HLOOKUP to find an exact
match or an approximale match. I FALSE, HLOOKUP will find an exact-match.

Exumple: | =HLOOKUP("BASIC", C4:E9, 6, FALSE)
BASIC  HRA ?DA
1500 T B00) 300
1480 i ......,‘:80" L_._.=290} °
1700 6801 340
L dog . S80( 280 : -
LZono 200! 400 . : .

V9EDORUP(lookop value, lookuprel, columnno, nearest)
A
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Scarchcs thc lefimost. cqumn of an array for a partlculur valuc nnd rt.lum the value in the
cell ipdicated. Use this function wiren the comparison values arc I-ocatcd in a column to the -.

leﬂ or right of the data you want to find.
Lookup_valuc - is'the value to be found in the first column of the table,
lnokuﬁrcr - is lhe lable of information in which dptu'is'lﬁokcd up S

Columnuo - is the column number-in table from which the mntclﬁng?vdll;tc should be
rcturncd ' ' ' e Co

‘Nearest - 15 a Ioglcal value -that Spcc1ﬁes whethcr you want LOOKUP to find an ecxact

match or.an .lpproxlmatc match.

Examplc: = VLOOI\UP("KIM" Ad: B9 2, FALSE)

E'T? W'NﬂME " IAGE
BUJAMES . | 25!
%ﬁ% KA _ 33
g LOUIS 2% |
M MARY 21 . o
 PHEIGEORGE| . 257 " -

Logical « These funclions are used to tcsl the condlt:onS\They retum tha 10g1cn1 valuc as

TRUE or FALGL

AND(!oglc'ﬂI loglcal?. )

Rcturn= TRUE if all its 1rgumcnls are 'I‘RU.E rcturns I"ALSE lf one or more, arguments are
TALSF - - .1'.'.-:'..

LO,_'lcall lug:calz . —are 116 30 condiliéhs'yqu want to*test thlat‘ can.be either TRUE or

~FALSE.

Example:  =AND(14312, 4=4)

OR<lagicall, logical2, ...) S I I
Returns TRUE if any argument is TRUE; relurns FALSE ff:ﬁil.arguménts.'me FALSE.

Logieall, logical2,... - are 1 to 30 COﬂdllIOnS you want to lest that can bc elther TRUE of
FALSE. .

Example:  =0OR(2<8§, 5>3, 6=2)

. NOT(logical)
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I‘u.'r:rscs the vaiue of its 1rgutncnl Usc NOT when you want to makc sure a va.luc is not
cqual to onc particular; value

Logical - i§ a vaiue of cxpression that can be cvaluated to TRUE or FALSE If log:cal is
FALSENOT returns TRUE; floycal is TRUE, NOT. retums FALSE.

Example: = NOT(5>3)

I (hfnc..l lest, value_if_true, value !f—ﬂ#ﬁt.)

Rewrns ane value if log:cal test cvalnates to TRU‘E
FALKE, Uip to seven [F func.tlons can bc nested e

RIS
A

l,u;,th! test - is any valuc ar cxprcss:on that ca.n bc cvaluatcd to TRUE or I"ALSE
Value_il_frue - is the value that is returned lflo_gllcaF__tes_;t is TRUE,
. Value_if_falsc - is the value that is returned if{ogi-cal_tc;st is IFALSE.
Mxample: =[F(35>20, 35, 0)
FALSE()
I.I’ etures he fogical vatue FALSE.
Exumple: =FALSE()
TR ) ‘
Retums ;hc jogical value TRUE.

Example:  =TRUE()
4.3.2 Function Wizard
lixeel also provides you with its buili-in functions lﬁrdhgh- Function Wizard, This guides you
tirough all the steps of writing a function and its arguments. The results and examples are shown as

you work on it, To use Function Wizard (ollow (he given steps :

L. Enter the given dala.

.

O B

7Jk|ITEM CODE| RATE . |STOCK STOCK LEFT
' AT 50 30T
AQD? 4200
ACQO3 20 620 - | |
A i F 390 ' .
ADGS - 80 100 |

ai;fd"‘fi.ﬁol}lér'.:v'iilﬁq' if it évaluates to -
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2. Activate the cell D2,

3.. Open the Function Wizard in cither of the [ollowing ways -

Click on the Function Wizard Tool on Standard Teolbar

or

Choose Insert -> Function command

or

Press Shilt + I3

4, ‘Cl;'y:k on Math & Trig in Funetion Calcgory.

5. Serol down 1o choose Praduct from the Tist of Funclion Nane.

( obscrve that the formula is shown in the Formula Bar)

hn S”N eﬂ."lou‘ {[’i

“..—

RODUE:

* il

‘[num _

Rt

E:.,'I $ qrﬂu 1enls
e A

Bert:

-

UL

My
;‘z
i

Ty ..-:';-u-

‘p:-u L‘.-\ r!u,l P L«ew;ﬁ

6. Click en Next button.

7. Click on cell B2-while the cursor is in number! box.

" & Golo number2 bax and click on cull C2.

2,

s d IR ats T
T S ‘?-;f:y:\'-‘-zz‘iﬂnwu}-.‘:?’??*&"u e
P I.unqtlon'Calcgory:.‘:&::;;g@% (’L\%&, qulr‘:j{!unzl!g._?ma; \.4. !
{TMost Recently Used BT MOD Rl
AN ¥looD A3
iFinancial Pl M
%Date & Time |POWER & '
S M AL 5 gt PAPROBUC T etk oe i
M ‘;lalrsllcal 2 RADIANS v }‘
|5{l.ookup % Reference % |RAND Lt |3
MDatabasc SFIROMAN 2 m
K Text #AROUND el
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9. Click on Finish, (The resultis shown in the cell D2) "
it Copy this st o cells D3 (o DG, , ;
i
Cliteek Your Progregs
roWhal s tae wpniiicance of iermulas in calewlations ?
.................... ; ;
:
20 Expioain the recaleulation l'calurc of MS-Excel. |r
3. the basic properties of formulus
4, What are functions ?
. .
(Give two examiples lor cach category of funclions
Calailations in Workshee! . 55 :
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%. Differentiate _be'lwccr_l VLOOKUP() and HLOOKUP() funetions, .

7. What is Functiz: Wizard ?

4.4 SUMMARY

In. thls section, y0u lcarned to enter formulas and Functions, These are very hclpful in calculauons

.and analysmg daLn

1 F Ormulas can bc used with functions z{lso to form complex equation.

2. Exccel prowdcs wnh the large col[cctlon of functions for drfferent caegories like text, math,
logical, date mld timae, Iookup and reference, etc.. :

J. Function leard guides you at cach step to entcr functions.
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5.0 fntreduction
o {hicclives
3200 Chart Tvpes
5.3 [zehiting Charls
5.3.1  Adding or Leleting Data
33.2  Change the Chart Type
5.3.3  Format a Chart
Y34 Drawing in the Chart’
5. Summary

5.0 INTRODUCTION

Charts are the graphic component of Excel. The data which is entered as tables can be viewed in the
graphical form as charls which makes the figures of dala elfective, interesting, easy to understand,
anl easy (o analyze and compare data, Chart can be of two types : '

Embedded Charts: These charts are included in the worksheét and can be moved, copicd, and
resized as any other graphical object, 1t's advantage is that it can be viewed along with the data and
many charts ¢can he inserled,

Chart Sheet: Separate Chart Sheets are inserled when a chart is ereated. It contains only onc charl.
=T ereate Chart Sheets, choose Tnsert 2> Chart -> As New Sheet, -

Iixeel helps you (o ereate chart as cither 2-dimensional or 3-dimensional. The Chart Wizard guides
you all the way 1ill you linish your work of creating it. Alter crealing a chart, you can enhance: the
mformation by adding chart items, such as data labels, a legend, titles, text, and gridlines, You can
also format these items using paticrns, colours, alignment, fonts, and other formalting attributes.
Any change in data will update the changes in the chart which was made using that dala.

ST COBIJECTIVES
Aller going through this unit, vou will be able to
« draw charts using Chart Wizard.

» resize and move i the warksheel,
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Yo Do
RS M U . 1

O AL
* cdit chart type, pattern, ¢olour and text font
" * use shorl-cut menu 10 insért data labels, legends

» . use built-in formats-and user-defined forimals to quickly format the charts.

+ print embedded charts as well as chart sheets

5.2 . CHART TYPES

" MS-Excel offers 15 different mujor chart types, cach of which has at lecast one subtype; or variation.

You can change the chart type lo present your data most clearly and effectively. The various chart
lypes arc | ' ;
Area Chart; This shows the magnilude of change over time. It is a stacked line chart, with the arca
between the lines filled with colour and shading. The data series are plotted one on top of the other,’

'REGION SALES

20,000
15,000
- 10,000 ??.:: DQUARTER 3
| 18000 -2 B QUARTER 2
5.002 el BGQUARTER 1

Bar Chart: It consists of the scries of horizonial bars that allow comparison of the relative size ‘of
two or more items. ) : ' ' '

i
WEST |
. e kb e I .. [
T [oquARTER Y] | . I
- SOUTH e RQUARTER 2] | o
| " BQUARTERT|] - . F
0 2000 4000 G000 BNO 5_
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Column Charts This consists ol a series of vertical columns that allow comparison of the ralative
size of two or more jiems, : ,

REGION SALES

NGRTH  SOUTH  EAST  WEST |EBQUARTER 1
HQUARTER 2
DGUARTER3‘

Lisne Chart: Lach of the data series are plotied as lines of different colour and shading.

REGION SALES
6,000
. G000
4.004
2,000
0 ;
MNORTH SOUTH EAST WEY —8— QUART| -
_u..EOII-{IEDT-

Pie Chart: These are the best charls to compare the percentages of the swn the data serics. [t
represents onty anc dala series. .

" S

* REGION SALES

BNORTH
@ SOUTH

OEAST
OWEST

Clirts i " T

et o e



Doughnut Chart: It is similar to Pic Chart but it represents more than one data scries.

T

REGION, SALES

mNORTH
WmSOUTH
OEAST
OWwWEST

Radar Chart: This shows the data values in relation to the centre point and tacach other. Data of
the same data serics are connecied by lines. -

REGION SALES

—+— QUARTER 1
—=&— QUARTER 2
—é— QUARTER 3

XY (Scatter) Chart: The value of the dita series is plolted as the intersection point of the X-axis

and Y-axis.

1

7,000,000
6,000,000
4,000,000
4,000,000
3.000,000
2,000,000
1,000,000

i}

ey

REGION SALES

——— QIUJARTER 1
—a— QUARTER 2
—A— QUARTER 3

3.3 EDITING CHARTS

Once vou have created a chart, you may wanl (o update it by adding or deleting more data series or
data points from the workshee!, change the chart type format a chart, or draw inside a chart. The
method you use 1o add data is determined by the kind of chart (embedded chart or chart shect) you

waid (o updale.
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RGN :\tltlin;_:'nr' Deleting Dala

Addimg or deleting data automatically updates any existing fegend. Using the Chart Wizard, you
vt change the range that a chart is based on. I[ your chart was created [rom multilevel categories
an] serien you must use the ChartWizard (o reseleet your data and recreate the charl.

Toadd datn o an embedded chart on a worksheet, you can drag and drop data rom that
workshéel. Using copy and paste is the casicst way 10 add data to a chart sheet. Or you can use
the New Data command for either embedded charts or chan sheets.

2. You van also delete data series from a cliart by double clicking on that and pressing (he Liclete
key. : ' ' .

AT COhmpe the Chart Type

St o vainouy chart types (o choose from. This can be done if you follow the given steps :

. Seleet the chart by double clicking on it. It puts a border around the chart,

- .-

2. Choose Format -> Chart Type, and select the new charl.
or

Chick on Chart Wizard tool bution, (this will show only 2 steps out of 5.

233 Tormata Chart

wnce you erente 4 chart and add chart ilems such as dala labels or litles, you can then format many
ol the items in the chart.

b select the chart area or plot area.

2o Press the right mouse button Lo get the shorl-cut menu, and choose Format Chart Area.

. This gpens up the dialog box where you can globally apply colours. palterns, borders, and text
fonts,

One chart item at a time can also be seleeted and formatted.

There is an casv alternative o selecting and formauting individual charl items, i.c., you can apply a
buiit-in chast aatolormal. Or you can create your own custom (user-defined) autolormats, which
vowean apply to charls, Autoformats work much like templates or styles. Each auloformat is based
on A chart Lype. 11 can also include sublype, legend, gridlines, data labels, colours, patterns, and Lhe
placement of various chart items. When you apply an autoformat to an active chart, it changes the
enlire look of the chart but does not affect your data.

Towve o Built-in Formuat ;

. Select the chart,

2. Choose Format -=> Autafarmat,

Cheartx : _ 1
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HECT T

3. From the dizlog box, select Built-in choose any of the charts from Gallcr:cs. On the right side,
various formats are displayed from where you can sclect any, -

To Creaté a Custom Fommr :
1. Create a chart having all lhosc features (chart lype font, pattern and other formals)

2. Actwatc thc chart.

3. " Choose Format -> Auto Format.

Select the User-defined option a.lnd click on Cusfo;rlizc buttoﬁ. )
5. Click on the Add button, -
6.' Enter the name for the format, if des}rcd. .
7. |

Click on OK,

3.3.4 D-ra.wing -in thc; Chart
You can draw.the objects in the chart in the similar manner as you'draw on tl;lc worksheet. For:this,
[. Select the chart. |

2. Activate the Drawing Toolbar, if it is not activated already.

3. Clickon the appropriate ool button of the toolbar and draw on the chart.
Check.Your'Progi'css 3 , " .

1. What is the significance of formulas in calculations ? v

2. Explain the recalculation feature of MS-Excel.

3. Give the basic properties of formulas.

oA
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4. Whalare functionis ?
: N i
TR e pie S cach category ol Tinctions, 1
' k
J.‘
6. Dilferentiate between VLOOKU]’() and HLOOKUP() functions :
7. What is Function Wizard ?

34 SUMMARY

la this scs.si-on. you learned:

I. To draw charts using Chart Wizard.

2. Charts can be resized and nmﬁ:& in the workslieel,

3. Editing of chart lype, pattern, colour.and fext font can be easily done.

4. Onee you seleel the chart, most of the menu commands are displayed in relation 1o charts oniy..
Short-cut menn can be used (o insert dmﬁ labels., legends, and sé[ccl the chalrl typc.

6. Built-in formats and User-defined formats can be used o casily and quickly format the charts.
. S _

/1. Charts are very uselul foals to analyze dali.
¥

8. Embedded charts as well as Chart Sheets-éan be printed.

Charts
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6.0
6.1
6.2
6.3
6.4
6.5
6.6
6.7

6.8

[ntroduction
Qbjeclives
Database Concepts
Creating Dalabase
Adding Recards
Deleting Records
Lzditing Records
Serting a Dalabasc

Summary

6.0 INTRODUCTION

Every organization works towards, maintaining data of various: kinds, c.p., a1l the details of the
cmployees, sales details, client data, products dala. The purpose of storing and maintaining data is
1o refricve it later for day-(o-day transactions and management planning.

The data which is collecled from the sourcee is (he raw data. Various operations can be carricd out
with the dala, like, sorting, searching and totaling. This is processed and manipulated to be

transformed as Information.

The mast important d'ltabasc featurc of MS- EXCEL is a’ powerful and simplified {ool to siovz,

manage and analyze data.

Internal Database -~ Databases created in the worksheet.

External D.ntnlnsc - Database which is created through other DBMS or RDBMS packagcs like’
MS-ACCESS, FOXPRO, dBASE, SQI Server, ORACLE.

‘I'here are two kinds of databoses :

£
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0.1 OBIJECTIVES

Atter going throtgh this unil, you wiil be able (o
o create datbase in e worksheel
e useextornal datibases

« arrange s though soriing techniques.

=+

adeh, defete, or edin records i the danthases

0.2 DATABASE CONCEPTS

. ™
Idatabase is also referred Lo as a list'or a table, It is an organized collection of information. Each
raw of the listis called as a record, and cach calumn is called as a field.

Lel's take an example of the employee delails as shown below:

EMPCODE NANMIE AGTE DEPARTI\I‘TENT SALAR
y
oot Rishi 127 Markeling 4500
002 Sandeep | 33 Marketing 6000
E003 Vinita | 24 Accounts 4000
E004 Prakash | 23 Inventory 5200
12005 -~ Aruna 23 Marketing 3700 .

i this exumple. EMPCODLE, NAME, AGE, DEPARTMENT and SALARY are the ficld names.
fzach row with the data for one employee is (e record of that employee. The record c.onLalm the
dala pertaining (o the ficlds.

Ihe ficld names must be unique and there should not be any blank row between the ficld names and
lie records, '

6.3 CREATING DATABASLE

o MS- E\CEL. dalabasc can be created in hwo ways

l. [;ntcr the dati in the form of table in the worksheet, You can enter the data as shown, This 1s the

simplest way to creaie the dalabase, .

20 Use Dawa Farm command,

Latabase Power of Excel - : S, 08

e -

R ik b R



To create database using Data Form connnand, follow the gi v;:n_ steps.

.

!Jl

9"\

" Enter the given delails

Al EMPCODE

Bl " NAMIE

cl " AGE

DIl  DEPARTMENT
Bl . SALARY

Choose Data -> Form command while keeping one of the field name active.

The dialog box is displayed, warning you for taklng the row of the selected cell as the header
row of the database. Click on OK. : .

Another di;ﬂog box is displayed, which shows one record at a time. Fill-in the appropriate
details in the box against each field namc. ' '
b .

e

R .,a
15 &Rﬁﬁﬁ‘ﬁ '1"-&#:& 13

;ér \‘urcmmscmﬂmp}zi ,‘ i
[

| SR B}'i"‘l"’ﬁ‘:ﬁ\f&?%

VRS
Lc ERARE Natadaanl T
Er' ‘%f -:Iﬁ;:é{%_:,)}ﬁ? e ‘*”‘#" L AT TR LTS ! Fﬁ‘ %E;?L Ei

Click on ' New. This will add the entered record in the database.

To (inish (be entry of rccords, click on Close.

el
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5.4 ADDING RECORDS

The records can be added in lwo different ways ;

1. Tyne Lhc.n'cw'rcco_rd entries in the blank row next to the database list, °

2, 'l"hc records can l;c enlered in the way that is similar to the steps of creating a databasc.
a Ac'.i'ltalc any ccll of the database list.
b, Chovse D:-ltil -> Form command.

¢. Goto the last record and click on New.

d. Type-in the new record details in the boxes against ficlds.

. CIfck on QI

6.5 DIELETING RECORDS

The records can be deleted by simply selecting the entire celi e of the record to be deleted and
press the Delete key. Move the rest of the records on row up. sanolher way of deleting the records is
as follows : ' ' ' :

1. Adlivate any cell from the database list.

. Choese Datiu <> Form command.

L 4Gel the veeord Lo be deleted by clicking on the [ind Prev or Find Next button, - P '

L, Click on the Delete butlon.

6.6 EDITING RECORDS

“Ihe tccords onae entered in the database list can be changed or modified. This can be done by
seleeting the ced and retyping (he data. Another way of doing this is by Data Form:

L. Seroll up or qown to sclect the desired record.
2. Ldit the ficld value,
3 Click en New butlon to update the modificalion in the record.

4, Click on Ciose once you have finished up (he task of modification of records,

6.7 SORTING A DATABASE

To arrange the records.in either ascending or descending order of a field is called sorting. To sorta -

database, first ereate the given database. : . .

Datahase Power of [xeel
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i. Choase Data -> Sort. cornamand.

Y. In the dialog box as shown below, you can sclect maximum 3 ficlds on the basis of which you
want to sort your dalabase. The drop-down list of the -

kPt 3, "\-F DR T A 21 ‘BI’-;}% Ty "(\ﬁﬁ TB" ‘4 %Eﬁ
L [ H . Py M
nl-’rlud“:::-rx LR v Y . ey ?"-‘-F 3"\" it iy o
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FRODUCT [QTR1|OTR2| OTR3 |QTRA
S| SHIRTS SO0 230|234, 250

W52 TROUSERY 80| - 75( 801" SO
“hEIBLAZERS | 1001 143, 124] 130
WE[T-SHIRTS_§ 3001 320 290) 350
SRS JACKETS | 600] 500|  5B0| 690
|9 JEANS ~ 50 - 30| BOJ . -45)
E1 B i ] RAMRNE

AT s o S P T
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l.

3. Choose the order in which vou want to display records - ascending or descending, -

4. Seleet Header Row option given wider My List has.
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5. Click an O and sce tie results on the worksheet,

Then By aplion is.uscd when you want to sort the database on the basis of more than one liclds.
The Nickd name chosen lor this option will become the sccondary fiekd.

Cheelt Your Progress I
. What is liw signil'u.:uncc ol" formulas in ealcuations 7
C20 Vapainihe :-cc:ll.;:ulalion lbatu;uof MS-Excel, . , ' .
o
..................... - | | '.
4, What are funclions ? ,
5. Give lwo examples for cach category of functions.
............. L .-
. Diflerentiate between VLOOKUP() and HLOOKUP() functions.
G
Loeeds :.f':r.r_\":." ," ’n\tlc: ()f}:).ccf IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII ' . 69
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6.8 SUMMARY

In this session you learned,

2.

6.

Database can be crealed in. the worksheet or exlernal_dgtaba.scs can also be used.
The dala can be arranged throuph sorting techniques.

The information malching a certain criteria can be cxtraclt;d from the database.
Reeords in thi: database can be added, deleted, or edited.

Data Tables help in What-if analysis.

Pivot Tables arc also used 1o analyze data,

70
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The aim of making a presentation is 10 pul your ideas across. To make an cff'cclwc prcsullauon it
is cszential for information o be well displayed. One-of the best ways 10 present the data is- lo:
present in the colorful pictorial [ormy. The most popular soltware for this purpose is Mlcrosoﬁ

Powerpoint. This soltware packabc comes as part of MS-Office software. '

The modulc las been covered in four units. The first unit covers the’ inlroduction 1o Business -

Gl‘aphics and highlights the features available in' Powerpoint. Second unit covers how to create
presentation slides using tools like Wizards which will help in c'rcalin;:, presentations quickly and
casily. Third unit gives an overvicw of graphs and tables. After going. lhrou;,h the fourlh unit you
will te able to mal.e effective presentations using slide shows.

You are expected 1o know windows, before you start with Microsoft Powerpoint.
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Structure
1.07  Introduction
[.1 Objectives

1.2 Whalt is Business Graphics?

L

Types of Business Graphics
[.4  How lo make an effeclive presentation
[.5  Physical aspects of presentation

1.6 Summary

1.0 INTRODUCTION ' o :

~

This unit gives a-brief introduction, of whal Business. Graphics is and- the lypcs of business
graphics. [l also muoduces you o Powchomr as one of the tools for making Busmess Prcsentauou

Graphics.

1.1 OBJECTIVES

After gaing Lhrough this unit, you will be able to
« understand the dilferent lypes of graphics
¢ appreciate physical aspects of presentation |

-« understand’the concepts of slides and charts'in a presentation

1.2 WHAT IS BUSINESS GRAPHICS ?

A picture is worth z thousand words. We live in a visua! world, and the human mind can
comprehend and retain concepts learnt through visual dcplcuen for longer time. In today’s world, it
-is very critical for a person 1o put acress ideas elfectively, whether it is business or not. One s way of
putling across ideas clicctively, is the use of visual i images. And the best form of visual images arc
“graphics and piclures. u::l])hlcs. if used to convey ideas'in business situitions are known as
Business Graphics. o : : e




1.3

TYPES OF BUSINESS GRAPHICS -

There are three types of Business Graphics. They are

()
(h
"

@)

{b}

{e)

Presentation Graphics.
Analytic Graphics. ) -
aesign Graphies. . B

Presentation Graplhies: Convincing the audience about an idea and putting your views '

across is the aim of any presentation. The main goal of presentation graphics is to get a

‘messuge across. Examples of presentation praphics tools include Harvard Graphics,

Powerpoinl and lot more.

Analytic Graphics: Analytic Graphics presents the data and information__in' such a way that
it helps in peaple analyzing i [ts ainris (o show relatiotiships in data and information,

Analvtic “iaphics need not have a very high quality. They are used to produce graphics
from the dia stored in dalabase management systems like MS-Access and electronic

spreadsheets fike MS-Excel. They help in analyzing the data and taking a decision thereby. -
" Graphies provided by spreadsheet packages like Lofus 1-2-3, MS—Excc! arc examples of
Lanalylic graphics,

Design I(;n_tphics: Design Graphics are used to create visual images of produ'cts,_ models,
cte, Computer Aided Design (CAD) is an examiple of design graphictocl. -

1.4

HOW TO MAKE AN EFFECTIVE PRESENTATION ?

Till now you have examined the different types of busmcss graphlcs. of all these, prcsentahon

araphics is the most commonly uscd onc. Toe convince the audience about an idea, the presentation

hias 10 be eifective. Tn other words, you can say that cffective usc of presentation graphics is a very
imporiant aspeet of successful presenlations. “For th:s ask yourself some questions while making
the presentation fike .

¢ Do { know aboul the people whom I am giving a prcsenlauon"

2 You must he aware of the audience’s fevel of knowlcdgc on the toplc about Wthh you are
nmaRing a pu.u ntition, -

o Ia 'n} presentation simple 7, You can convinee Uie audience only if they understand you. Your

presentation should be simple, enough. so that even a person who is lolally new or who hardly
knows anything about the Llopic, also rt.ls youy point. '

= s lhe presentation Lo the point 2,

Take care of lollowing points also while making Lhe presentation”

«  Start with whatds Tmiliar (o the audience.

e Make cocly chat independent.

{
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Uge sppce o™ ~vely.

Hise text and color judiciously.
i

3

% PHYSICAL ASPECTS OF PRESENTATION

jow the information has been displayed, is very important aspect of any presentation. hiosic:
stides. praphs, bar charts and pictures are used for displaying information. To be able to usc slides
acmingfuily, the person must be familiar with the basic compoiicents of a slide.

Yo can call aslide a good ong, if it succc_ssi'ully communicates a message. ;'

The campn1lc|115;-0{'“:rsn‘('l(,-'_;;['c :

s Title : ‘Title gives an idea of what the slide is all aboul.

> Subfitle - 1 A sublitle cmphasize:sl-lhc slide’s central idea.

< 'Fouluotc : A faomole indicai.cs th‘e source of the slide’s data.

a DBorder : Itacts like a [rame {or your slide.

s X-axis , Y-axis , X-axis title , Y-axis title (for the graph).

Slides ave one of the most important cmﬁponcnls of a presentation. Let 1js examine slides in detai!._
Types of Slides

» Text Slide highlights the main ideas.

Profit -
1995 Vs 1996.

1995 . 1996

Profit : . Profit-
100 crores -~ - 140 crores
"Prod. capacity Prod. capacity
200 tones . -~ 300 tones

Prescatation Graphics
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o Charts like Pie Chaet, Bar and Columin Chart, Area Chart, Line Chart, and Organization Chart,
clarifv 1ne reimionships in data and information.
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45 SUMMARY = . .

+ Dusiness graphics can be categorized. into .~ ¢

-

e Presemintion graphics
« Analytic praphics
». Design g|.'uphics
» The various types of slides are Text slides and charts.

The various components of a stide ave : Tille, Subtitle, Footnotes, Border, X-axis and its Titles, Y«
axis and its Titles ' ‘ '

- — - ' _ Presentation Graphicsy



Struehunre

2.0 Introduction

2 Objcctives

2.2 PowerPoint Views

23 Starting and Quilth?g PowerPoint
2.4 The PowerPoint Window

2.5 Sunymary

2.0 INTRODUCTION

The previous session introduced PowetPoint as a Presentation Graphics package. In this unit w
will get introduced 1o some of the components of PowerPoint like PowerPoint Wizards, Toolbai

and PowerPoint Views,

[ R e
!

>

S O T AT

Selling an Idea or a Product
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i"nwerPoint is a compicte presentation graphics package. It gives you everylhing you need to
produce o professional-looking presentation - Lext handling, outlining, drawing, graphics, clip an,
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and so on. It also offers rich speaker support and aids to help you créite truly cffective
presentations, PoverPoinl makes you, the presenter, an independent producer of your own high-
" quality |):cscnl..1t10ns

Dan't worry aboul consistency in design and colour. Powchomt can help you. If you don't consider
yourself a designer, just apply ane of the PowerPoint templates lo your presentation and choose
from among the thousunds of colour schemes available.

Whether you need quick overheads for a team bricfing, slides for a sales meeting, or dazzling
cflects for an pn-screen presentation, PowerPoint wizaggs, templates, and AutoLayouts help you pet
“right (o work; and o complele set of easy-to-use tools assures you have everything you need to get
,yous pojnt acrosg and share information with others.
NI o

2.1 OBJECTIVES

Aller going through this unit, you will be able to

|- .
* y starfand.quit the powerpoint from the icon “
r b t "

° know lhe dilTered.: powerpoint vicws

* use the toolbar and menus (o ereate a presentation

-

2.2 POWERPOINT VIEWS

4

A FowerPoint presentation is a collection of your slides, handouts, spcaker's notes, and. your
outline, all in one file. As you create slides, you're creating a prescntatlon _you're designing how
youi presentation should look and giving it a format that carries throug-h from beginning to end.

PowerPoint gives you the flexibility of switching between different ch\during the crcation of
slides for a presentation. - S
. . \~\._\\__——1'\’

T
» Slides arc the individual "pages” of your presentation. Soon, you'll be creali{ng slides with
PowerPoint. Stides can have tilles, text, graphs drawn objccts shapes, clip artujravm art, and
vnsual crealed wilh olher appllcal ons and more.. -

+ Handouts support your prcsenlalmn You have the option of providing handouts for your
audience. Handouts consist of smaller, printed versu:ms of your slides. :

* Speaker's Notes cun be created and prinied. You‘l] see a small image of the slide on each noles
page, along with any noles you lype on the notes pages.

» Girtlines  As you're working on a presenlation, you have the oplion of working with your
pre: sutation in outling form. In the outline, your litles and main lcxt appe.a: but not your art or
the text typed with the Text tool.

1A ' ) . Introducing PenwverPoint
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2.3 STARTING AND QUITTING POWERPOINT

You can start and quit PowerPoint in the same way as you do other windows based applications.
To start PowerPoint

1. Open the program group that conlains the PowerPoint icon.,

2. Double cliek the PowerPoint icon. PowerPoint starts and chsplays MS - Powchomt window,
where you cin cieale or open a preseiniation.

P

9 £ B K

Office Rieadme Oifice Setup  Microsoit Microsoft  Miciosoft
Help Office Word - Excel

Micragett

=

WS Eroel . Miciosolt  MS Access
Samples Access  Readme Help

ey Double click here

MS hccess  MS Access . . . ’
S=tup Woikgroup '
; Administratos

Introducing PowerPoint : - "1




To quit PawerPoint

»  Seleet Txit from the File menu.

M alyd Edit View Insert Format  Tools
New... : S Ctrl+N
Open... Ctrl+0O
Close N
Bave - . Curl+S

Sawve As...

Find Filc...
Summary Info...

Slide Sctup...
Print.. Ctri+P

a;g-rt';--m}ar R

v THE P ERPOINT WINDOW

From the PowerPoint window, you can create preseniations and use its toolbars and menus.

ﬂM cnu Bar '
;::_‘3‘{: S MICtOB ot PawerPoint  ~ bt Tire -7 o o
Lile Hlil Vit In.,t.n Fnrmut Touls
(N e e e e o e ] B Tl
e e E;m ]
er. o & . .
? I% G} Tool Bar : !
== g
15y Status Bar .
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Title Bar localed at the top ol the sereen, displays the name of the presentation.
Menu Bar located below the ttle bar, lists the options,

The Status Bar Messages anpuar at the botlom ¢ the wmdow in an area called the status bar.
These messazes duseribe what you are secing and domg in"the PowerPoint window as you work,

Ch . . Iniréducing PowerPoint




Normally, the slatus bar tells you which slide you're workmg on (Slide 1, Slide 2, and so on) thn
vou c.hoosc a comtmnd the status bar provides a short message telling you what that command will

do.

Three shorteut buttons appear on the right side of the status bar - New Slide, Layout, and Template.
Clicking the New Slide button presents the New Slide dialog box and adds a slide to your
presentation immediately following the current slide. Clicking the Layout button lets you change
the luyout of the current slide. Finally, clicking the Template button allows you to app]y or change
(he lemplate for your presentalion. N

Tive Toolbars you can use toolbars for quick access 1o commonly used mands and tools.
When you first start PowerPoint and open a presentation, the Standard and Fefmatting toolbars are

displayed just below the menu bar, and the Drawing toolbar is displayed vertlcally on the left side.

of the window. Different toolbars appear aulomanca!ly in each view.

The Seroll Bar There's a vertical scroll bar on the right side of the PowerPoint window. The s¢roll
bar has an clevaior as well as double arrow buttons you can use (o move from slide to slide. .

To move to a particylar slide using the scroll bar

. Drag (he cievator up or down to go to a particular slide.

Elevator

As you drag, the slide indicalor box tells you what slide you're about to display. Releasc the mouse
bulton when you reach the slide you're looking for.

To mave slide by slide using the double arrow buttons

You can quickly move one slide up or one slide.down using the Prewous Shdc and Next Slide
butions icons below the vertical scroll bar.

Previous Slice

Next Slide

Introducing PowerPoint ' ' K
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«  Togo!l Iheuextslide. click the double down arrows., -

‘To go 1o the previous stide click the double up arrows, - -

2.5 SUMMARY

¢+ PowerPoint gives yor way [0 produ.cc a professional-looking presentation.

* PowerPoint views can be divided info . ) s _ _. .
) S[idcs‘
¢ Mandouts
“ Spcakcr's.Nulcs

e Oullines

» owerPoint is started by double clicking on the powerpoint icon.

Powerpaint window provides you to creale preseniation slides. .

PowerPoint wizards are the way. to quickly and cfficiently create professional-lookiny:
presentations.

» _Powerpoint provides
« ‘The AutoContent Wizard .
¢ Fhe Pick a Look Wizard . -

You can'show o Inde the teolbars [rom the Toolbars dialog box.

Lt 1 e R LD L LR A WL
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3.0 Introduction

31 Objectives

3.2 Creale a Presentaion

3.3 Create a Title Graph

3.4 Creating a Graph

3.5  Creating Tables

3.6 Making Organisation Charts
37  Saveand Closc' a Presentation
3.3 Oplen a I’réScn[ation

39 Add'aNew Slide

3.10  Change Slide Layout

3.11  Slide Show

3.12 . Summary . .

3.0 INTRODUCTION

The main aim of using any prcs;ntatlon graphic package is to make effective prescntatlonq In the
previous unit, you have learnt about the components of PowerPoinl. In this umt we will make some
slide shows (presentations), ‘ -

e

3.1 OBJECTIVES . . S
After going through this unit, you wilt be able to

¢ crealc 2 presentation

* usc the blank slide option to create a slide of your choice’

15

[ S B B



4 1,
154 . . EE I

e creale grn‘f;hs as your slide
» add a new slide

s change the layout of a slide

3.2 CREATE A PRESENTATION

In PowerPoint, your enlire presentalion is in one file - everything is "under one roof™. That includes
all the slides, the oufline, the speaker's notes, and the handouts, as. well as the formatting
information you build into your presentation. v

Using a slide layout is an casy way lo begin building a presentation. You choose a slide layout by
selecting New Slide from (he Insert menu and then selecting the layout you want in the New Slide
dialog box. There is a varjgty of slide layouts, somc with placeholders 1n which you type text, and
somie with placeholders set up {0 make it casy (o add grapls, charts, clip art, or other objects.

With PowerPoint, you can ghange the ook of your presentation - the format, the colors, or the kind
of output you wanl - anytime. You can always apply a new template or change the color scheme.

Creating a new presentation

When you create a new presentation, you have choices about how to proceed. You can use the
AutoContent wizard to help you organize what you want your presentation to say. You can use the
Pick a Look wizard to help you apply a template and set up the masters. You can also start with a
"blank" prcscntallon if you wa.nt to use the default prescntahon either the PowerPoint default or
one that you set up,

———

3.3 CREATE A TITLE SLIDE

A Title slide is the first slide that will be displayed in your prescntatlon A Title slide is dmdcd lnto
lwo parts - lhc top part for the titlg and the bottom part for the sub-title or the topic.

To ¢reate a Title slidq

I. Select New from the File menu, Lo display the presentation dialog box.

Flle' Edlt ‘Jlew Insert Furmat Tuul_

Open.. T
Close

16 Creating u Presentation



Click the Blank Presentation, and than QI
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4. Tt will display the blank title slide 1o enter information.

. Type the title and sub-title.

~ Presentations
Powerpomt Shde Shows

3.4 CREATING A GRAPH -

A bl uph can be created and wcwcd in dlﬂt..ran formals, as-a ptc, bar ‘column and so on. Legcnds
titles and data labels can be added 1o improve rcadablluy ' .

-To create a graph

I. Sclect New from the File menuy, to display Lhe brcscnta{ion dialog box.

. _Ctr_l*U |
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2. Take the cursor of the mouse at the small circle shown in front of the Blank Presentation and

press the button.
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3. Take the cursor at OK and click the mouse bulton,

4. You ;.uill sec the different types of graphs under Choose an AutoLayout, Y:ou can select any
one style of graph as per your choice. You will notice that the rectangle shown around the
stlected graph has darkened. This shows that the graph styie you wanted has been selected.
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5. Click your moysc cursor o the OK sign.

6. 1t will display the biank graph fayoul slide.

‘Click to add title

Double click to add graph

t 7. Double click on the graph box marked as “Double click to add graph” to go in the graph modc.

" Now you can create and modify the graph. You will sec some data also in the Presentation -
Datasheet. Pleasc do not get disturbed. This is only a default dala. You'can pul the new data i.c.
modify the exisling dala as per your dalasheet by taking the mouse curspr and clicking it once,

e
S TR S

Presentatin

4t

st lr : rd Gtr  |dthQtr

204 41 90 204
346 3.6
%l 438

j
45)
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8. Whenever you change the values in the datasheet, it will change the graph automaticaily,
dispinying backside of the datasircel.

20 ‘ Creating a Presentation
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Change the graplt type

(ype.

One way is .

You can change the graph Lype ds per your rijlanenicili, Thor aoe Lwo ways to change the granh

e Click on graph type list box, 10 will display you differant types ol pranhs, You can choosc any ol

them.

The second way s :

o Scleet Chart Type fiom the Format menu 1o display ehart type dialog box..
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Change i sui-type of the graph

Seleet 3D cojumn group firom the Format menu.

s l'.u'ﬁ_i:llf:

e
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|

Click onlSub!ypc button and select the sublype graph and than click on QK. It will display you
the préview ¢ [ the praph, '

Py
I
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Chan; o format

w Sel o . woformal from the Format menu o dispiay Autoformat dialog box.

o
rt

i
Llligé B¢
4B '.§ﬁ1

4]

o)

o Sclecl graph type from the gallcnes list to display different formals to the ng,nt sxde of the list.

¢ Select a format from the format hsl 'md cl;ck on OK,
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Change the 3-D vigw

You can rotate the graph in the 3-D vicw.
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o Seleat 3-1 view from the Formal menu e display a dialog box.
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Fhe graph preview is display the graph in lell to right side and top to botlom side. You can
shange theny by click on rotate buttons.
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» Click on up arrow rotale butlon lo view graph in boltom to top side.

Click here

A
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Creating Titlay

Semetimes you may want to include more than one graph on a single slide. In such cases. ca b

individual graph will need to be identilied. This car be done using Litles.

« Select Titlas from the Insert menu (o display titles dialop box.
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Add data labels in the gropl

-

« Sclect Data Labels from the Insert menu (o disnlay o dialog box.
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» You can show the value or label with the graph. Selcct any one and than click on OK By default

none is selectod.

Display or hidz the gridlines
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« Seleet Gridlines from the Insert menu to display
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3.5 CREATING TABLES

Tables are used to display data in a columnar foim. One ar more rows of cells commonly used to
.display numnbers and other items for quick reference and analysis. Items in a table are organized
-

Creating a Presentation
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o
A

into rows and calumns. In a table, the intersection of a row and a column forms one cell, in which
you can type text. Il the text of your columns does riot fit into your slide, you can reduce the

column wid(h, <
&* . H

?W_‘Ermm a Table

I Click on New slide button on the status bar o display AutoLayout dialog box.

2. Sclect Table layout from the AutoLayout list and than click on OK to display a blank Table

presentation slide. I'rom where you can add table. -
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3. Double click.on Table box to display Insert table dialog box,

table
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Double click to add

' Click to add title
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4. Type numbier of columas and number of rews i respective Goxes of your requirement anci click
on (G to wo in word able( rows and columns) (orum.
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3.6 MAKE OCRGANISATION CHARTS

An organisation chart shows the formal structure of a hierarchical group. An organisation chart can
ko used to clfectively depict a complex organisation scheme as an casily comprehensible visual.
“Thesc charts are ideal for all types of groups - clubs, colmpanics and governments.

II the hicrarchy of an organisation it's very complex, the Organizalion Charl that represcnts this
organisation may also hecome complex. In such a situation, it is belter 10 create two organisalion
eharts. For example, il you have more than five boxes than at the same level, divide them belween
tvo charts and prescat the charts logether. 1f the organisation chart looks too crowded, use”

.
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abbraviations for the names or filles disaiayed in the chart. Or, show only the names ofpcop[r., not
their titles.

To create a Table

L. Click on New slide butloa ori ins siatus har to display AutoLayout dialog |

2, Select Org Ch:ul ]ayont frany the AutoLayout list and than click on OK to display a blank
Organization chart presantation slide.
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3. 'Doub‘lc click on QOrg. Chart bos ic #:sniny Organization chast window.

Dl : *r'k to add org chart

30 | o Creating a Presentation

R S T



4. Click on box to type title and name in the box.
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To change group styles

v Seleet on Styles menu to display dillerent Group Styles. Select any of them

To chauge box border styles

» Click on boxito select.
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Select the box
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o Scicet RBox Border [rom.-the Boxes menu Lo display different border styles. Sclect any one of

them.

T
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To change box shadaw sivles

e Click on box to selecl.

« Sclect Box Shadow irom lhe Bmu; menu 1o display different shadow styles, Select any one of ;
thcm. ' |
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To change box colours '

+« Click on box 10 select,
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o Sclect Box Color from the Boxes menu to display different colours. Select any one of them.
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To changa line thickness of the box:

» Click an box 1o select,

1

» Select Line Thickness from the Boxes menu (o display different ling thickness. Sclcct any one of -
them,

ALl
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To change line styles of the box

» Click ap bpx to select,

» Select Line Style from the Boxes.menu to display different line styles. Select any one of them.

tass ..- “,-W:q %‘?rgﬂ . . | - ‘ '_
m@z =

To change-line colour of the box ~

¢ -Click on box to select,

». Select Line Color from the Boxes menu to disp!ay'.differcnt line colours: Select any one of them.

34 - e ' . .. Creating.a Presentation
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To Change displaping size

s B3y default, Orpanization Chart window is displaying size is 50%. You can see the acweal sve g
:,clu,L Actual Size [voin the chart men.

S :'
- St MG X ';
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c- T RS apm:- :
, Bacbqromnd;;ﬂqlor ol AP
Tor eddd mare boxes in orgunizefion chart ;

+ Chek on the appropriate button on the watbar, 1o add Subordinate, Co-worker, Manager and
Assistunt boxes.
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+ Adiding diflernt boxes

o

Subordinate
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3.7 SAVE AND CLOSE A PRESENTATION

Aller creating o slide, now you ¢

Yo save a preseafation

H) &Ive your pl'L‘.SCI][GliOH.

1. Sclect Save from he File menu to display Save As dialog box.

ZRiled Edit View Insert. .

i New.. Ctrl+N

{ Open... Ctrl+0
Qlo'se

i Savegs...

2. This dialog box displays the current directory and the current drive in respective direciories and

drives boxes, Enter the name of the presentation in the File name box. A presentation name can

conlain upto cight characters

but cannot contain spaces. No need to give cxtensnon because

Microsoft PowerPoint aulomatically adds a .PPT exiension lo the name,
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3. To slore the prcscnlatlon in a different dtrcclo:y. select the dircctory from the d:rectorws list.

4. Click OK 10 save presentation file.
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To close a preseniyfion

o Selicct Close from (he File menu 1o close the current presenfation.

%EIJE* Edit- View

Insert - Format

2ty

IS:SJ i s :,As‘l-,.l‘

3.8 OPEN A PRESENTATION

You can open a PowerPoinl presentation which cither you or some of your friend had created. -

T apen a presentation

1. Select Oper from the Fiie menu lo display the open dialog box.

Insert Format

Tools

View

Save

Save As...

2. Select the directory from the directorics list, which contain the presentation file.

3. Select presentation file from the file pame list box and than click'on OX to open a presentation.
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hadnews.ppt
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stiotenu.pnt
I 1

@ m:allicc

(= poweinnl

B g, dv

i b
] ~-arm:m;vmm~mw

-

-38

Creating a Presentatior.

R o



_—

PowerPoinl presentation file is a col I-_Luuv of glides Tilae

3.9 ADD A NEW si,mE

want o expand the presentation o adkd more stides

To wedd ¢ new .el.'ﬁr!r:

1. Scleet New Slide from the Tnsert memi o display At arout dialog Lox.

2. Scleel the layout.

3. Click on OK to display blank slide layout to chter informalion.

gt have created a slide. Now you

'3.10 CHANGE SLIDE LAYOUT

o

You can change the slide layout of Lhe existing slides.

I. Click on Layout... button on the stalus bar to display AutoLayout dialog box.

-l Iélc here

@ :

New Shde.‘f‘.':f i

i

P pat?g;]
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2. Select Bulleted list and than click on QK.
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e

3. It will display Blank Bulleted list slide to enler information.

4. Type the title and enter the information in the Bulleted list.

M icrosoft Products

. Pdwer'Poi‘nt
+ MS Word
« MS Excel

T T T =" .

3.11 SLIDE SHOW

e

» Click on slide show button, from the bottom of the slide..

3

fas] e

3.12 SUMMARY

* To create a new presentation by select New from the File menu.

Titles slides are used to display the title of & presentation. : ‘

Bulleted lists are used to group related information on a slide.

To add a new slide by click on New Slide Lutton on the bottom of the slide,

Slide show provides a way (o appear slides on the screen one by one.
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Struchure

A0 Introduction

4.1 Objectives

4.2 Creale a Blank Presentuion

A3 Warking with text

< Clhiunging Tonts, size and colour of text

.5 Working with Graphic tooly .
4.6 Align Qbjects

4.7 Group or Ungroup the objects

4.8 Slide Show

4.9 Summary

4.4 INTRODUCTION

You have aleeady scen, how to create a slide through a slide layout, But you can crealc objec!s of
your choncc i the unit.

4.1 OBJECTIVES

Afler you po through this unit, yéu will be able 10

s create a blank presentation

v add atext by use the text Lool,

+ change the fonls, size and colour ol text,

v add drawing objects in your slide by ::cIcn:ldthc drawing shape rom the drawing toolEur.
~  work with ehjccls

¢ proup or ungroup objects

~—r

5




4 2 CREATE A BLANK PRESENTATION

1. Select New from the File menu Lo d:splay a presentation dialog bo:\

|
-
|_'
l:
Open". ;
Close |
2. Sclect Blank prcﬁcututiolu from (he dialog box and than click on OK to display AutoLﬁyout
dialog box. g
R TEOR P R LR ikl RS e T e i
New Plesenlallpn : o | ey L !
iy F ) - 5 I T . ; P IR .
_3;:, S ":“'-_ S et i !
? '. BTy ) - o ML T T ot |
Ek‘”.l‘ wE I. ‘ J t}“pi 1,t l
A t % lﬂ} -r' ’ i
.
& 5 ;
17

3. Select Blank layout from the AutoLayout.list and 1han click on OK to dlsplay a blank
presentation slide. Where you can creale drt ferent PowerPoint objects of your chome

42 . N Customizing the Slide Show :
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4.3 WORKING WITH TEXT
You can creale i lexl objeel, edil text and move (ext objeci.
To create a fext object

. Select Text tool bulton from the toolbar.

e Tool
2. Leave the tool on blank slide and type lext on il

'17////4"./////f/////)///////f///f/

PowerPoint

TLLIL LU LELI LI I 2010074071

bbbty
At
¢ e gmpm e -

N

3. When finish typing the text, click any where of the blank slide.
To edit the text object

» Click on the text object. While cursor is blinking on it, you can add more characters or using Del
key / Backspjice key to remove characlers,

y//z’//;‘////////////////f_”/////].f

7 - 2
2 PowerPoint| 7
Z %

2 PP A

N

To move the text ohject

.

° Click on text object 1o select it. Move the mouse cursor Lo border of the text object and click on
it and hold down the mouse butlon. Move the text object any where of the slide and leave the
mouse bullog. ‘

Customizing the Stide Show _ ' ) o 43 ‘ "
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To delete the object

« Click on object to select . Press DEL key Lo delete.

To resize the object

» Click on object to select. Move thé mouse cursor to the corner of the object, when cursor
changes its shape, hold down the mouse button and drag it to increase or decrease the size.

b

4.4 CHANGE FONTS, SIZE AND COLOUR OF TEXT

PowerPoint provides so many choices for the appearance of text object on slide. You can change
the size of the text, change the font of the text and can make the text bold or italic. Youcan also fill
colour to background of the text, shadow the text and text colour. '

To make text bold, italic or colorful

. Select the text object, to enables additional tools in the toolbar for changing the appearance of
the text, -

Click the bold or italic button to changes the text.

Bo l,d Underline

Ry = el fu;ﬂ B Text colour

Customizing the Slide Show
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To change the fout and vize of o lubel

.1

. Suleel the text object.

seleet fonl from the Tonts list box of the weolbar to change the appearance of the text.

Select size rom the size list box of the toolbar 1o resize the label text,

'TI‘ Tubunc

‘1 Tubular
7 Wide Latin
T Wingdings
T Zurich Cn BT '
T Zusich Ex BT i
T Zurich Lt BT -:;‘:‘_J
T Zurich LICn BT 2

4. Using the mouse pointer to resize the control.

Ta fill the text background colour

» Sclect the text objecl.

s Click on fill colour button to display colour list and select to fill it.
FFilled background
vt _r,"?l_(r d,,,"-,‘r_‘}",'l"".& T
POWEL
NG 5
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T create or chanye the border cofonr

v Sclect the text-objcct.

‘o Click on border colour button o display colour list and seleet to create border of that colour,

To create or change the Shadow colonr _ ,

+ Sclect the text objecl.

» Click on shadow colour button to dispiay colour list and sclect to create shadow of that colour.

15+ "\._\ J) {‘\"‘

?NoSh

#:i'i}
par et \1.1(&3

) JEmbosseds i o
SOthesGalor -

‘With shadow
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4.5 WORKING WITH CRAPHIC TOOLS

Click enany drawing buiton (reos e Prawing o Drawing - tooibar,

A

o> O]

T O =
ngL

C

4.6 ALIGN OBJECTS

» Sclect the first object, press and hold down (e Shifl key and ciick on the second object Lo align

with first objecl.

: I\.fIicros-ofL a

g i 5] o
e PowerPoint »
W 1] =

Customizing the Sitde Shay




* Sclect Align from the Draw menu Lo display another sub-menu.

J'nl'!'{l"—, \‘Y"

»Ht‘rnup.

2 '1"*-'. 1 :
ol .3 H
3 .-erﬁu:-; ﬂqth feit
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ALY i{mw-:i; : 3 ot
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balf Ly
}g‘p"ﬂﬂ &S’:F??A.L

= Sclect centers Lo align Lhe objects in cenler.

Microsoft

PowerPoint

4.7 GROUP OR UNGROUP THE OBJECTS

You can ercate a sct of object to group them and separate them by Ungroup.

To group the objccfs

» Sclect the first object, press dnd hold down the Shift key and click on the second objcct to group
with first object. -

[ ] [ | =
v Microsoft = :
[ ] X ’

» PowerPoint =
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= Sclect Groun from the Draw menu.
T

dlibth £ e

T FA
s B ,ﬁg,w
I : ey’
I rrou i \*.'-,IJ\'.':FZ
Q;..u n . 3

LA {.A—-.‘-"-E‘l

+ Tt will group the objects.

¥ Microsoft

PowerPoint

To Ungroup the objects

» Click on the prouped object to select. Sclect Ungroup from the Draw menu to Ungroup them

4.8 SLIDE SHOW

Tilt now you have leamned about crealing slides. Now you can show them by slide shov:

« Scleet Slide show from the view menu w0 display a dialop box.

pViews) Insert F
. * Slides
Qutline
Slide Sorler
Notes Pages
e, STowWs

' u.-...d' I-.-..,..w.m.“_ DI

+ Click on shaw button 1o display slide show.

n N-E;—)u-'--.-.;‘:-.- e e B

ﬁ Sy R "'Sllt]l.. ahuv'
Y i e - ¥

cﬁ_n“

R %ﬂ%

TN The sy

R \;;rrShn“'H .
_{\5 KRCanEaN; ,

- iR,
fﬁ?;‘ggﬁf ?I‘!Hulr‘:’%’:ﬁ
AT
Gl ."-*,;’ﬂ

d N“_f,r ;;) o
IIf‘Izr‘OﬂlanOI}S N
."? o Lo

yT - '_' Ty
el Ak
4ol -L; '\I\u.‘_. -Lﬁtﬁt‘%"{‘&&"

Customizing the $lide Show

49



‘4.9 SUMMARY
» To add a {ext by use lﬁL. text tool.

* You can change the farts, size and colour of (ext.

‘e You can add drawing objects in your slide by seleet the drawing shape from the drawing toolbar,

* To work with objects-
» Move a object

s Align objects

+ Group or Ungroup objects

Screen display cffects cun be added 1o enbance i presentation.

50
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UNIT 1 Internet: An Overhview

1 0 Introduction 0

1.1 Whatis [nte.r‘he_t? _ | G

1.1.1  How does Internet Work? 7
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Internat Awaroness.” .

. ' ]

Internet: An Overwew

1.0 Introduction

=

In the G52 of information, Internet has become a very popular mode of communication. |t
has permealed all spheres of life. Internet is for anybody who wants {o get in touch with
anybody clse. The Inlernet has shown a phenomenal growth. In this capsule, we will
introduce you to the concepls of Internet and related tools such as e-mail, file fransfer,
remaote lagin, World Wide Web (WWW) etc. We will be only discussing about a subset of
commanss/operalions for specific packages. However, if you acquire an understanding of
the logic of thesz operations, you can do similar operations using any other package.

1.1 Wrnaviz Intornat?

The lntaraet is a global collection of peaople, who are linked through computer cables and
telephone lines, making communication |
for specific purposes. However, the rigid technological definition of. Internet is that itis a
global coliestion of interconnected networks. By definition; a network allows computer

users to share computer equipment, programs, messages, and informalion available at

possible with each other in.a common’ Janguage

€
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Inlernel Awarcness -

one site. The earlier attempts in computer networks were limited to Local Area Networks
and Wide Arca Networks. Internet is defined as network of networks; that is, it connzcts
many LANs and WANS. Figure 1 depicts the Internel. There are many major networks
participating in the Internet. ‘Some of these are ARPANET, NSFNET, NASA, BITNET,
' DECnets etc. Internet is not the only global network available: Some of the commercial
nelworks such as CompuServe (CIS) and MCI Mail and America Online are also giobal
nelworks. - These glabal nelworks are owned by different: agenmes that'charge usz, fu: r
access. - -

Corporate Network -

Q. . |

O i

Ethernct . . .

O | o .

O W O B .

The Internet

'n.naEE ST

Campus Wide .
Nebvrork

s st

Workstatica:
uaning ¢
oo/

~

. Figure 1: Infernet: network of networks

1.1.1 How does Internet Work?

A computer network, by definition, allows sharing cf resourcas. - Ong Sudh 10aja! few o .0

is information, which exists in computers in the fonn of files of data. Thus, cne o7 i . Z-.;-,f
aapects in network of many computers is to move the fies bct\r BeN (WU o ln'C
computers. For such a communlcallon we rcqmre

e the address of lhe‘destmahon_

-, d e —nT .
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* & safe method of moving datd in'tise form of electronic signals. - *

- As far as safe movement of data is conceméd. thére exist & set-of tulesihish. governs

“sending and receiving of data on the Intemet. These rules-are implemented in two padts
in the network’ software and-are calle Transmission_Control Protocol (TCP) and Internet

Protocol (IP). These two are collectively called TCPAP. -For sending a large block of
texl/data to another machine, TCP divides.the data into little data’ packets. It also-adds
special tiformation e.g. the packet position in the document, emor correction code ete. to
make sure that these packets, at the destination, can be reassembled correctly, without

any damage to data. The role of IP here is 1o put destination-address information on such
packets. . ’

On Iniernet it is 'no't.necessary that all the packets: follow the same path from source to

‘destination. A special machine, called "router* tries to load halance various paths that exist
on the network. ' G

Anclher special hardwaré!sdfhuare-calléd gateway allows different electronic networks to
talk to Internet which uses TCP/P (refer to Figure 2). As an Internet user one may not be
interested in knowing how messages are converted to packets, but one must know how

addresses are to be given. Let us explore the addressing mechanism on interet in more
details. )

Figure 2; Working of Internet

e L F o e g T =,
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Internet Awareness

1.1.2 Domain Name System (DNS)

Addresses are essential for virlually everything we do on the Internet. The IP in TCP/IP is
a mechanism for providing addresses for computers on the Inlernet. internet addresses
have two forms:

» person understandable which are expressed as words

¢ Mmachine understandable {hal are axpressed as numbers also called P addresses.

The following can be a typical person understandable address on lhe Internet:

usermname@hiost, subdomain.domain

FHosts are, in general, machines at a particular localion. Resources of a host machine are
normally shared and can b utilised by many users on lhe Internet. A user is given an
account by system administrator, which allows him to use the resources of the machine.

The username in general, is the name of your Internet account for logging into the host
machine. Logging in is the process of gaining access lo your account on a compuier,
vhich is shared by several users. -

Hosis and local nelwarks are grouped togelher inlo domains, which are grouped into one
or more larger domains. For an analogy a host computer is considered as an apartment
building in a housing complex and your account is just an apartment in it. Domain may be
an apariment complex. a town, or even a country.

Sub-domains may correspond to organizations such as NASA or CompuServe. Domains
are classified as non-geographic and geographic figure 3 lists various common domain
names. The domain names in india come under a iarger domaini ".in",

Code Applicable for

.com commerzia!l organisations

“.net NEWorK orgapisalions

.gov pars of governments

.edu organisations of higher educalion

-mil non-classified mitary networks

.0rg organisaiions that do not fit the commercial or
educational designalions

Non-Geographic domains

& Inddiva Gandii National Oper Uniiversity
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. '_(Egunh-y R Domain_Nai‘ne_
o AUSTRALIA . | .au
CHINA cn
GERMANY : de
. INDIA in
JAPAN . Jp
UNI';'ED KINGDOM | .uk
UNITED STATES | .us

Few Geographic Domains

Figure 3 Non-Geographic and geographic domains

The Internet address socis@del2.vsnl.net.in indicates that the host computer whose

“name is del2 is one of the host computer in the sub-domain named Videsh Sanchar
Nigam Limited (vsn!) which is a network organisation {net) and is situated in country india
(.in). The socis is one the user group in this server/host (del2).

IP Addresses: as slated earlier, these are machine understandable addresses. The P
address of a host computer (also called a server) is termed as host address. Significance
of IP addresses for computers are same as significance of telephone numbers to us.

An'IP-Address consists of four sels of numbers that are separated by dots. These
addresses are organised from left 1o right. The del2 server of VSNL has an I[P address
202.54.15.30. A portion of number separaled by the dot is known as an Octect, that is, 8
bits of information. Thus, IP addresses have four octets that are equal to 32 bits. Just like
our telephone  numbers which include country code, city code, 'exchange code and the

user code, the P addresses consist of sequence of domain code and sub-domain code
from left to right. -

Computers termed as name servers contain dalabases of Internel hosl addresses. They
translate word addresses or person understandable addresses into numeric equivalenis. .

1.1.3" Who governs the Infernet?

Internet has no president or chief operating. officer and is governed by a number of
authorities. * "The ultimate authortty of Internet rests with Internet Society (ISOC) a
voluntary membership organisation.. The purpose of this organisation is to promote global -
interchange of information.. Another authority is a group of invited volunteers' called-

[nternet Architecture Board (IAB). The IAB sels standard and gives Internet addresses.

10 _ @Indira Gandhi National Gpen Universily,
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Inlernet Avwareness

" Internet Engineering Task Force (IETF) discusses the technical and operational problems
on Internet.

Who pays for it?

~

No one pays for using Internet; instead everyone pays for its part.

1.1.4 Whatl can do on Internet?

~ You can perform many lasks if you have' access to the Intérnet. Some of these are:
¢ you can publish your research paper on Internet, thus. making it available for others
¢ you can create campus wide information systems

° .youcan use itfor teaching, for example you can teach languages using WWw/ |
¢ you can use il for publicily and advertisement

¢ you can use it for mullimedia conferencing

« you can refer io the piE:tures of an art gallery

° you can have an electronic copy of classics such as Alice in Wonderland

° Yyou can have an electronic copy of iournais and magazine ffom the Inlternet

€ ydu can meeti people afound lhle world, be in iheir touch - ’

© you can refer o job listings and requirements

you can get free public domain programs, you can see movies -

© you can send mail across the boundaries in no time

¢ you can search for specific informalion.

1.2 How Can | Connect to Internet?

For connecting to the Internet, you need to have a computer account on a host machire.

.For using the accéunt, you must provide the host machine with the username and
password. This process is termeéd as logging in. Figure 4 gives various modes of
connecting to (nternet. These are discussed in the following subsections:
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Figure 4: Connecting to the Internet
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1.2.1 Hoé'dTerminal Connections

You are connected to Internet in this mode when your computer behaves as if it is a
terminal to an Internet host or server. In general, your terminal will be remote to the host,
therefore, requiring a dial-up modem to transfer information from your computer to the
host and back. VSNL does provide this kind of connection.

On such conneclions the information from any Internet sites will be reaching to your host
machine. You have to get the information from your host by using communication
software, .

Such connections may be well suited when you:

have a limiled budget

do not require constani connectivily

do not want to manage setver by yourself

want to connect from different locations using remote log in facility.

in this connection only the utilities offered by host are available to the user. Most of these
connections do not provide any graphical interface. This machine cannot exploit the
multitasking features of the computer as this type of connection can perform only one type
of communication at a time. Normally these shell accounts are on UNIX operating system.

~1.2.2 Individual Computer TCP/IP Link

* Such links help a computer 1o act as a TCP/IP host., You c¢an customise this computer for
specific access. These links are called Serial Line Intarnet Protoco! (SLIP} or Point to
Point Protocol (PPP) links. One can have dial-up SLIP or PPP connection. You can
compress the data and send it using TCP/IP or vice-versa. A computer using such link
allows Windows based applications on your computer. Thus, providing a very simple user
interface for connecling to Internet.

Such cohnnection allows use of graphical internet browsers, ile transfer capability, e-mail
and other PC based services.

Using TCP/IP link one can:

o

perform remote login to a distant compuler where yourhave an account

lransfer files from a distanl computer

o

find out information about people and organisations

-]

Browse the internet using a browser

@ Indira Gandhi National Open University . 13
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The limitations of a SLIP orPPP account are:

Normally, we are connected:on SLIP/PPP through a dial—up;dqnqectivity.and if our link is
slower than 28.8 kbps then our host isaccessible_vew,slowly and we may not allow
peopleto use our machine as this will reduce the speed of our computer drastically. ..

. Many software packages are available for conﬂgu_fing'SLlP or PPP connections.
1.2.3 Dial-up or On-Demand TCP/IP Link through-LAN

This_connection {5 considered to be an intermediate step between a dial-up connection
and a dedicated high-speed link. It has some features of both the types. This kind of
connection is established between your LAN server and the Internet host/server. You
may request for a-connection as.and when desired from youg LAN server. It may have a
direct line or may dial the umber of the inicrnet server to establish a link. A regular
cxchange of information béetween the LAN server and host machine of the service provider

is the exchange of e-mail messages.

Internet traffic bud many -mail me=sages to exchange. For such systems the program .

running on network server makes the initiation of establishment of link. However, the
speed of link is quite limited. ' '

This type of connection “is ‘ideally suited for environments where you have very little

1.2.4 Dedicated Link Connections

- This is a permanent conneclion, which can be set up over a telephone line using a modem
or a router. A rouler is a specialised compuler, which can read the address on a packet
and can transmit the packet to its destination. Modems are used when the speed of

transmission is low (28.8 kbps), whereas routers are used for higher speed (above 56
kbps). LT ' - ‘

Dedicated high-speed cﬁrihe_ction is best suited "for larger organisations, which have to
serve many internal and external customers. This kind of link allows you to become
information provider round the clock.: This connection allows full connectivity to Internet,:

however, because of organisations own securily, privacy or policy reasons you may
choose not to use ali the connedctivity features. ' :

Presently, the main Internet service provider in our country is Videsh Sanchar Nigam
Limited (VSNL). They offer all of the above type of connections.

1.3 Tools and Services on Internet -
To work with Internef and to utilise the information and resources available on it, we use

certain tools. .For example, Telnet is a tool that is utilised for logging on remote computers
on the ln_ternet: Let us briefly discuss about sorie-of the important tools and services.
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1.3.1 Elecfronic Mail on Internet

One of the very useful things about the Internet is that it allows you almost instantly
exchange of electronic message (e-mail) across the world instantly. E-mail is a popular
way of communication of electronic matter. You can e-maif to your friend or a to’
researcher or to anycody for getting a copy of a seiected paper. E-mail is mainly used for
sending electronic piece of text. Through e-mail on Internet you can be in direct touch to
many of your friend and colleagues.

An Internet account includes an electronic mailbox. A message meant for you is received
at your Inlernet host computer, where it is stored in your electronic mailbox. As soon as
you login in to your Internet account, one of the first thing you-should do is to check your
mailbox. :

Some of the mail programs, which exist on Internel, are UCB mat, Elm, Pine etc.
‘However, one thing, which you must emphasise while selecling a mail program, is the
user friendliness of that program.

Mazailing Lists on Internet

E-mail provides a mechanism for groups of people who have common inleresis (o
estabiish and maintain contacl. Such interest groups are referred to as mailing lists (lists.
ior shorl), afler all; they are mziiing lists of the members’ e-mail addresses. You can
subscribe to any of such lists. You will receive copies of all the mail sent to the list. You
can also send mail tc all the subscribers of the list.

You can become a list subscriber, by contacting the list's administrator. There exist two
types of list administrators: human or computer program called listserv. Your request lo
subscribe may sometimes be refused. Do not get disappointed, there will be plentiful
more lists that will accept your subscription.

it you have joined maay fisls you may wind up with lots of mail in your mailbox. - or
' yoie, if vou subscribe to sevaral active lists, you may receive over 100 messages
oty Gy Tows, bl vour sulscriptions o fimiet iisls. Moderaled fisis have one of
more human msoaersors who scrzen all incoming mail and redistribute only a selecied
portion to tie list. Unmoderated fisis just pass all the received mail to its subscrioers. i
¥ou do not like a panicutar list, yeu can always upsubscribe from it, by sending a request
lo iz administiator. '

P

.l wps

L

1 o —
-zl Auto ne:~po:1:.es

This {aciiity heips in gelivering aviomatic presiored responses on arrival of e-mail.

Tihere zrz manv ways o meel pzople and.share information-using Internet.  On2 such
viay is.through Usenet newsgrours. These are special groups set up by people who.want
to share common interests ranging from current lopics to cuiturdl heritage. There are
surrently thousands or Usenal newsgroups.

L
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The Usenet can be considered as another global network of computers and people, which
s interwined with the [nternet. However, Usenet does not operate interactively hE(e the:
. .Internet, instead Usenet machines store the messages-sent by users. Unlikg mail from -

mailing lists, the news articles do not automatically fill. your electronic mailbox. For:
accessing the information on usenet. one. needs a special type of program called a

newsreader.” This program helps in retrieving the news you'want from Usenet storage site
and display it on your terminal. '

Usenet is like a living thing: New newsgroups get added, the groups which have o0 much
traffic get broken up into smaller, specialised groups, and the groups even can dissolve
themselves. However, changes in newsgroups can occur on the basis of some c_ommpnly
accepwd rules and by voting. For Usenet, there is no enforcement body; it entirely
~ depends on-the co-operation of its computer owners and users.

The newsgroups are really meant for interaction of people who share your interests. You
~can post your own questions as we!l as 3}our answers to the questions of otherS: on tl_1e
Usenet. *One thing, which is worth mentioning here, is that when one is interactmg_wnth
people on Internet certain mannerism should be adopted. These rules are sometlmt.as
called "neticuette”. In a face-lo-face conversation you can always see a person’s facial
gestures anu; hand movementis and Can-ascertain whether he is teasing - or is being

sarcastic, or somelimes even lying. However, in onine interaction one cannot see the -

Person one is interacting with. The rules of netiquette may help to compensate some of
these limitations of the on-line ehvironment.

Usenet has its own sel of rules and manners, governing behaviour; most of them are

based on ¢ommon courtesy. Unfortunately, not everybody follow them. Some of the
pointers on how to behave on Usenet are:

> As stated you cannot express facial gestures or your tone of voice on on-line

commiunication to show that you are being sarcaslic, or wink 1o indicate that you are

kidding. This can be added to on-line speech. One can use a number of character

- sequences, that when viewed from a side looks something like a facial expression. For
example, the.wink may be conveyed with ;-) and sadness may be conveyed with :-(.

~. Read the news for & while before padicipating. This helps you to observe the
dynamics of a particular grour. Cerain things that might be acceptable in one group
would not be acceplable to another. For €xample, a group may collectively choose not
to discuss certain aspects of a topic. Different groups may have different opinion of

what is offensive or improper. For example, jokes that are funny to some may be
offensive to olhers.

~ You can be emphatic about “highlighting* the word with asterisks to stand out.

# Many of the news articles involve questions. So before asking a question, check_ the
- list of frequently asked questions (called FAQ's) for the group. Do not ask questions
for which "answer is available readily. People on Usenet may be extremely co-

operalive, but not if you are asking questions whose -answers are prominently
displayed in existing documents.

~ Do not get involved in personal attacks or tirades. This tvpe of verbal attack is called

flame. . Flaming is totally undesirable as i gencrales lots of articles that very few
pcople want to read. Thus, wasling Usenet resources. -
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What is FAQ?

A great resource offered by Usenet is the FAQ's that is the list of frequently asked
questions and responses for them for particular newsgroup. These FAQ's are available
on incredible’ number of topics, such as new Power PC to variely of dogs. FAQ's are an
excellent place for sharing informalion about a topic.

These FAQ's are generally text files or Usenet articles. FAQ's can be organisad as a long
list of questions and answers, or as a list of questions followed by answers. . The secopd
approach is belter {from the point of view of searching for a parlicular question and iis
answer. Some FAQ's go to a distance such that they provide annotated bibliography.
FAQ's are very popular among Internet users. FAQ's are also archived.

Usenet serves primarily as a forum for questions by offering subscribers a decument
- made up of frequently Asked question (FAQ) and their answers periodically. You must
read these documents 1o make sure that your questions haven't already been answered.
[f you have a new question, 'people on Usenel mav be exiremely co-operative in helping
you getting the answer. Therefore, when other ask questions, it becomes your
responsibility- 1o assist them. * It is only the people interaction with each other that has
made Usenet the amazing informatior resource thal it is.

1.3.3 Transferring Files with Ftp

Internet gives you access to all kinds of information. However, files and data are scaitered
all over the Internet in farge and small archives. Some of these may contain text, some
may contain pictures or sounds, or computzr programs. A file may contain some
important information for you, however it may be on a dislant computer. If you want to
have your own copy of the file then?

There exist a standard too! on Infernet for transferring copies of files. . This program is
- called fip, that is, file {ransfer profocol. Ftp can be used to copy any file from one internet
hostto other.. However, for such-transfer you need an account on a remote hest. The ftp
program will make a connectior with the remote host. which wil aliow you 1o browse the
directories anc specify files 2t the remdte host for transfer. Howevsr, vou cannot look at
(he contenis of these remdie files by using fip. You have to trensier the cooy and then
|00k_ 2t i, ence itis on vour own zccount.

What will happen if you do not have an account on_a remote Internet hosi? For suck
cases fip recognises a special account name called anonymous. Thus by using
ananymous ftp you can access public archives on the Internet and copy a file from there.

Somie of the common programs such as Stuifit, PKZip. or Compaclor are used t
conipress a file before using lp. The basic advantage of using these compressed file

-aie inat these fil2s requice iess slorage space, and less time to fransmit frem site to site ¢
[nlernet, . ' :

,

1.3.4 Connécting to Remote Machines with Telnet

Telnet is a program that allows an Internét host computer to become a terminal of anot
host on the Internet. Fin opens a connaclion solely for transfer of files, however, Tel
allows you to ecome a user on & remote machine. You can run the computer progrz
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at remote host, browse the database or perform any desired cperation of the remote
machine using this facility. . ] '

Thus, Telnet provides a direct access to various services on Internet. Some of these
services are available on your host, but Telnet is especially useful when these services

are nol available on your hest. For example, if you want.to use graphical interfaces

designed by other users, then Telnet allows you {o access their hosts and use their new

(interfaces.  Similarly, whenever someone creates a useful service on his host, Telnet

allows you 1o access this valuable information resource. This ool is especially useful for

accessing public services such a$ library card catalogues, the databases available on the
ramote machine elc. '

it is extremely simgle lo use. Imagine the use of it as a utility. Suppose you are work_ing
as a facully member of Indira Gandhi National Open University. You have a typical

account FACULTY-1 on the IGNOU computer that is one of the hosts of the Internet. You

are selecied for Academic exchange scholarship to USA. You will get a user account in
U.S.A. However, all you colleagues know only you IGNOU account. Thus, using Telnet

you can always log on 1o your account in India for your papers, for running your programs,
for your mail et '

There are many databases available on the Internet. -You can explore these databases
using Telnel. There are many Internet services vel {0 be created. Every year better

means of accessing the ireasures of the Inlernet are appearing in which Telnet is the key
for accessing. ' :

1.3.5 Some Other Tools '

There are many olher tocis that exist on Internet, The following table provides a brief
summary of {hese tools: '

Finger -} This command allows display of the contents of the.files
" that are associated with particular user identifier at a
padicular Interpet-site.  ~ -

Talk Allows privale communicalion between (wo individuals.

Both paries musl be connecled to Internel for a session.

Inlernet - Relay ~Chat+ This allows each pariicipant contribution displayed on the
(IRC) : . screens to all other taking par in the conversation.

T B A - e

N Rt

Multi-user  DOngeons "T1i@g€ tools have rules and regulations of ‘Infermation
(MUDS) and Multi-user __ﬁi';]q,r_ing_.An_.ap;_)l_rgq,ch_forgroup learning. '
Simuiation Envitonment [~ - TR - :

(MUSEs) - [ EE T

‘Muliicast  BackBONE | It is used-to broddcas) speechés, news, conferences and
(MBONE) olher informational events on Internet. ‘

CuSeeMe. Maven and | These are tools for audio and video teleconferencing.
VAT ‘ -

Figure 5: Advanced Tools on Internet -
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1.4 Browsing the Internet

-Both Telnet and fip programs, require that one must know the address of the specific

computer to be connected.. Neither of the two is conducive to provide a general
information of what is out there on the Internet. There are many browsers for the Internet.
which provide the abiiity to view text and perform searches. If you are using the browser
then you need not remember UNIX commands or syntax. You just have {o start the

browser and selecl from the choices they present. These browsers help you perform a
sort of window-shopping of information on the internat,

The first of these browsers, Gopher. presenls the Internet as a series of hierarchical
menus containing ilems that point to another menu or a file or a directory within a remote
host or the articles of a Usenet newsgroup or to a variety of other things. The secpnd
browsers take advantage of the World Wide Web (WWW). The World Wide Web places

pointers to resources within its text, on selecting a pointer one automatically jumps to the
resource pointed at. - ,

Gopher and the World Wide Web are easy to use and mest popular browsing mechanisms
on the Internet. The Internet is growing very fast. It is very difficult to keep up with all the

new information, archives, and other resources that are available on it. So periodically,
you must surf the Internet. :

Surf implies venturing out just {0 see what you will find. While daoing surfing you have no
particular destlination in mind just like surfing in sea. where you do not know which wave

will come in what way. You do not know what you are searching yet you can search great
things on Internet. ' '

Surfing the Internet is just like channel surfing on your cable television. You have very
littl2 idea what is on or even what you want to see. You just fiip through channels seeing
what's on, and move {o the next when you lose interest inwhat you are watching. Gopher

and World Wide Web make suring a simple and enjoyable pasiime. Beware it is easy fo
los2 track of time while exploring the Internet! -

Inlernat users have grown frustrated, as the information on it is not arganised. Some
pedple are also worried about the qualily of tnformation on the Internet. *Some individuals
ana groups have taken up tagk of creating special subject-specific listings and archives.
These are available through both Gopher and World Wide Web. These lislings are just
like libraries that specialise in material on one- subject. These lists are maintained
carefully and conslant monitoring of Internet is made to update these lists.

1.4.1 Whatis Gopher?

Gopher displays a set of reso_drces on the Internet in the form of mehus_ or lists of items.
You go around the Inlernet by selecting items from these menus. You need not know the

addresses and commands. You just select an item of interest’to see its content on the
screen. D <

- . ' P

It is based on the concept of client and servers. - Here, clients are the pregrams that
request information for a user, whereas, servers are programs that provide the information
to clie_n'ts.“-Goph'gr servers are scaltzred all over the Internet., Thus. servers sit and wait
for- requests from Gopher client programs. One can use the Gopher client program on

- - ones _ovy_q.lhle_rnet host. [f Gopher program is not available on your machine you can

-
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teinet to one of the public Gopher clients- available-on the Internet. The people who
‘maintain running of Gopher services create' the merus. - A Menu item can point fo

materials on that Gopher server or fo materials on any other Gopher servers (Refer to
Figure 6). B L . IR ]

Move this arrows
to the desired
‘meny item, 3

/™

e D e ke

’— internet Gopher Information Client Gopher Information Client
: Root gopher server : IGNOU @QVAXIG.IN ] Root ngpher server : IGNOU @VAX 1G.IN
1. Help About Gopher/ =T AL Help in Saurses
2. Comuter Information/ -+ *~"2. Courses Related to Management Studies
3. Fip Sites/ ' H. " 3. Course Related to Management Studies
4. Games/ Onsclaetag || .- A4 Course Related to Computer Sciences
5. Librar~s/ i lupiégu’mbcr U5 UG Courses '
6. Mailing Lists/ - 10°vou may . " 6. PG.Courses
7. News Groups/ ’ pet'anothec 7. Other Information
8. Other Gopher Servere/ Meno :
9. Phone Books/
. 10. Courses at 1GNOLY
11. Searchiots of places in Indias
i 12. IGNOU Campus Information/
Peess ? for Help, q to Ouit ' Page : 11 Press ? for Help, q to Quit Page: 14
...... [}

Figure 6: A hypothetica! \.fiew_of Mgnus on Gopher

All these Gopher servers, their respeclive'in‘forma'tion resources, and all the Internet

resources we can reach are colleclively. referred to as Gopherspace. The lerms like |

tunneliing through Gopherspace and travelling around Gopherspace have been comrnon

for Gopher users. The .Internet has grown exitremely fast in size, but Gopherspacle (s
perhaps growing even faster,

1.4.2 Whatis World Wide Web?

Is the menus only way to browse the Internet? The World Wide Web offers a competing
.approach. The WWW does not require vou ta leam a lot of commands.” You can sirnply

read the text provided on the screen and select the itéth you wish to view. Thus, you can’
follow many different “trails” of information. s véry casy to use software, therefore, &

favourite means of browsing the Inlernet.

The WA provides an integrated view of the. In‘ternet':using clients and- servers. As

discussed earlier, clients are programs that help you'sought out information while servers

are the programs that find information for the, clients. . \WWW servers are placed all around
the Internet. ' : : S

-y
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The operations of the Web mainly rely on hyperiext as its' mean of interacting with users.
But what is hypertext? Hypertext as such is the same as regular fext, that is, it can be

written, read, searched, or edited, however, hypertext contains -connections within the taxt
to other documents. - T

For example, in Figure 7 on selecting the option: "Arranging Windows and Icons” you are.
linked to another screen, where you can select "titlebar” to get linked to a new screen.
Please note that these new texts can also have links and may connect you to other
documents. Thus, continually selecting text will take you to a tour of information. The

hypertext links are called hyperlinks. These hyperlinks can create a complex virtual web
of connections.

On selecticn

hl : 1 Arranging Windows and Icons
| Grganising Application and Documents v '
M L Using Program Manager commands, you ¢an
| Using Program Manager, ¥ou ¢an organise | arrange you desktop so that windows and
i vour appfications and files inlo groups that _ icons are easy to see. The Tile command
; Make sense 1o you. For help and organizing resizes and arranges the open gioup window:s
: applicatios, choose one of the lolloving i side by side in the Program Manager window,
_ lopies: ' ' i The cascude cammand resizes znd layers
i Arranging Windows and leons ?spgi:im?up viindoves 5o hat each Liie bar :
" @ Ghanging Propenies : . On
: . To arrange grovp windews 0a your desklop sefecling
! - @ Copying a Program ltem - From the Window manu, chose * Tilte bay
1 @ Crealing and Deleting Groups T | . Caseadeto Tile
. ® Grealing and Celeting Program Items Use the Artange icons command ta evenly
i ® Moving a Program Item 1 arrange lhe izong in a group windew.
1
] )

Filie bar ; The bevizonial bar (at the tap ol a
vrindow thal cortains the Litle of the vindow
or ¢ingg box.

Figure 7: Working of hypertext

_ - P .
Hypermedia is advanced version of hypertext dosizments as it contains links not only to
other pieces of text, but also to other forms of media such as sounds, images, and movies.

In fact, images themselves can be selected to link to sounds or documents. Hypermedia
- contains hypertext and mullimedia. '

The World Wide Web is described as a "wide-area hypermedia information initiative
aiming to give universal access (o a large universe of documents”. World Wide Web
provides users on computer networks with a consistent way {o access a variety of media
in a simplified fashion. A popular software program to search the Web is called Netscape.
The Web project has modified the way people view and create informalion-it has created
the first global hypermedia nelwork. The Web browsers identify the location on the
Internet using a notation called Uniform Resource Locator (URL). URL indicates the toof
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being used and the cddress of Internet site where presently. information is being located.
. For example, URL hitp:/fwers.whitehouse.qov means that presently Hypertext Transfer

Protocol (http) is active, that is, WUII"' Wide Web browsmg tool is 1ookmg at the site
www.whitehouse.gov.

The Web information facilitates an easy exchange of hypermedia through tnternet. The
native documents on the World Wide Web are written in HTML known as HyperText
Markup Language. HTML defines the structural elements of the documents such-as
headers, citations, addresses, layout information such as bold and.italics; and the use of
intine graphics alongwith the ability to prowde hypertext links.

It is availability of VW on the Intemet thal has made it so popular among ‘masses.
However, there is a limitation of Web information, that is the information available on a site
is static (does not change aulomatically). To make this happen an ohjeci‘orlented
programming language JAVA is bécoming increasingly populaf for Web page designs.

1.5  Summary

This unit is an attempt for answering some of the basic queries about Internet, & network
of networks where ot of Information is available and is meant to be utilised by you. V\_fe
have presented an overview of how and what you can do 6n Internet. For more details
about.how to get connectivity to Internet and how to work with various tools you can get in

touch with VSNL, NICNET, ERnet. Using Internet you can overcome the boundaries .
across the globe. The internet technology is growing so fast that it is difficult to keep pace -

with it. You can do so only if you are using Infernet, a mega source of infarmation.

i e nAha L Ing ifis.
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Internet Tools: E-mail, ETP and Telnet

=

2.0_ intrdduction

in the previous unit, you have been exposed to the basic terminclogy of the Internet. In
this unit, we will discuss about one of the most interesting methods of communicaling with
the entire world. This method is called Electronic mail or e-mail in short. This was the first
utility, which was used on network and is very popular. E-mail’have brought people close
to each other in an off-line fashion, that is, in e-mail the receiver may not be present to
_receive the mail, but it is delivered in his mailbox.
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In this unit, we will also discuss two commionly used tools for retrieving mformatlcn frof a
separate location (host). These are FTP & Telnet. FTP is ‘used for transferrmg

information stored at a distant host, whereas telnet is used to log into your own accounl
on-a distant host to chieck for your. messages, retrieve files etc. In the subsequen_t_

sections we will be discussing these tools i |n more delalls

2.1 Electronic Mail: A Message window

Electronic Mail is the service that is available to people on a local area network or on the

global Internet. It is one of the most commonly used services on the Internet, as this -

service is more convenient than normal postal system.. 1t is easier to send e- mail than
postal mail, as you do hot need to paste a stamp or search lfor an envelope just create the
message- and send it. E-mail does not require the person réceiving’the mail to be
available (Iogged into the des tination computer) at the time of recelwng lhe mail.

Itis called e-mail, as the basrc concept in e-marl are smular to the pcslal mall services viz.,

> You put on e-mail message in*s. electronic envelope and place an electromc address
on it.

> You then hand over the envelope o someone else (the network) for ¢ slivery.
> You do not worry, when the e-mail is read.

» You-can forward e- mall to a forwarding address The e-mail system routes it to the
forwarding address.

# Your message may come back to you |f your mail cannot be: dellvered (Thls is called
bounced mall as it "bounces” back to you)

Other commeon points between e-mail and posial mail are:

- The sender should know your e-mail address.

» You can keep in touch witn your friends using e-mail.

~ Your mailbox may become full of e-mail, you may get mail which m|c1ht be difficult fo
read.

~ An electronic magazine or a mailing list subscription may pl’OVIde you wnlh the latest,

_'trends in the topics of your interest,

-7 Commercial companies may send you their adverttsement through electrcnre mail.

This is also called Junk” mail,
- Your mail may be delivered to, and read by, someone else

~ Cvery p:eCe of e-mail you get may not be pleasant and friendfy.

24
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Some of the difference belween e-mail and postal mail are;

# As e-mail is so easy 1o handle therefare, it has become an extremely useful tool for-

reaching to people you do not even_intend to see.

» Your e-mail because of problems May go to a computer postmaster or the person
- responsible to handle bounced e-mail. . '

~ E-mail, since it is very easy to create, may result in sending responses on which one
may regret later.

What about Privacy?

. Although e-mait can be made public, yet anly the sender and the recipient read most e-
mail messages. The main reason for this is the ‘raffic of e-mail. There are so many e-mail
messages floating around on the net that no one feel interested in reading them, even the

mail arriving at the desk of the postmaster, inay not be read. The chances of your mail
reaching to postmaster is just 0.5%. ' S :

Even the bounced messages might be seen by you only, as most of the bounced

messages are handled by the computers electronically and does not involve any human
intervention.

You can cohmunicate with your friends via e-mail, however, it is probably not a good idea
to send some personal information that you do not want to make public.

y

2.2 E-mail Addressing |

If two people have account on the same computer or are connected through the same

SErVer, or are on the same company network, then in general, their address might be the
first name of the person. ‘ -

Please note that, all e-mail user or addresses are not the first names or initials. On some
systems it may be your account number, or employee number, or some other randomly

.assigned user identification. However, in general, with smaller systems we tend to use
names or initials. . -

In fact, the service provideré like CompuServe, Genie, Netcom, America Online, and many
olher large service providers. use this type of addressing, because although people

connecled to them do not work together, or live in the same city, yet their mailboxes are al!
handled by one single e-mail.system. - T

same system need to be more elaborate. This kind of address contains the ‘login’ name
followed by the domain and subdg_ma[n namesl_,fl:his is called the fully qualified address.

However, the Internet addresses in the cases when sender and receiver are not on.the

© Indira-Ganghi National Open University ~ . © . -
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For - example, address of School of Computer and Information Sciences is: -

socis@del2.vsnl.net.in. This is a fully qualified address indicating where the account .of
socis exists.

Once a message is assigned an address, it can be send to the destination via the -

interconnected Internet systerns. The e-mail handling syslem on t_he sgndt{er ds "gg'r'n:f;tse!'r
(using any e-mail software) breaks the message into manageable pieces cal re"ffe?:.-lr?t atl';
Each packet is addressed 1o the final destination. These packets may follow di ! p N
to reach the destination. At the destination they are reassembled in the correct order by
the destinalion e-mail machine. Figure 1 illustrates thig process.

Packets -

fnl‘crnct

Figure 1: The E-mail System

2.3 The Components of E-mail

An e-mail message has many c_ofnponents. There is much software such as Netscape.

avi i { i whi i il Iy the -
Navigator, Pine, Internet Explorer efc.i which allow you tc_:u dea! with the‘ r_nslulf_t Ir‘-lp;.njs,‘
following sections we will be discussing about e-mail using Netscape Naviga 0"" Ak
window. .

A mai

| message, in the Netscape maii window is shown in Figure 2. The recgived mail'is

displayed i the message window. The message is prefixed with the date, sender.and .
Figure 2(a)). It is followed by the contents of th_e_.

- feceiver addresses etc. (refer tg
rmessage (refer to Figure 2 (0)).
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Figure 2: Netscape Mail Window
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2.3.1 Messagé Com p.oéiti_g‘n'- -

You can create and send e-mail messages Using the Message Composition window. One

can transmit fully formatted HTML- pages, - disk files as attachmenfs to these mail

‘messages. Vi
For E:reatihg a maii -rhess'age, the message _cbmp'ositidn window of Netscape _nzla’uigator. S
o be selected, you can select it by choosing “New Mail Message” from the “File” menuor

the “To: mail” butfon on the toolbar. There are many other ways of getting to this window.
i 'i"Heli:b_’*[H'a’.Gﬁntilitin]

DA View T Db
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1 e D R Ry
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Figure 3: WVicssage Component Window with all the fields

Figure 3 shows all the ilems of the majj message. However, using the View menu, you
tan hide or display desired items on the screen. Each individual item is termed as a field.
A field can contain more than one address separated by comma. '

The From field will display our own e-mail address.

The Reply To field, will contain the e-mail addresses if you want to send replies {o e-

mail you had received. You will find that message window is fiiled wilh the contents-of

the leiter you are responding to. Il is.a good habit that you include the contents of the
received mail. - L

+ The Mail To field is filled with the e-mait addresses where you want 1o send tha
message. - ' ' : -
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o

The cc field contains the e-mail addresses where- copy .of your message is to be sent.
cc means “carbon copy”. You may include this address as a courtesy or for the

information. Be careful about CC-ing of an e-mail messagé. Some people regard this
as rude.

The Blind cc field contains the email addresses where a blind copy of yourmessage is -

to be sent. Blind ¢c (Boc) means. “blind carbon copy”. This is similar to s making an
exlra photocopy of a letter and dropping in someone's in-box without letting the official
recipient know about the sender BCC-ing yourself helps in having a copy of everylhing
which has been sent by you. ' The recipients of BCC get a notice that this is a blind
carbon copy. Think carefully before BCC-ing a message to someone. BCC may
encourage gossip or may result in-spread of information indiscriminately, this may hurt
someone else. Therefore, you must use BCC judiciously. ’

The File cc field cantains the location where you want to store the copy of the sent
message you are sending. By default, messages are stored in the specified folder.

The Newsgroups field will be filled with the name of the newsgroup if you want to post
yOour news message. '

The Foliowup To field is provided with the name of the newsgroup where you are
interested in posting a reply.

The Subject field is filled with a description of your e-mail. It is always advisable to
provide subject so that olhers know the topic of discussion,

The Attachment field displays the page name or file name, which you have attached
to your mail. This is one of the most interesting options as it allows you to send a large

file, or a lable, or picture or any other information which was created offline in a
different application.

The Message Composition buttons help in the following tasks:

¢ -

4

Send (ﬁow) or Send (later) bultons will be available based on the option you have

seiecled in “Options” menu. if you have selected "Immediate delivery” in that menu.

you will be available with send (now) button. [f you have selected "Deferred Delivery”
from thal menu then send {later) bullon is availabie. Send (now) button immediately

tries to send you mail on the nelwork, while send (later) holds your message in outbox _

folder and tries to send mail Jater.

YOL_J ¢an send the attached fite as it is, or in ASCI text format. The View menu tn the
Mail window allows you to view attachments either inline (the page appears in the
message body} or as links (a-link to the page appears in the message body)

Address opens_'the Address Book window. This allows selection of address from the

address book, thus giving a lot more power 1o the user. We will discuss abou! address

bock in more details in section 2.3,

If you want to Stop transmission of message you are sending press the Stop button, -

@ Indira Gandhi National Onen Urniversity
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-2.3.2 Chec_king and Reading Messages T

.~If you w_an_t-to check for the new meésages and want to disblay them. You can choose
"L Wiqdpw!Mail in the Netscape menu, Alteratively, you can send the mail icon (the small
e_‘n\:EfIOpe _9tlthe botlom-righl corner of the Netscape window).

'On.opening the Maif window, you will be prompted to enter your e-mail password. This
password may be same as what you have used for your Internet account.

Hchps,Mai 2

wrllee | &%, C.’,g C}» Y I Si& | . TR
Gat b} Dodew [ Tobd | ook | Ron Fovand | “nsfies| ke Fiv | 5o : '
tiail Folder . ]UNL‘&dITOld I ]—‘\|t-5uhe(-l‘ "-'-‘“'-"'-lDalc Lol B
Qe 9 — - ATTENTQII HEW LINES! _ 6/27/97 1107 ]
T3 Duthon B s

':l Sa

£5

D Help Desk:

%" Cybert Times, -6 Augusl 1997

6427097 D217 -
BRATIST 2

 ATTENTION! HE_W LINES!
+ triel emad

_:j{l:_‘;l:l{a::h . o2 {8 and kumarpandt

B2/ 15:47 |

B T

ety

pe IR ]
PearItvtecn

vou tha
LR TR B

LR H LI _._. .‘:_-.—_.._:- .
v ve heve added some mare’teleph

Y

- N L. L
L1“TCP/IP: nocess mumbers -in -Delhl:ex

I . -
R A A ¥

The':surmary o

-

4120, 1ines .
144 1ines
2196711k

L

AL 1568 1ihns

. .HS8) [7CFegiem Flzz/Nelscape/Navigotc:/Hal/inbos Ibb_-,lc u_:a:hlcdl [ IR e N

Figure 4: Mail Window
For retrieving new messages from the server you can press the “Get Mail” button from the

toolbar of the Mail window (refer lo Figure 4). This will bring the new mail messages to
your terminal if you are connected. |

The Mail icon in the bottom-right corner can also be used for retrieving new messages. [l
atso informs you about the availability of new messages as:

¢ A question mark (?) next to the envelope (mail icon) indicates Metscape cannot chack
- the stalus of tihe mail server automatically. '

The' envelope alone indicates that thare is no new message for you.

¢ An exclamation point )
~for ratrizval

next to the envelope indicales that there are new Imessages:

[
2
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The Mail window consists of three panes or components (refer to Figure 4):
¢ the mail folder pane
¢ the message header pane

¢ ‘and the message content pane.

The mail folder pane consist of three ;:olumns (refer to Figure 4):
+ Mail Folder, indicating the names of the mail folders such as Inbox, outbox etc.
+ Unread, indicating the messages which have not been read.

+ Total, indicating the total number of messages within the folder.

Netscape by default generates the following folders for its use:

+ The “Inbox" folder for incoming mail messages.

+ The “"Outbox” folder for messages to be sent.

¢. The "Sent folder" for holding sent messages.

~+ The “Trash folders” for holding mail messages which are deleted.

However, you are free 1o create more mail folders. For example, if you are sharing an
account vsith other users then by creating more folders, you can' organise your mail
separate1 Y.

A folder can be selected by clicking on it. On selection the contents of the folder are
displayed in the "Message header pane”. This pane display the following calumns (refer

to Figure 4):

¢ Sender: it displays the name of the sender of the mail message. [f you are displaying
Outbox and Sent folders, this column will display the name of the recipient.

4 An important message can be marked noteworthy by clicking the ﬂag icon for the
message.

+ The "Read"” icon indicates. whether the message tas been read or not. The icon can
be clicked again to make a message not read once again.

* Sub]ect indicates the subject line of the message, lhus after reading the sub]ect we
can dec:|de to read junk mail or not.

© Indira Gandhi National Open University : ' 21
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¢ Date displays the date and time of the arrival of message! Many people_ ,orggnis_e thejr
. mailbox by date of receipt, therefore, you must keep-proper date and time settings in
your computer. Co A - "

P T e

An imporant message. can be stored in an important folder created by you by dragging |
the message icon in the message list to the desired folder. Thus, you can keep track of-

important messages to you,

_selécted"and 'displayed in the message content: pane by selecling the

message heading. The header information such as Subject, Date, From, To elc. is also
displayed. ' '

You.can resize panes, as Per your requirements, by positioning the cursor on the

borderlines between two panes (the cursor changes shape) and dragging o -the
proportions you desire. . ] ' : : : ‘

. 1f you have received 3 message that includes a page attachment then you can select.in

the View menu the option. Attachments Inline to 'see the confents in the message pane,

the option Attachments as Links meny itern to display a fink to the attached page. If the,
- message sender has included a file altachment, you can click'on a link that preésent the

"Save As” dialog box for saving the file to your hard dis

The Mail toolbar buttons and rﬁehu items offer functions for viewing, creating_, sending and
storing mail messages. The meaning of thesa options are given in the fol[owmg table:

Mail toolbar buttons: These buttons provides the most commonly used commands. You
can perform following functions using toolbar buttons (refer to Figure 4):

Get Mail Connects te the mail server and bring any available messages

on the server into the Inbox.

Delete | Puls the currently selected message in the message-héading
pane into the Trash folder. a

To: Mail Displays the Message Composition window for creation of a

new mail message. °

Re: Mail Displays the Message Composition window for replying lo
: selected mail messages. The To field displays the address of-
the sender. '

Ra: All Displays the Message Composition window for replying to all

mail messages one by one.,

‘Forward Displays the Message Composition window for forwarding the

.| selected mail messages (lo be sent’ as attachment). .The
.| original subject is automatically prefixed by the word Fwd.
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Previous

Displays lhe;"plr(‘:vidu:.s unread mt_ass_age'.in the meséage list.
qut. D@sﬁlays tlf-1e ne;(t unrle_aq méséaée'i\n:llie.rr;és.sage list.
Print | '!;rin't's' -the _se!e;:tecl messages.
Stop Halts ahy ongoing transmission of messages.

2.3.3 Mail. Menu items '-_ ‘_'

The menus available in {he Netscape ma|l provide many funclions,

also avanable in.general, in most other e-mail soflware

These functions are

The F|Ie Menu is ulilised mamly for prowd[ng [unclionality relating to files. The File Menu
options are given in the foIIowmg table:

New Web Browser

creates a new Nelscape window.

New Mail Message

displays the Message Composition window for
crealion of a new mail message.

- New Folder
3

creates a new mail folder.

-

L Adid Folder (Open Foider)

f displays the standard Open Folder dialog box.

[ Save As

h
4

L

message as a file.

a dialog box appears for saving the currentt

 Get New Mail

refrieve messages.

Sand Mail in Qutbox

sends any oulgoing messages in lhn Quibox
folder for deferred delivery.

Empty Trash Folder

removes messages placed in lhe Trash folder
permaneanlly,

} Compress FI:Hder

| recovers disk space from deleted messages.

ey
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aaiL --' “M.—ﬁ—.:“ll_.

.I.:’age Setup - | displays - the dtalog box for standard Pags
- Setup. s )
- [ PrintMessages _ print a seie cted messages
' b' 0,;5‘3‘ | cioses the Mail wi_r!de.xlr.r_ 1
! EinQLJi_t exit-the Netscage sgp!ie'alior_l. a ‘

The Edit menu optiens are:

Undo/Redo reverses ihe {ast action.

Cut removes ’ the selected ‘portion and places a
Copy on lhe chpboa.d

Paste . puts a copy of the contents of lhe cl:pboard at
the position of the select:on marker

Delete Message moves the selected message 1o the Trash
folder.

Delete Folder permanently removes the selected folder.

Select Thread | selects all messages i_n the current_,'th're_ad‘._‘.

Select Flagged Messages | selects ﬂagged messages ttj:e"._fcqr:(ent
thread. - o

Select All Messages selects all messages in all the'threeds:-' )

Find searches the text in the presént message.

Find Aééin | | searches for the same fext as the prewous

' -} search in the present message

« The Vlew ment opliens are gw=n in the fol!ow'ng table One of the common!y useo
-option of thrs menu is sort commano uefer to the lab!e for more: details)

N TR | ey

@ Indiro Gandhi National Qpen University




g : : Inlerne; Awareness

Sort

allows you to arrange the messages in the

messages heading pane -according to Date,
Subject, Sender, or Message Ffumber in
Ascending order. Again sons again. Thread
liessages is used to sort messages such that
messages and their responses are grouped
together.

Unscramble

when checked ailows'l deceding of the
message scrambled by sender using shifting of
characler mechanism.

Wrap Long Lines

—

it allows the display of long lines of the
message in many lines. If it is not checked
then a line may extend off the screen. The
aefault option is unchecked.

Reload

brings the message from the server again.

Local Images

displays the images of the present message if
they have not been automatically loaded.

Refresh-

redraws the present message.

Document Source

produces a View source window displaying in
present page in HTML format.

Y Attachments inline

when checked it allows viewing a page
atlachmenl as part of the message. ! lhe
sender has sent an HTML page as an
attachment, the formatted HTML page is
appended to the message body.

Attachrlqents-as Links

when checked it allows -accessing 'a page
aftachment using a link. If the sender has
included an HTML page as an atlachment, a
link to ‘the formatlted HTML page is appended
lo the message body. .Clicking on the link

.} displays ihe page in the message confent
.l pa‘ne.‘___._ . :

.......
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‘Message menu option allows you to perform various operations wilh the messe

J—

‘3.

Some of these options are available as mail loolbar bullons. The message menu opl.ons

aras
Reply : isplays_ the Message Composilicn window for wnting a
) response with the Send To field pre: -addressed lo the
sender of {he message.

Reply to All Cisplays e Message Composition windsw for v.*rll-mg‘ a
response with the Scad To field pre-eddressed (o the
sender and the recipients of ine message.

Forward displays lhe Message Composilion window for sending

\ i iaati i i ihe Go
CGo meriu.helps the user in navigating among various messages. The options of ihe

the curren! messages as an alla_chmr:nl, the Subject
field and Attachment feld automatically filled.

Forward Quoted'

displays the Message Composilion window for sending
the current message as guoted text in the content area.

Nariks as Read

designates that the current message has been viewed.

Mark as Unread

designates that the current messagé has nof been
viewed.

Flag Message

designales the current message j.with a small icon in the
fiag column of {he message-heading pane.

Unflag Message

removes the current message's flag column icon.,

Add to Address
Book

creates an address book entry of the sender of the
currenl.message.

Move

transfers the current message to the folder you select.

Copy

transfers a copy of the current message to the folder you
select.

menu are:

e ket a

Noxt e

displays the next message listed in the message-
heading pane.

Previous Message

di.splays the brevipus massage.

-
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First Unread

first unread msssage.

dispiays the

Next Unread”

displavs ihe next unread Message

Previous Unread

. ——

displays ine previous unregad message.

First Flagged

displays the first marked message.

Next Flagged

displays the next marked messagé.

Previous Flagged

dispiays ihe previous maiked message.

Stop Loading

halls any onigoing transmission of messages from
the mall sarver.

- The Options menu aliows chanqirg severai oplions.

options:

Show all Messages

when checked dispiays both read and
. unread messages in lhe message header |
- j*pane.

Show'On!y Unread Messages

when checked, displays only unread
massz2ges in tha massage header pane.

Show Headers

lets vou conirol the number of header
L information fisids displayed. when viewing
1 messaces. - All displavs 2! possioie |
i hezoer  fieids. | Ronmad \JH'J:-::‘“S i
primary addrass fieids. Brief msp.ays onty
suhjcrl and lec.ol'an* flf-ldc

Document Encoding

tets you select @ character set encoding a

document.

These menus have the following

There.are two more menu items called WINDOW arid HELP. The WINDOW menu lets you
switch among Netscape's prlmary or currenﬂy apen w:ndows whereas the heip prow'i'=

help on various topics.

24 Address Book

The Address Book simplifies the process of addressing for sending an e-mait message.

You have to seléct Window/Address Book ontion for opening an Address Bo .,

Details

- about 2n individual contact can be added o your elecironic address book (refer to Figure
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5). You can edit, sort or organise address boak. -For sending mail to an individual you

-simply Aeed to double click the entry in the address bock. A message composilion with’
"Mail to:" field filled with the-address will be displayed. ' -

A_d-ding -add'l_"gs:.ses: To add an address of an individual, choose ltem/Add User.,

N i

" :Nick Mame;

N roele - R

ISpecizlist of Scams : )

hére dte noakases L

Figure 5: Adding an address in Address Book

-You_canEmodify an address book entry by selecting the Item/Properties oplions. You can

link. address book to other packages than mail. .For example, in Microsoft-Oulloo}:, the

. address-book can be linked to meefing organiser, which enables automatic sending cf
desited. mail 'to all the people who will be attending a proposed meeting.

-You can give a -nicknarhe to the individual in the address book. One qf the majer
.. advantages of having nickname .is that instead of entering the complete e-mail address of
the individual, you simply give his nickname while filling "Mail to:" field far a new. messaga.

This nickname will be automalically expanded to the desired address’ from the fault
address book. ‘ _

Another important application of lhe address book is that you can create a mailm_g list as a

folder, of your contacts. For example, you can create a mailing list of_ your personal

‘contacts with. the name Personal-friends. An individual address c¢an be in one or more
. mailing lists. The power of mailing fist can be ascertained from the fact that suppose you

want to_send new vear greeting to your pérsonal friends, you just have to click on the

mailing iist icor "Personal Friends" while addressing your e-mail message. Your message .
~will go to'all the members of that. mailing_list {refer to Figure 6).
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To add an address of an individual to mailing lists just drag and drop the individual icon to
the mailing list foider,
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Figure 6: Maiting Lizis
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The individual icon wrll remaln inits place- -and an alias of it'is stored in the mailing list
folder. You can create a new mailing hst by selectmg ltem/Add List optlon

Other address book menu optlons are gwen in lhe fol[owmg table:

File/New MaiI-Message" dlspiays the Message Composmon window for a

. R new mail message with the Mail to: field filled
wilh the :address .of "the members; you have
selected |n the address book

File/lmport . "~ -agjpends' ';he contents of an address book file (an
S HTML-formalted page) into the aclive address

book file,
File/Save As . saves the acuve address book file (=s an HTML-

format;ed page.

File/Close ‘ closes the Address { ok window while saving
the current list. '

Ed‘i‘dFind,:. allows -yeu tol search for items in the Address
: Book lisl. (names or addresses).

EditvFind Again- perfor'ms'fhe Find command again.

ltein/Add User creates a new e-mail address enlry. Enter an
' abbraviated name in the Nickname field {o be
used as a shortcut when addressing e-mail.

ltem/Add List inserts a new (mailing list) folder. Enter an
' abbreviated name in the Nickname field to be
used as a shorteut when addres smg e-mail fo the
enhre hst

|‘}'

2.5 TrOJb[esnooLmd i —mali

Sometimes a message bources tha[ is, comes back 10 you It basically occurs because

you might have entered a wrong user name or a wrong host name. Thus, mail bounces

- because of misspellings in addresses. One or the most common types of mistake is when
you type & |etter of an address in different case. Remember e-mail addresses are case

.sansitive. " This problam. can. casiiv be gliminated if you keep an address book of your
con[ac'“ This is possibic in Nelscape, E:*.LL." 21 explorer and other packages.  Sometimes
fhe mossages may nod reach because i insilbox of the racipient is full. T..ts i possible
wihen o os s nf-t chiacked ‘1|s mah fere worv long tlme

“The bourl ad anll is nan dled by daamons :he tesm* dsemon” (pronounced as DEE-mon)
. is an example of progremmer numer. ' .DgEmens ‘2ré 'supposed to be the servants in the
: 'aften.w For a progremms F._\*J"“ 'o.st punm“.nm' posslbie wculd bo to. hc.nd‘e FGP‘E'J'“VG

D oc ey e e e T . [T T—

e bt .
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support-tasks._ThuQ, man? programmers wrote [ittle. helper programs, called daemons to

do these repefitive tasks- for them. Mailer deemons are getting more and more
sophisticated these days. Some demons may tell you about the problem also.

2.6 Interesting E-mail Addresses -

If you know a person's name and if he is registered wilh world wide address book at
http://veww.emailbook.com then you can find the e-mail address of a person by just
submilting the-name. However, if you want to send e-mail lo say, a member of the Indiain
Parliament then you must visit site of Indian parliament at; hitp://alfa.nic.in.com.,

You can also send mail 1o ihe President of United States at president@mwhitehouse aov,

You can search for addresses from the yahoo yellow pages.

2.7 Mal Reflectors, Mailing Lists and List Servers

Mailing llists are special group of people who would like to bz in touch for sharing -

informztion and a topic. You may join many mailing iisls on the [nternet:
P Y] Y

You can join a mailing list by sending a request o the list adminisirator. I you want {o
send a mail message 1o all the members.of a mailing list, you need:to send the mail to a
mailbox called mail reflector for that'maiting list. The mail refiector receives the mail and
reflects it to'all the members of the mailing list. )

Mailing list needs to be administered. The list administrator can be human or a computer
program. Pregrams that are created for managing a mailing fist are called list servers. A

very useful program in this category is named LISTSERV. This program was created by
Eric Thomas. ' “

Some mailing lists are moderated. In such lists the list administrator firsi moderates the - .

mail and then the mail is distributed to the members. You can get more information o
mailing lists frem the Internet itself.

2.8 ‘ ETP and Telnet

FTP and Telnet are the two common tools on interngt. ‘FTP (File Transfer Prolocol} allows
movement of files specifically intended for you or files that are placed for general usage.
Telnet connects you to cther computers.

2.8.1 FTP: The File Transfer Program

FTP is an abbreviztion for the file transfer protocol. Notice that the file transfer programs
that use this protocol are als. -eferred to with the sama name. File transfer
suggests is to send a copy of a file, this is not same as a massage, from on

.
T i . SCAP L .-, o

as the name’. .
e computer to -
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araol_her. T.h_e files that'can be senting across using FTP include spreadsheets, digilized
pictures, scund ﬁ!es, programs, word-processed fiies etc.

F1¥ is basically used for retrieving information from file libraries and archives accessible
w0 lhe public. Ttus consists of free or low-cost shareware programs. Using FTP, for
example, you ~an get a recent U.S. Supreme Court decision. copies of historical

documents. However, you have to know the address of the place where these files are
Kept, :

FTP-works in two modes: for sending a copy of a file from ybur computer o other
cornputer, upfoad or put mode and, to retrieve files on your compuler use the download or
getl mode. . :

There are {wo methods of FTP. In the first method, you sign on to the remole hosl
machine on which you have your own account or user identification (iD) and transfer files.

‘Other method is (0 sign on as a guest or as an anonymous user, called "anonymous FTP".

With anonymous FTP you are restricted by the security system of the host computer. The
hosts that-provide anonymous FTP do so specifically to make some files available for
anybody's use. In Anonymous FTP, login name providéd is anonymous, guest or fip and

* the password is your e-mail address. The use of your e-maijl address as password helps

the FTP provider track who is interested in which materials. Thus, it provides a trace i
case of a security probiem. '

- Anonymous FTP is one of the most convenient tools for making information and other files

available to the public. Many sites currently use it 1o provide resources; you can find the
most current listing of selected sites via the Web. The easiest way to do that is to go to
the Yahoo site: , : . '

nttp //veww.yahoo.com-

2.8.2 How to Use FTP

Irrespective of the type of FTP, thal is, regular FTP or anonymous FTP the use of the FTP
is same. You can connect to an FTP site using a Web browser using anonymous FT.
Basicaily, there are two types of FTP Clients: Graphical User Interface based (such as
WS-FTP) or line-mode clients (Unix tommand interface). Il you are using a GUI FTP
client you only need mouse or arrow keys for selecling option from the pulled down menu
whereas in line-mode client you enter the complete command. '

“In this unit, we will be providing'informatioii.-_about FYP via VSNL using Unix commands.

ewenver, vou'can lse any other graphical FTP client for FTP.

2.8.3 Using FTP via VSNL

At vour dial-up connection, after you have gol connected after providing your 2ceount
name and password, instead of giving PPP, type: ‘ -

telnet host-name, for examp_té socis we type felnet defd.-

it will prompt you to give your account and password. You will then gat @ menu shown in
tigure: : . -
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VIDESH SANCHAR NIGAM LIMITED
WELCOME TO VSNL INTERNET ACCESS SERVICE
UNAUTHORIZED ACCESSED PROHIBITED |

Select opt[ons by no.:

H. Help - List of commands on UNIX prompt
-0: Logout _ - Logout of the system '
1 E-mail- . - Electronic.mail service

2. FTP - File Transfer Service -

3. Telnet - Log on to anolher system

4. Lynx - World Wide Web browser (WWW)
. 5. Chat - Internet Relay Chal (IRC)

G. Kermit - Transfer files to your PC

7. New Password - Change vour password

8. Zmodem download -  Download files thru ZModem

9. Zmodem upload - Upload files thru Zmodem

10. UNIX Prompt - Exit lo UNDX prompt

Your Selection:

Ry, S

Figure 7: -Opening Menu at VSNL {(Unix comma’.‘._‘d interface} -
Select option 2: You will get a ftp> prompl at your screen.
At the "fip>" prompt, you can cpen a link with any site.
ﬂp-> open site-name

Please do not connect to most ftp sites during peak business hours {(generally 8 a.m. to 6-
p.m. local'time). The -main reason for not doing so is that across the network ftp takes up
considerable computing power, which during the day is likely to be ulilised for the main
functions of the computer. However, there is some ftp sites that are accessible o the
public round the clock.

But how do we know what information is existing at 'what site? One scan. get the

information abou! contents available at a site from a friend or wsmng and browsmg lhe.

content or an Internet tool called archie.

Once you are connected to site you can see the contents availablz it thét_site-.‘ Yr:-u can
use "dir" command or "Is -I" tommand (working cnly at your own host) to do so. - -

If you see several directories in your list then you can change directory using CD
command. You can go to directory of your interest to determine liie fiie you may want to
downidad. There is usually a "readme file" in the directory, providing oiie-line description
for each item. This helps in locating the file'you want to download. :

2.8.3.1 Getting a file to your account at VSNL
If we want to trarsfer a simplé lext file then the-ﬁlé trans;f,ér commands are:’

fip> ascii
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* fip> get filename

- IF you weri 1o transfer contents from shareware then:
fip> bin
fip> get filename

This indicates that you are interested in copying a binary file. By default most ftp sites use
binary format.

2.8.3.2 Reading and sending a text file at an ftp sile

Since, ftp can only transfer files, therefore, for reading the contents you may have to wait
until you have:transferred the file. However, following allows you to read the content page
by page on the screen '

itp> get README [more

Suppose you want (o send a file from your accounl 1o anolher computer. The command
for this will be

fip= nut filename

2.8.3.3 Commonly used ftp commands

.The following table gives the commonly used fijp commands:

Command ) Action

Is-1, tir lists the current directory of the site you are

onnesied

dir {directory name) st the flies 10 direciory
L ¢d (directory name) change directory
ascii prepare to download text file
Phary or image or bin . preparé to download ner ical dile
| oet filerame get ihe contents of afile (calied download)
i .. X
b .
mget e fila2.... download many files
PUL flichiai put a fiie'on (he connecled computer {called

uplnading)

mpuf Hled Nlez.. . upicad many files

LT L LT T I S P
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del filename _‘ .| delete a remote file

bye or quit - 0} leave fip

" 2.8.3.4 Decoding file encoding formats

Files are normally stored in compressed form. There are many compression methods and
most of the decompression programs can be located through “archie™. The fiie exlension
indicates the compression progrem used for a file. Some of these are givan in ths
icllowing lavie:

Axt implies that the file is a document.-

Ps a PostScript document. You can print this file on any
PostScnpt printer.

.Zip ' file has been compressed using an MS-DOS based
program PKZIP UNZIP the file using UNZIP
program.

gz a Unix version of compressioh program ZIP.

ar ' a Unix format, generally used lo compress several
related files inlo one large file. Untar your files.

CAUTION: ftp. always checks the size of a file before you download it. Your cennection
may be quite slow and take -phenomena! time to cownload. In addition, freguent
downloads may resull in bringing some wrus infecled file. You must have a good anli
virus program on your computer.

e B B =y
&UQ\J

A few words about your ‘archie’

It is a tool {0 whmch anybody can dial into and lype in a Fle name, to check e place of that
file on the Net. Archie presently catalogues around 1,000 {ile libraries around the world.

You can use archie in three ways:

o by telnet lo any of the archie sites
archie.megil.ca
- archie.sura.net

archie.uni.edu
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arcirie.ans.net

archie ruigers.edu
¢ A client” Archie program on your own host system, or

e Dby using E-mail

2.9 Telnet

Telnet service allows you to log-on to a remote machine, on which you have your account.
However, some computers around the world permit guest logins. One such computer is
the VSNL's host computer. The information.available in on-line libraries on Internet can be
browsed only if you can use Telnet facility. Therefore, telnet is a program that allows
connecting you to on-line databases, library catalogues, and other information resources
‘on the Internet. The World Wide Web now is disseminating the information, -which was
available only v.~= telnet earlier, but still telnet is a useful tool to learn.

'2.9.1 Using Telnet via VSNL

Before you can use telnet menu of VSNL, if you have a TCP/IP connection you need to
log on fo the VSNL host using the steps given'in section 2.7.3. The followmg is the listing
of a sample session:

username: socis®del2.vsnl.net.in

password:
diro43>telnet del2
login: socis

password:

On successlul login, the menu shown in Figure 7 will be displayed.

re are many advanced features to telnet but those are beyond the scope of this r‘apsu[e
However, for simple routine tasks you do not need those features.

The commonly used options on telnet are:

close close current connection

~ i ~fconpeiitoa S|te ThlS can he uuorevnaied to“g"
Juit | . | ;;ll telnet,

send transmit special characters

stalus - | print status information:

;46 ) ' @ Indira Gandhi Nalional Open Uriversily -
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z suspend ihe telnet

? print help informaticn

2.10 Interesting Sites

Some sites to \which you can telnet for information are:

-

AGRICULTURE

'nternational Food & Nutrition Database
National Fami!v Database

Informalion -Provider: Penn Slate College ¢f Agricuiltural
Scienge S '

Login: two Ierter-a‘l'i'brev.iation 10 the slate

Address: psupen.psu.ed-u

ARCHAEOLOGY

National Archaelogical Database
Address: cast.uark.edu

L.ogin: nadlab

COMPUTERS:
"LITERATURE

HPCwire
HP Cwire news bulletin on high-performance computing.
Address: hpewire.ans.net

Login: hpewire.

EDUCATION:

Higher Education Resources and Opportunities (HERO)
Address: locis.loc.gov

Password. Organizations

HEALTH

AIDS information

AlDS statistics details of those at risk, and Aids Treatment
News.

Address: sehway.umt.edu

Login: health

iy g —
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HISTORY

f—listory Databases and Journals
Address: clus1.ulcc.ac.uk
Login: ihr-uk

Address: ukanaix.cc.ukans.edu

Login: history

INTERNET

InterNIC Information Services

For information about peopie, organisalions and resources
on the Internet. ¢

Address: ds.internic.net

Address: 'rs.internic.net

INTERNET:
RESOURCES

internet Ser\;rices and resources

A comprehensive collection of Inlernet résources.
Address: garam.kreonet.re.kr -

Login: nic

Address: info.anu.edu.au

Login.library

Address: nessie.cc.vguv_w.edu

Login: libs

LANGUAGE

Webster's Diclionary Servers
Online Webster's dictionary and spellirg reference.
Address: chem.uesd.edu

Login: webster

LIBRARIES

Carl Sysiem

A ‘corfiputerised network of library . systems.  Search for
keywords, '

Address: pac.carl.org

.48
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- 'PHYS‘III'C_IS‘;I I “National Nuclear Data-Center Online Data Service .

Data . regarding nuclear physics = and stétislical
measurements.

Address: bnlnd2.dne.bh[.gov

SPACE NASA Spacelink
History, current events, projects and plans at NASA.

Address: specelink.msfc.nasa.gov

WEATHER Weather Reports

g : Get up-lo-date weawner reports for zny location on the
' planet. An easy-to-use inlerface guides you through the
process of selecting a city or [ocation, and then viewing the
weather report onscreen or downloading it .to your
computer.

Address: downwind.sprl.umich.edu 2000

2.11 Summary

In this unit, we have discussed about one of the most utilised took.e-mail. ilis a cowerful
tool for getting in fouch with your contacts. E-mail is very cheap and operates in an off-
line mode. Electronic Address book features makes e-mail addressing simple. One can
" create a matling list of ils own using address book options, thus, allowing group e-mail at a
time. ST - '

FTP and Telnet are'two olher imporiant tools discussed in this unt. Both reguire you o
have an account on to the computer you wanl to connecl or a facility of anenymous log-in.
These tool help in retrieving programs; dala files and running remote program from ycur
machine.. However, the most powerful tool on Internet today is a Werld Wide Wab
(AWW; tool. This is the topic for the subseguent units,

A r—— e — e —
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Browsers

3.0 Introduction

Browser is the software, which allows us to easily display web pages and navigate the
web., There are many flavors of Web browsers, but they ¢an be grouped lnto two basic
categones Text-only and graphical. )

A text only browser such as Lynx allows you to visit web pages without showing art or
page structure. Essentially, you look-at ASCII text on the screen. The advantage of a
text-only browser is that it displays web pages very fast. The reason for fast display s that
it need not transfer images, voice and other media that occupy large amount of memory.

if we want to display the complete web pages along with multimedia, we must use a
QTaphlcaI browser such as Netscape Navigator or Internet Explorer. Graphical browser
‘can show. pictures, play sounds and even run video clips. The disadvantage is that
multimedia files, particularly graphics, often take a long-time to download. Graphical
‘browsers tend to be significantly slower than the text-only counter parts. And this wamng
time can be stretched even further with slow connectlons or heavy ontine traffic.

s . : _ : 77 . - l@Indira Gandi National-Open Universily

- ———— e e e -



. Intarnet Awaroness

The browsers that are currently in use are Netscape Gold and Microsoit's Intarnet
Explorer. in this unil, the fealures of Netscape Navigator Gold, Microsoft Internet Explorer .
and NCSA Mosaic are described. Also the method of searching for the web pages whose
addresses are nol known to you is described. S BT

The Technology is changing at a rapig pace.. So, few of ine features which are described
in this unil might have changed by thé time you prattice on machiine.. .

3.1 Netscape Navigator

Netscape Navigator is a WWW graghical browser. [t is available for downloading free of
cost at the sile with the URL http://home.netscape.com. The following figure shows ¢ &
schematic of Nelscape Navigator brewser.. - T '

LW
:&’E‘.-v.:. 3

R BN N
Gk |'—‘f-'_‘{~‘-"a' Yore |

14 eéa —

| vases Coonl [

Figure 1

Let us discuss various manu items available in NETSCAPE for browsing the Internel. The

main menu items are File, Edit. View, Go, Bookmarks, Oplions, Directory,” Window, and
Help. ' : . S . IR -

. l : - ' {

T
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File
New Web Browser: A new window of Netscape Navigator wilt be opened.

New Document:  There were three submenu items in this menu. They are;

Blank: Opens a blank document in the Netscape editor.

From Template: it will start a new document using Notscapes
' " Template page or page we set in preferences.

From Wizard: It will open the New Document Wizard at
Netscape's web sile.

Edit Document Using this menu item, we can open a document in the Netscape Edilor or
we can’ open a remote document.

New Mail Message We can open a new letter for mailing it using the mtegraled mail
facility of Netscape.

Mail Documen:: Mail the current document to the address specified in TO box.
Open Location: We can switch onto a particular web site.

Open File in Browser: We ‘can open a fite, which is residing in our machine’s main
memory or secondary memory in Netscape browser.

Open File in Editor: We can open a local document in the Netscape editor.

Save as: Wel can saae the current page in the browser as a file in our rnachine's memory.
Upload file: [t sends a file to this FTP directory.

} F'age Setup: We can change the printing options.

Print; We can prini the current active document.

View

Reload: {he current document is reloaded from the address from where it has been
loaded initially. This is necessary when the “transfer is interrupted”.

Reload frame: The active frame in the current document is refoaded from the address

from where it has been loaded initially. This is necessary when the “transfer is
interrupted".

Load Images: Usually, the images wili be embedded in the E-mail messages.: These
icons which represent images have to be expanded This can be done with this menu
- item.

Refresh: This will clean_the RAM. . So, the browserwindow will look blank.

52 ' ' ‘ @ Indira Gandhi National Open University

T, ATV T ¥ .o T N




a2
et

Inlemet Awaréness

Documez:.1 Source: The aclivation of this menu item will display the H“I"Mi_T source cbd_e of
the web page displayed currently in the editor of lhe browser. " The following figure shows
the docurnant source of the home page of web site name JAVA CORNER.
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Figure 2

Document information: This will contain the information. about the current qocumepf. '
which includes the structure of the document atong with the HTML files associated with

them. The folfowing figure shows the document information of the home page of ihe web
sile name JAVA CORNER.

CHETR

Java Corner ks the folou=g stz
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Laut Modified: Suadzy, Map 13, 1997 22 5500 Laca) o
Lues Madified; Suadwy, By 18, 1997 172900 GNT
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T T Secering Thrit smiosense deoemm tar is sl enirypied imd 05T no 1oesty pretocbes

Formem it

" HICAL Y Y|, 7 L B, T P I & L e ey v

Figure 3 C

n
(T3]

& Indlira Gandli National Open Uiniversily




internat Awareness

Frame Scur~2: A sngle page on ins web can be divided into subpages. Then, each
subpage = <zied a frame and each frame will have its own scroll bar efc. For example,

censidar 2= home page of Satyam Computer Services limited as shown in the following
firure. : )
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Fer nearly a decdde, Sziyam hes bevn at ths forefront in providing offshore scrvices
and solitions to major corporations worls-wide, Satyam, a piorcerin affshore,
zaftware development, was the first indiar company te use high speed satetlite ks
Sor asypuckrovous and syaci:ronous dals irancfor, Satam has more than 1600
prafuzsionals, at its five state-of-the-art davelopmernt centers, at Hpderabad,

‘Secunderabad, Bangalore, Chenngi and Pune.
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Figure 4

i containe'd two frames.

The acti\;_'ation_ of this menu item will display the source code of the currently active frame
in the editor window. This Is illustrated in the following figure.
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Figure 5
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Go “. . o _ _

: B_;c_:k': The previous page is loaded into the browser window.

,,Fofwg‘r,-._:'fl" he page that has been viewed after the current page ﬁ)re\_ziously (i.e. you have
already viewed the page previously) wiii be loaded into the browser window.

A

Home: loads the page, which was set in the preferences.

Stop loading: interrupts the current transfer.

Default publishing location: go to your default publishing location to view your web site.

Bookmarks

Add Bookmark: Add the name of the current web page to the bookmark list so that we
need not remember its address if we want to load that web page in future.

Go to 'B'ookmarks: View the list of Bookmarks. Now, we can choose one of the

bookmarks and click. Then, the browser will load that web page from the concerned
server. :

Options

General preferences: Modifies, the general progfam configuration. The configuration
includes appearance, fonts, colour, images, applications, helpers and language.

Editor preferences: Modifies the editor configuration. The clonﬁgu‘ralion includes general
appearance, publish oplions. '

Mail and News preferences: Modifies mail and news configuralion. The nreferences
.include appearance, comiposition, servers, identily and organization,

Network preferences: Modifies the netwbrking con{igural_ion. The preierences include
cache. A cache is used {o keep local copies of frequently accessed documents and thus
reduce lime connecled Lo the network. The reload bulton will always compare lhe cachad
a

Meriory cache, Disk cache, Disk cache directory and others,
Connections: Nelscape can open mare than one connection at a time lo an Internet
server. This aliows it to stimultancousty bring in text and images. More conneclions mean

more simultaneous files, bui can slow down the speed of each individual connection size.

The netwerk Suifer size determines the amount of data thal can be received in a nelwork
dala transi

nission. Larger buffers mean more ddfa, but can also saturate the computer.
.. Proxies: A nelwork ProxXy is a conduit between ybﬂf'computer'and the” Internet and is

used to access the Internet through a firewall. . If you have a direct connection fo the
- Internet, you need not configure proxies. ' o L o

———

ocument to the network document and show ihe most recent one. in this, we can set
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internel Awareness

Protocols: Protocols are technical customs or guide lines that govern lhe exchange of.
signal transmission and reception between companies.

Languages: Using the option, we can enable JAVA or JAVASCRIPT so that if we include
the code, which uses this language, the.browser can understand and execute if.

Security preferences: The preferences include passwords, personal certlﬁcates and site
wartificates.

T

I u bl

Show toolbar: If this menu item is not checked, then the tootbar will qiisappea{r. This has
been illustrated by the following figure.
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Figure 6 ' _ i

Show location: If this menu is not checked, then the location bar will dlsappear This has ;r
been illustrated by the following figure. '
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' Show directory button: if this menu item is not checked, then the directory buttons wil

disappear. This has been illustrated by the following figure.

aNetscaps  (Rip:lhoEnelscape,
tﬁf&l‘hwwfﬁﬁiﬁﬂm;“ lplions?

T

Dt L e - !':‘L'-':-':" - e, UL iR B ey bh'&_’j&ﬁ.‘ﬂ}‘ﬂi@_
Dot et L1 Tereil . + s =

‘3'24.;_;,. AN D Ol s
Rl

i

Figure 8

Auto load ima

-
)
S
Fhih

ges: automalically loads inline images. If this menu item is not checked,

then the web pages are displayed with icons representing the images in that page. 'I:hen’:
we have to click on the icon to load that image. If this menu item is checked, then a page

.is loaded along with the imag.es in it

Directory

Netscape's home: This will open Netscape corporation's home page.
- Wiat's new: Displays the items, which are new on the net..

What's cool: Displays the coo

sites relating to the music, recreation, food, cullure, movies elc. -

Customer showcase: This
promote their businesses.

I'sites on the network. From here, we can switch on to the

features companies that are Iusing"Netscape servers {o

& Indira Gandhi Mxtinnal Open Univergity
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Netscape destination: contains directories on different areas fike Business, Computers,
efc. :

.

Internet search: Using this, we can search the web using different ssarch engines fike
yahoo, altavista, lycos, infoseek, smart search and web crawler.

Feople: will switch on you to the-yellow pages of Internet from where you ca{q find the e-
mail addresses of individuals, ¢

About Internet: will switch on you to the sites where you can learn about Internet.
Window “ - .

Netscape mail: Opens the mail reading window. This has been illustrated by the
fallowing figure.

st Netscafie Mait+ pop3://de
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Figure @

Netscape news: Opens the news reading window. From here, we can obtain -the
information regarding new users who had Internet connection etc.

Address book: Opens the address book. From here, we can directly open the mail
window wilh the address automatically appearing in the TO box. ‘ .

© Indira Gandki National Open University.
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: Bookmark: Opens the bookmark. window,

| . Histofyf,éo‘ﬁ; up the hj';stbry list,

H.elpi S |

ﬁ_'\bout Netséapéi Displays program Iver_iﬁlcation, version n-umber and copyrigﬁl.

About plug;ins: contains informafion about plug-ins. These are special packages meant
for special purpose. C. :

Registration information: contains product registralibn and support information:

_ S'of'.jevare:‘informatlion about Netscape sofiware and upgrades.
- _ 'Wc_eb f;élge starter: informatic;n and tinks to-resources for new web publishers.
Handbook: Online version ofllh'e manual.
Releases. ndtels:.,information aboul version of Netscape we are running..
Freqlue'nt[y-asked questions: answers {0 conimon questions relating lo Netscape.
On security: information about Netscape's securily.
.How to give feedback: information about how to give feedback aboun Nelscape.

How to get support: nstructions on getling support from Nelscape.

How to create web services: The guide to creation ot wab sarvices.

3.2 Search Engines

' The address of oracle corparation's web site is hilp: iy, oracle .com

Usualiy the address of any web sit2 will be of the above form, As there are housands oy
veb sites, it will be very difficult to femember thesz addresses. Aiso, a5 everyday, good
numbers of crganisations are having there own web bages on internet, i wili not ba
possible to keep track of all these addresses. So, fo overcome lhis problem, Internet has
search engines. Search engines are programs, which accepl a stiing as inpui angd wit!
-ouipul all the URL's whose pPages contain related informaticn to the siring,  Thers ane
nuUmerous search engines. A {few of the search angines are DOGPILE, EXCNE,
INFOSEEK, LOOKSMART, LYCCS, WEBCRAWLER and YARQO. '

S0, if you want to find the address of an organisation or youivant to Know lhe aduressesy
of all organisations that contain information on the subject in whish yeu have inierast, you
¢an use these search engines for the desired addresses. “Now, the use of YARCO .in
NETSCAPE NAVIGATOR is demonstrated. The schematic 6f YAHCO is as fofidws: :
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SUPDOSF-:‘ that you want to know about computer courses being offered in Stanford
University. But you don't know the URL (address of web site) of Stanford University.
Then, the site of Stanford University using YAHOO can be accessed as follows.

The first step is to click on the Net Search option of NETSCAPE NAVIGATOR's directory
button. Then, one“of the search engines will be loaded. But still you have the option to
choose any other search engine. Choose the YAHOO among them. Then, the screen will
look simitar to that of the above figure. Then enter the string "Stanford University" in the
search window of YAHOO and click on the search option as shown in the following figure.
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Then YAHOO will search the web for those sites, Which_ contain information relating to
Stanford University and list those addresses. In this case, it has found 7 category and 682
‘'site_matches for Stanford University. -It also displayed them along with a synopsis of the
content of the information present in those sites. Now, we can_click on any of these iinks
and then the concemed page will be transferred from the concerned server. '

A category match is one, which contain subcategories. So, if we choose an;} of these
links, YAROO wiill ask for another search stiing and also lists the subcategories it found.
Then, we can enter a search string in the box and again search. In this way, you can

narrow down your search o the concerned page. The schematic is as shown in the
following figures. y
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[f we click on a’site malch, it will transfer that page from the concerned host server and wili
display its home page on the screen.. YAHOO will list all the category malches as a group
and all the site matches as a group. “This has been illustrated by the following figures.
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Now, [ want to know the information ebout the HUMAN-COMPUTER INTERACTION . So,
I'click on that link. Then, YAROO will transfer the concerned page from the concerned
host server 'and dispiay it on our computer screen. This has been illustrated by the

following figure. So, this is the way we search for-the information we need, using the
hrowser and search engines.
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3.3 NCSA Mosaic )

-

Mosaic is a World Wide Web browser that has been developed at the Nat_ion?al _Centre for
Super- Computing Application on the campus of the Universily of the lffinois in Urbane
Champaign. NCSA Mosaic is an Internat navigation and data retrieval tool. 1l makes
access to network informalion as easy as clicking & mouse bu*ton__ These services
provids search ca'pabilities in database environments. NCSA Moszic is, designed to
operaie under the following Microsoft Windows environments: Windows 3.1x, ‘Window/s for
Workgroups 3.1x, Windows 85.and Windows NT3.5x.

NCSA #iosaic browser contains the following menus: Llle Edit. Options, Navigate and
Hotlisis. The, schematic of the browser is as shown in the following figure:
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Ficure 18

Fils

Open Document: Using this, we can edit ahy Web Page. We have to input its URL.
Open Local File: This edits a file present in machine's memory in browser wmdow

-Sc.ve as Text: The current document is szvad as {ha te file.

= L

H Fé —_— ‘ ' . l
Print: Tre current document in the browgn vindow is printed.

>rint Setup: sets the name, status, type of printer to which the machine is connected.

News Groups: It searches the weh for lhe sites relating {o the news such as Times of
India, The Hindu, The Washington Post etc.

o | & Indira Ganghi Naona! Cpan University
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Send Mail: This will edit 2 new empty mail window on which we can type our letter; insert _
rmessages, include. URLs etc. Itis illustrated in the following ﬂguret : - '

'-ﬁmﬁm

mpgil r?;fl? 4Send
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Figure 19
Collaborate: starts a session. .
Docur-nent _Soufce: Using this, we can view the HTML code of tha current document.
Options
Shcw Toolbar: Show or Hide the toolbar.
Show Status har: Show or Hide the status bar,
Show Location bar: Show or Hide the current URL.

Preferences: Edit Mosaic user preferences. These include -Proxy, Sefvi_ces. Tables, .
Vievers, Window, Anchors, Audio, Cache, Direclories, Fonts, News, and Printing.

Navigate

Back: Gq to_ previous page.

Forward: Go to next page.

Rélloa;i: Load the current document again.
Home: Load the home page of Mosaic.

Stop Transfer: Interrupt the current transfer.

© Indira Gandhi National Opan University ' sl TR




inlerne! Awarencss

Session History: D[splays the hlstory window. It conlain the URL's wh[ch are previously
viewed,

Add current to hot [[st Add the current douument to selected folder. It is similar to the
hcokmarks column of NETSCAPE. '

Acvanced Hot List Manager: Display lhé Hot lisl manager.

Mosaic Auto Surf: It staris @ search engine with the help of which one can find {he
addresses of all sites of his own interastls.

Hat Lists

Ciren the list of bookmarks.

3.4 Iicrosoft Internet Explorer

Microsofl iniemet Explorer is another popular browser of Internet other than Netscape
Navigator of Netscape Communication inc.internet Explorer has been developed by
rMicrosoft Corpoeration. Rec:mond park, Washington. USA.- The schemalic is as shown in
the following figure:

(DM icroitinlemat Expiesrin E‘FWW«I%EEDM
I'ﬂe;‘iti.!_vm r; verie s g‘e'.p e ! .

Bl OIS PR NN A ESTT _ﬁ____‘@
\dd'.e:: ] ] s

1e

{eactaing the following menus. They sr= File. Edit. View, Go. Favouriles. Tools and izl

Crezte Shortcut: Create a shortcut lo the currenl, web page. So, whenever we click on
s sihorteut, the Internetl Explorer will be aulomatically opened and conpects {o this sits.-

Lrata deleles a documeni from the losal memory.

vy
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Rename: renames the documerit.
Properties: 'lt_hgs -_thé following s_ubmenus:
- Hisfory: shows the URL's of the recently browsed web pages.

Browse Ofﬂine;: show web pages willicut felching from the host.‘_server..""

Close: closes lthe browser. -
Edit
Cut: sto-res the highlighted text inl the clipboard.
" Cony: copies the data in the clipboard to the poéilion of'cgréor. '

View |
- Toolbar: shows .or hides toolbar

Status- bar: shows or hides the status bar.

Refresh: reloads the curre_nt docﬁment from the host‘server.

Options: enables us to change the settings of Internet Explorer.

Go

"Back: loads the previous page onto the screen.

Forward: load the page, which has been viewed after the current page pl'e\_!iCUISIY' will be .

loaded onto the screen.

Up one level: goes up by one level i.e..closes a window, which is open.

Home Page: opens the home page of the web sites whose URL has been set in the
configuration which will be loaded as the siart page of the browser.

Search: opens and closes the search bar.

- Best of the web page: opens the best site like top 100 sites.

Mail: opens the e-mail window of Microsoft Exchange of Microsoft Outlook from where we

can send e-mail.

News: opens the Internet's newsreader program. From hereswe can switch onto the icon,

which_represems the sites of new corporations.
Contacts: opens the address book, which is the part.of Microsoft Ouflook.

CaIenda_r: dbens the calendar so that we can fix our own schedules.
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Tasks: lists the appointments.

lnter.net Call: connects to the Internet.
Favourites
it lists the’ bookmarks we added when we are browsing the Intemet.

Tools

Find: switches on to the search sites and prompts for the search string.

Map network drive: maps the drive to another drive.

| Help

It contains the information about Internet Exp[drer.

3.5 Summary

In this. unit, the features of three Internet browsers namely Netscape Mavigator, Microsoft
Internet Explorer and NCSA Mosaic are described. We can access any information using
internet with the help of search engines if we don't know the address of the site, which
contains the information of our interest. For this, we can use any of the search engines
available on the web. Then, we can choose the proper category match or site match after
reading the information relating to that particular link. [f we know the address of any web
site, we can view its home page by just entering its address in the location bar and clicking
the mouse. Then, from the home page, we can obtain the desired information using the
links available on the home page. Home page is the first page of any web site.

3.6 Review Questions

1. View the home page of SUN MICROSYSTEMS, USA.

Z. List all the site addresses where you can obtain the information relating to Internet
commerce.

3. Send e-mail to your friend using Netscape's integrated mail facility.

4. List the advantages and disadvantages of different browsers.
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T



internet Awareness

Visiting Web Sites -

4.0 Infroduction

Using Brovwssers, we can visit humerous number of web sites relating to different fields
such as business, job opportunities, universities, technology, newspaper, law, business,

entertainment, sporis, schools, home'pages of individuals. We can download information
from the sites if they permit us to do so,

4.1 " Downloading

.- Down [b_aiding is the process of copying software from é_refnote_ server to your-machine's
* -~ secondary memory. Now, the downloading of JAVA DEVELOPMENT KIT from one of the -
sites of SUN MICROSYSTEMS using Netscape Navigator is described. . It is illustrated

with the following steps and figures. Step 1: Enter the string "download jdk" using one of
the search engines and start search, :

 ®indira Gandhi Nalional Open Universily
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Step 2: Now the search engine listed thc- sites related to the downloadlng of the Java
Daveiopment Kii,
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Internet Awareness

Step .3: Let us choose the link of JAVA CORNER. Now, the browser dlsplays the home'
page of JAVA CORNER : _ L :

Lﬂculﬁgl!ilﬁlfmhulu‘ﬂig’/wu_m
z w Afe iR _J'ﬂ?('ﬁ-" l'\

LT Ot tY
: %}'-L:,. WA
ek “mﬁﬂ‘l’or—SulmsﬂnIﬂﬁ [1."L1 :
) i G A D Frlbpers Kot Tor W, "1&;:595@?.?19 By

Figure3

Step: Here, two versions are provided for us to download. Let us click on JDK for
Windows 95/NT. Then, it prompts for the filename with which the software has to be
stored. Then, let us enter the filzname as "java"and cllck on save.
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Figu.re 4
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Internet Awareness

Step 5: Now, the process of down['oading 'starts as shown in the following figure.

-‘ an}:;-.r:". f.'..EIttp.| il L ety <
' Saving ' Ci\New Folder\isvaiexc - .
161 of 7938 (o 0.2H/26¢)

- Timgtel: 083523 -

Statuz; .

o

Figure 5§

From the above figure, we learn that it takes nearly nine and half hours more to complete
the process of downloading JDK and it has already downloaded 16k of 79MB software. In
this way, you can download any software from any site with the help of any search engine.
Of course, there are other ways to download. But, this is the most preferred way.

Examples

In this seclion, we Is'hall view home pages of different organisations using NETSCAPE and
MICROSOFT INTERNET EXPILORER.

4.2.1 Net;cape Navigator

In this section, we shall view the home pages of White House, Times of India, Oracle
Corporation and IGNOU using Netscape browser.

The URL of White House is hitp; /ivww.whitehouse.gov

This is entered in ihe location Bar of Netscape.and the mouse is clicked. Then, Netscape
will look for that address and will contact the host server of that URL. Then, it transfers
the information from that server to our machine and displays -the home page of White
House on the screen of our computer. The schemalic is as shown in the following figure.
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Figure 6
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Inlernef Awareness

Of course, you can read the today's newspaper on the web. The follo'.mng schematlc
shiows the home page of Times of | ndla - .

‘.H:'q"'??ﬂ-#_-:]" LT dil‘;‘..—; £ e, o

THE TIOF INDIA

Tuesday 29 July 1997

.ametropolis #india wworld estocks
ebusiness esport eeditorial

.‘ 'il .-.r:';--";:-l;"\': . \"-';'.i':i‘
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hyaﬁun'mn :_“_-.:‘
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e e ———

Figure 7

The followirig page shc_;ws the schematic of the home page of ORACLE CORPORATION.
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Tha following page shows the schematic of the home page of IGNOU.
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Figure 9

The following figure shows the schemaiic of home page of [ndia F’ar[iament.
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Internet 4warencss

4.2.2 Microsoft Internet Explorer

In this-section, we shall view {he home-pages of Intel, Apple and Motorola using Microsoft.

Internet Explorer.

" The URL of Intel Corporation is hitp:/Awwww.intel.com.

This is entered in the location bar of Intel and the mouse i clicked. Then Inte] will look for
thal address and will contact the host server of that URL. Then, it transfers the
informalion from that server to our machine and displays the home page of Intel
Corporatlion on the screen of our compuler. The schematic is as shown in the following

figure.
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‘nternet Awarenass

The following schematic shows the schematic of home page of Motorola (ne.
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4.2.3 List of URL's of Interesting Sites

1. - United Nations Commission on International Trade Law

hitp:/ftlinv. uit.no/trade law

Nonway Universily of Troniso hosts this site, which contains information about the
United Nations Commission on international Trade Law.

2. CommerceNet

hitp:/www._commerce.net/
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internel Awareness

CommerceNet, a non-profit organisation ig"'con&uéting a large. scale, study of .

electronic Intemet Commerce. Read about thé company's mission and. tap binto the
-CommerceNet drrectory services that round out the srtes foenngs

3. TheU.S. Savmg Dame ber\rar

http:ﬂww.cs.cornell.edu-lfinfofpeoo.l'e'fasw'infSavi_nq Dancing/Swing_dancing.himl

Swingers can praclice their virlual footwark here. The éxpensive sile includes a
library of swing steps, a file defining dance terms, and-a national events calendar.

4. The Wonderful World of Cricket

hitp:/www.dcs.ed .ac.uk!home!sma!HTML/crickefr.hlmI

Take a look at {op cricket teams and home-b'ages from around the world at the
collection of links. Visitors can learn the ruies of it orfind out how cricket stralegies
vary from Sri Lanka lo Zimbabwe. -

5. Michael Jackson Home Page .

hitp:fwew primenet.com/~listen

Enigmatic Pop Superstar Michael Jackson is the, objec:t of speculation and admauon
by his fans at this on-line homage site.

6. University of Florida
hlip:/fwww.ufl.edu/
The home page for the University -of Florida provides polential students and
inlerésted visilors wilh a collection of - rnformal[pn about the University, its facully,

deparimenl!s, course offerrngs and publlcahons

7. l\fzars Path Finder

hitn:/impiwww.ipl.nasa.qov .

Al this sile, you can view the image of Mars path finder as well as other inlormation
relaling lo the probe te mars.

8. USA Today

hitp:/hwww usatoday.com

This is the home page of USA daliy newspaper USA loday Here, you will be able fo

go through the news relaling to natlonal and international evenls ‘as wdl as spemal
editions like money, films ete. :

9.  Aiken Preparalory School

hitp:fiwww . rcoszpe.net
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internet Awareness

This is the home page' of Afken Preparatory School. You will have the-image of front

view of school. Also, there will be finks {o different page which contain information-

about faculty, classes, adimission process ete.

4.3 Summary

-

In this unil, we learned the process of downlozding soflware from any server connected to
Internel.  There were different methods o download software. Bul,"the most preferred

way is {0 enter the string in search bar and then fo!foir,r the suitable links. Also, lists of -
URL's have been provided which belong to different fields. Students are suggested fo go

through these sites so that they will be able to know the power of Internet.
v .

4.4 Re\}iew Questions

1. List the sofiware's that can be downloaded free of cost from‘the web site of ORACLE
CORPORATION. .

2. View the siles with URL's listed above. B )
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